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GETTING TO KNOW ILLUSTRATOR

With the release of Illustrator 7, Adobe has completed atightly integrated trio of applications
(Photoshop 4, PageM aker 6.5, and now Illustrator) that al work in the same way. Most key
commands are the same across all applications, and palettes look and work the same. The
applications are truly cross-platform, working virtually identically on both the Macintosh and
Windows 95/Windows NT platforms. If you are already familiar with Photoshop, many things
will be familiar to you as you learn Illustrator.

If you are aready an Illustrator user, you will need to adjust to version 7's new interface, and its
metaphors. And for those new to Illustrator in general, this chapter will deal with how Illustrator
works, and how it differs from other graphics programs.

This hour, we will learn about:

* Raster and vector images

* |llustrator's environment

* [llustrator's tools and pal ettes
* Viewsin lllustrator

NOTE: Illustrator 7 isamajor program upgrade. Whereas the last Macintosh version was 6, the
last Windows version of Illustrator was 4.1. Version 7 finally bringsidentical features to both
platforms while sporting a completely revised user interface. If you've used Illustrator before,
you may go through a short transitional phase to get used to working in version 7.

RASTER VS. VECTOR

In the ever-growing world of computer graphics, there are two types of images -- raster and
vector. Some programs that create raster images (also known as pixel or paint images) are
Photoshop, MacPaint, PC Paintbrush, or Painter. Some programs that create vector art (also
known as object-oriented art) are Illustrator (that's us!), FreeHand, MacDraw, and Expression.
Other programs, such as Canvas and CorelDRAW, have tools to create both raster and vector
images.

Raster Images

Raster images are made up of awhole lot of tiny dots, called pixels. To illustrate this concept, we
will use a sheet of graph paper. Each square on the sheet represents one pixel (see Figure 1.1).
Let's start smple and create a black and white circle that is 20 pixelsin diameter (see Figure 1.2).
The number of pixels determines the resolution of your file. The computer stores thisfile by
recording the exact placement and color of each pixel. The computer hasno ideathat it isa
circle, only that it isacollection of little dots.
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Figure1.1 Figure 1.2
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Each pixel has a coordinate, and the contents of that pixel are recorded and saved in afile.

In this example, we see each individual pixel, and the circleis very blocky. By adding more
pixels, thereby increasing the resolution, we can make that same circle appear smoother because
the pixels are much smaller. Of course, the higher your resolution is, the larger your file size will
be because the computer has many more pixels to keep track of.

Where the problem arisesis when you try enlarging araster image. Because the resolution is set,
when you scale the art, in reality, you are just enlarging the pixels, which resultsin ajaggy (or
pixelated) image.
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Vector Images. An Objective Approach

Vector art isdifferent in that instead of creating individual pixels, you create objects, such as
rectangles and circles. By noting the mathematical coordinates of these shapes, a vector program
can store files in afraction of the space as raster images, and more importantly, be able to scale
images to virtually any size without any lossin detail.

Unlike raster images, the vector circle appears smooth at 100% (left) and just as smooth when
enlarged 800% (right).

THE ILLUSTRATOR WORKPLACE

Now that we know all about Illustrator, let's actually open it up and see what it has to offer. If it
isn't already installed, follow the instructions that came with Illustrator to install it on your
computer. Now, let's launch Adobe Illustrator 7.

NOTE: If you've launched Illustrator before, or if you're working on someone else's computer,
it'sagood ideato trash your Adobe Illustrator Prefsfile (in System Folder > Preferences folder)
so that what you see pictured in this book matches what you see onscreen. Also, if Illustrator
seems to be acting weird, or even crashing often, trashing the preferences and restarting
[llustrator usually clears things up.

The next time you launch Illustrator, a sparkling new Preferencesfile is automatically created.

TIP: Did you know that you can edit Illustrator's Preferences file? If you're the daring type, open
thefilein atext editor and you can make changes, such as turning off warning dialog boxes.

After viewing the beautiful Illustrator splash screen and trying to read al the names of the
programmers to see whether you know any of them, you are presented with Illustrator's working
environment and an open Untitled document--we're ready for action.
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Thelllustrator Window

First, let's take atour of the Illustrator window. We'll start with ageneral look at |llustrator and
then go into more detail about each part.
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Across the top of the screen is the menu bar, which contains Illustrator's commands and
essentials such as printing, saving, copying, and pasting.

Directly underneath is the document window, which isthe actual Illustrator file. In the title bar of
the document window is the filename and the percentage at which it is currently being viewed.

On thefar left of the screenisatall narrow strip of boxes. Thisisthe Toolbox which contains the
tools you will use to work in Illustrator.

In the center of your screen you will see the page border of your document. Y ou can change the
page size to fit whatever you might need--anywhere from 2x2 inches to 120x120 inches.

Right inside the page border is a dotted line that represents the physical print area of the printer.
[llustrator determines this by taking information from the PPD (PostScript Printer Definition) file
of your currently selected printer.
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At the upper-right side of the screen you will find four of Illustrator's many floating palettes:
Color, Attributes, Stroke, and Gradient. They are clustered and docked, which we will soon see
when we discuss palettesin detail.

At the lower-right side of the screen you will find two more floating palettes. the Layers pa ette
and the active Swatches palette.

To theleft of the scroll bar at the bottom of the document window is the status bar. Clicking the
mouse on the status bar allows you to choose to have Illustrator display important information
for you as you work. Or try holding down the (Option) key while pressing the mouse button on
the status bar for alist of not-so-important things to keep track of.

Immediately to the left of the status bar is the zoom magnification bar, which identifies the
current zoom percentage of your file. You can quickly zoom to any of Illustrator's zoom
percentages by clicking the mouse button with the cursor on this bar and selecting a zoom

percentage.

— The Toolbox

How can you keep track of Illustrator's different tools? Well, | can give
lfi: : you a hint--look at your cursor. Sometimes it's an arrow, other times a
crosshair, a paintbrush, or different variations of a pen. By recognizing
the different cursors, you will be able to concentrate more on what
you're drawing rather then on how to draw it. Wherever appropriate,

| will bring these tell-tale cursors to your attention.
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Depending on different circumstances, the Pen tool cursor changes to
quickly help you complete your drawing.
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Thefollowing isabrief description of the tools found in the Illustrator
Toolbox.The keyboard shortcut for each tool isin parentheses following
the tool name.

You'll notice that alot more tools are listed than what appear in the
Ilustrator Toolbox. To make life easier on all of us, toolsthat are
similar in function are grouped together in the Toolbox. Those tools
with alittle black arrow in the lower-right corner of the box have other
toolsin their space. Y ou can access these tools by either clicking and
dragging the tool, which brings up a pop-up box of the toolsin that
group, or press the keyboard shortcut command for that tool repeatedly
to cycle through all the toolsin that space.
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NOTE: Do not be alarmed if you find atool in the Toolbox that is not listed here. Illustrator 7
enables the addition of third-party plug-ins and the ability to place those plug-ins directly into the
[llustrator Toolbox. VectorTools from Extensis, for instance, adds a Magic Wand selection tool
to the Tool box.

TIP: When dragging the mouse over the Toolbox, atool tip

EE% pops up, identifying the tool and the keyboard shortcut for it.
k I ' | strongly suggest that you learn the keyboard shortcuts for
ﬂ il the Toolbox. Adobe has made it easy by assigning single

; - keystrokes to every tool. For tools that have several options

3, Q (such as the Rectangle tool), hit the shortcut key repeatedly

] to cycle through the tools.
{:? d :51 Rectangle Tool {I".ﬂ}l

Selection Tools

Used most often, the selection tools are used to tell Illustrator which objects you are working on.
The selection tools are

* The Selection tool -- Used to select and move objects.

* The Direct Selection tool -- Used to select parts of an object.

* The Group Selection tool -- A variation of the Direct Selection tool, used to select grouped
items.

Creation Tools

The creation tools allow you to create your artwork, each tool serving a specific drawing task.
The creation tools are

* The Pen tool -- Used to create B* zier paths.

* The Add Anchor Point tool -- Adds an anchor point to an existing path.

* The Delete Anchor Point tool -- Removes an existing anchor point.

* The Convert Direction Point tool -- Changes a selected anchor point of one type into another.
* The Type tool -- Used to create headline or point type.

* The Area Type tool -- Used to create area or paragraph type.

* The Path Typetool -- Used to create type on a path.

* The Vertical Typetool -- Used to create vertical headline or point type.

* The Vertical Area Typetool -- Used to create vertical area or paragraph type.

* The Vertical Path Type tool -- Used to create vertical text on a path.

* The Ellipse tool -- Creates circles and ovals.

* The Centered Ellipse tool -- Creates circles and ovals from a center origin point.
* The Polygon tool -- Creates polygons.

* The Star tool -- Creates multipointed stars.

* The Spiral tool -- Creates spirals.
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* The Rectangle tool -- Creates squares and rectangles.

* The Centered Rectangle tool -- Creates squares and rectangles from a center origin point.

* The Rounded Rectangle tool -- Creates squares and rectangles with rounded corners.

* The Centered Rounded Rectangle tool -- Creates squares and rectangleswith rounded corners
from a center origin point.

* The Pencil tool -- Used to draw freehand single path lines.

* The Paintbrush tool -- Used to create filled variable-width objects, and supports pressure-
sensitive tablets.

* The Scissorstool -- Splits a path at a selected point.

* The Knifetool -- Splits objects by dlicing through them.

Transfor mation Tools

Power is being able to change that which you have. Illustrator's transformation tools give you the
power you need to perfect your art. The transformation tools are

* The Rotate tool -- Used to rotate selected objects.

* The Twirl tool -- Used to distort selected objectsin acircular fashion.

* The Scale tool -- Used to resize selected objects.

* The Reshape tool -- Used to make simple changes in the shape of a B*zier segment.
* The Reflect tool -- Used to mirror selected objects.

* The Shear tool -- Used to skew or slant selected objects.

Assorted Tools

Some tools just can't be categorized. Illustrator contains a wealth of task-specific tools to assist
you in your quest for the perfect art. Illustrator's remaining tools are

* The Blend tool -- Creates blends between objects.

* The Autotrace tool -- Traces bitmapped art and convertsit to vector.

* The Graph tool -- Creates an assortment of different graphs.

* The Measure tool -- Used to measure distance and angles.

* The Gradient tool -- Used to control the way gradients are filled within an object.

* The Paint Bucket tool -- Used to copy fill and stroke attributes from one object to another.

* The Eyedropper tool -- Used to samplefill and stroke attributes for use with the Paint Bucket.
* The Hand tool -- Used to "grab" the page and move it within the document window.

* The Page tool -- Used to position artwork on the printed page.

* The Zoom tool -- Used to zoom both in and out of your document.

Underneath the tools are two swatches depicting the currently selected fill and stroke colors, with
asmall button on the lower left to quickly set the fill and stroke back to the default whitefill,
black stroke (D), and a small button on the upper right to swap the fill and stroke. Using the X
key toggles focus between fill and stroke. Y ou'll learn more about these features in Hours

10 and 11, "Fills" and " Strokes."
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L de] ™ Thefill and stroke selectors. If you use Photoshop, these are identical to the
o foreground and background swatches.
lﬁ Below the fill and stroke selectors are three buttons that you can use to

quickly access Color (,), Gradient (.), and the None attribute (/).

Om=
Ifl 0 Finally, at the bottom of the Toolbox are three options for document viewing:
= standard screen mode, full screen mode with menu bar, and full screen mode.

THE MANY PALETTESOF ILLUSTRATOR

| think it all began when someone said, "Hey, the Toolbox is aways visible, why can't we have
other stuff also always visible?' Thanks to that one person, we now have floating pal ettes.
They're called floating pal ettes because no matter what you are working on, they still remainin
the foreground, accessible at all times. They can also be moved around by pressing and dragging
the mouse over the title bar at the top of each palette.

The people at Adobe must really like floating palettes, because they gave Illustrator 13 of them.
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* Info palette * Transform palette * Align palette * Color palette
* Gradient palette * Stroke palette * Swatches palette

* Layers palette * Attributes palette * Character palette

* Paragraph palette * Multiple Master Design palette * Tab palette

Throughout this book, we learn how to use each of these to our advantage.

TIP: If you opened every Illustrator palette onscreen, you wouldn't have much room left to draw
anything, so it's nice that you can quickly hide all palettes at any time by hitting the Tab key. To
hide all palettes except the Toolbox, press Shift-Tab.

Working with Palettes

Well, if you want to criticize lllustrator for having too many floating palettes, then you must also
praise lllustrator for making it so easy to manage them. All of Illustrator's palettes "stick” to each
other like magnets. They also stick to the edge of the screen window, which makes positioning
them easy. But it gets even better than that. Double-click the tab (the tab is the area where the
actual name of the palette appears) of afloating palette, and the palette collapses, showing you
only the tab.

= o Double-click the tab again to
[ Color ™, | b expand the palette.
"""""""" k Y ou aready know that you can position a
_ floating palette by grabbing the top bar of
ﬁh — = i?, the palette, but you get an extra surprise
when you grab the tab of a palette.
m e[ Clicking the tab of a palette and dragging
ol hasatinilul | produces the outline of the palette.
[}

Now drag the outline
right over the middle
of another palette.
Notice that the
underlying palette
now has a black
outline around it.
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Let go of the mouse button, and both palettes
are now clustered.

Click the tab to bring that palette to the
foreground. This capability givesyou
unlimited possibilities to configure your
pal ettes.

Believeit or not, there's even another way to configure palettes called “ docking.”

Grab the tab from a palette, and drag it over
so that your mouse cursor just touches the
bottom of another palette. Notice thereisa
black outline only along the bottom of the
underlying palette.

=i [
| Color \'1| Gradient-'"*s.\ | 4

Angle: I:l‘:' Location: |:| "

VIEWSIN ILLUSTRATOR

When you release the mouse,the two pal ettes
are docked. Y ou can now move the entire
palette as one, but still collapse and cluster
each palette individually. Cool, huh?

[FiE =
| Color \-l Gradient\\ | 4

| s ——
Angle::l‘:' anatinn::l.“ﬂ
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Miter Limit:(24 % Join: 12|
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There are three viewing modesin Illustrator: Preview, Artwork, and Preview Selection. Y ou can
toggle between Preview and Artwork viewing modes by pressing (Command-Y). In Preview
mode, you see the file as it would print, with colored fills and strokes (see Figure 1.17). There
aretimes when it is necessary to view your file in Artwork mode where you see only the outline
of each object (see Figure 1.18). Finally, the last view mode, Preview Selection (Command-
Shift-Y) isacombination of the two (see Figure 1.19). Whichever object you have selected
showsin Preview mode, while all other artwork appearsin Artwork mode.
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Figure 1.17 -- A page viewed in Preview mode.

=

Figure 1.18 -- A page viewed in Artwork mode.
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L

Figure 1.19 -- A page viewed in Preview Selection mode.

Things That Make You Go Zoom!

Illustrator lets you zoom in and out of your page, |etting you view the entire page for layout, and
giving you an up-close view for detail work. There are several ways to change the zoom
percentage of a document.

Ka

Hold down the (Option) key, and notice that the little plus sign inside the magnifying glass has
turned to a minus sign, which will zoom out, letting you see more of your document, only
smaller.

* Use the Zoom tool. Select the Zoom
tool from the Toolbox (seethe
following TIP) and click the place you
want to zoom into; or even better,
click and drag a marquee where you
want to zoom, and Illustrator triesto
make that selected areafill the screen
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* Use the keyboard. (Command-hyphen) will zoom out or down one increment, and (Command-
=) will zoom in (or up) one increment.

* Select a custom view (see the section "Custom Views' later in this chapter).

TIP: To instantly access the Zoom tool at any time, no matter what tool you are using, simply
press (Command-Spacebar), and your cursor will change to the magnifying glass. By also
holding down the (Option) key, you can zoom out, seeing more of your image. Upon releasing
these keys, Illustrator brings you right back to the tool you were using.

Moving Around Your Page

When you zoom in really close to work on an image, thereis only a small portion on the image
visible. That's where the Hand tool comes into play.

Al £ Select the Hand tool from the Toolbox. Press the mouse button and
G{ drag. Thelittle hand "grabs’ the page and movesit so you can see
‘?TF'. other parts of the image.

| —a |

TIP: To quickly zoom to fit your page in your document window, double-click the Hand tool. To
quickly go to 100% magnification, double-click the Zoom tool.

Custom Views

If you work with large, complex images, you will be very happy that you took the time to read
this chapter. I'll explain why. Everyone is always complaining about how slow computers are for
graphics, and that you need expensive multiprocessor computers to keep up with today's work.
Wéll, I'll let you in on alittle secret. One of the biggest bottlenecks in computer graphicstoday is
screen redraw. An accelerated graphics card can do wonders for your application speed. But
[llustrator has a secret weapon that costs alot less than a graphics accelerator: custom views.

Imagine yourself ina TV recording studio. There's one show that's happening on center stage,
and they have five different cameras aimed at this stage. This gives the guy in the recording
studio the ability to jump from camerato camera, seeing different views, instantaneously. Well,
[llustrator's custom views work similarly.

To create a custom view, simply choose New View from the View menu (see Figure 1.22).
Whatever your current view is, it will be automatically added to the Viewslist in the View menu.
Attributes such as zoom percentage, viewing mode (Preview or Artwork), and window position
are all saved, enabling you to quickly jump from an extreme close-up in Artwork mode, for
example, to something such as afit-in-window view in Preview mode. The first 10 views you
define are also automatically assigned keyboard shortcuts--(Command-Option-Shift) and 1
through 0.
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New Window

[llustrator has afeature where you can create two different windows that contain the same
artwork. It's the samefile, but just viewed in two windows. Y ou could, for example, work in
Artwork mode in one window, and have another, smaller window in Preview mode, so you can
see changes as you work.

m Window To use this feature, choose New Window
from the Window menu, and a new window

Preview i .
. y opens. Of course, whatever you do in one
Preview Selection <Y window automatically happensin the other.
Zoom In a0y IWindow
Zoom Out gb- New Window
Fit In Window £
Actual Size 31 Hide Tools
Hide Edges 3tH Show Info
Hide Page Tiling Show Transform
Show Rlign
Show Rulers 3R
Hide Color
Hide Guides E; Show Gradient
«wLock Guides o3 Hide Stroke
Make Guides 389
Release Guides D Show Swatches
Swatch Libraries 3
Show Grid 38"
Snap To Grid Lr3e" Show Layers
Show Attributes
‘ Edit Diews... ! + Untitled art 2 <100%>

Figure 1.22 Figure 1.23

Another great way to use the New Window featureisif you have two monitors. By setting one of
the monitors to 256 colors, you can see how your artwork will look if viewed at two different
color settings. This can be very useful when designing art for the World Wide Web.
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Context-Sensitive M enus

A new feature added to Illustrator 7 is context-sensitive menus. From anywhere on the screen,
hold down the (Control key) and click the screen. Y ou will get a pop-up list of the most common
functions, depending on what you currently have selected.

[llustrator's new context-sensitive menus offer you aslew of relevant and usual commands, right
where you want them, all at the touch of akey.

SUMMARY

Congratulations! Y ou've spent your first hour in Illustrator. There, that wasn't so bad now, was
it? We learned how Illustrator is different from paint programs such as Photoshop, and we
learned all about Illustrator's palettes and tools. Next hour, we will learn how to customize
[llustrator to our needs and tastes, as well as learn how to set up a document to work in.

Term Review

* Palettes -- Small windows that contain settings such as colors or fonts.

* Cross-platform -- Terminology used to describe software that runs on multiple operating
systems, such as Mac OS and Windows 95.

* Raster image -- A graphic consisting of a collection of dots, or pixels.

* Vector image -- A graphic defined by a scalable, mathematical outline.

* Pixel -- A square that isthe smallest part of an image; also called raster.

* Pixelated -- An image enlarged to the point where you can see the individual pixels.

* Cursor -- Theicon on your screen that indicates the position of your mouse or selection point.
* Focus -- The active part of the screen. Because of all the new keyboard shortcutsin version 7,
[llustrator might not know when you are entering data in a palette, or when you are trying to
envoke a keyboard shortcut. By making a pal ette the active part of your screen -- making it the
focus -- you aretelling Illustrator exactly what you plan to do.

* Floating palettes -- A palette that is always visible (remainsin front) even though the document
window is selected.
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CUSTOMIZING ILLUSTRATOR

When you move into a new house or apartment, you feel akind of excitement, yet you also feel a
bit uncomfortable because it's all new and different to you. Only after you've arranged things the
way you like it, making adjustments and finding your favorite "spot,” do you get that warm
comfortable feeling.

One way of getting comfortableis setting Illustrator's preferences. In this chapter we learn abouit:

* Document Setup options

* Setting Illustrator preferences

* Using guides and grids

* Creating an Illustrator Startup file
* Document Setup

Thefirst step in creating a document is setting up the correct page size. Do this by selecting
Document Setup from the File menu. Y ou're presented with a dialog box with four sections:
Artboard, View, Paths, and Options.

Document Setup

Artboard
| DK i

Size: | Letter - Width: (8.5 in

Units: | Inches - Height: [11 in __tancel |
Points
Plcas Drientation: @ [ [ Page Setup... |

Uiew I sillimeters !

Centimeters @ Single full page

::;EU p EPS Art : () Tile full pages
e b (O Tile imageable areas

Paths

Output resolution: {800 | dpi [ Split long paths

Options
Use printer's default screen
[l Compatible gradient printing
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Artboard

In the Artboard section, you specify the size of your page. Y ou can choose from those listed in
the Size pop-up menu, or you can enter a custom size manually--1llustrator supports page sizes
anywhere from 2"x2" up to 120"x120"--in the Width and Height boxes. Clicking either
Orientation icon swaps the width and height values, so you can quickly change from Portrait
(tall) to Landscape (wide) format.

NOTE: Simply clicking the Tall or Wide icon automatically swaps the width and height settings.

Y ou can select any of Illustrator's five supported measurement systems to specify page sizes by
selecting one from the Units pop-up menu. If you check the box marked Use Page Setup,
[lustrator will use the page size that is currently selected in Page Setup. Y ou can change the
setting in Page Setup by clicking on the Page Setup button beneath the Cancel button.

View

In the View section, you can choose to Preview & Print Patterns. Previewing patterns onscreen
can slow down screen redraw considerably, and this option enables you to turn it off. Y ou can
also elect to Show Placed EPS Artwork. This setting is for when viewing placed imagesin
Artwork mode, not Preview mode. Y ou will always be able to see placed imagesin Preview
mode.

........................
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Many times, Illustrator is used as atool to create art that will then be placed into another

program for final layout, such as PageMaker or QuarkXPress. In such cases, you don't need to
create more than one page. When creating complex layouts and spreads, however, you can set
[llustrator to create a number of pagesin your document. Unlike other programs, however,
[lustrator makes multiple pages in adocument by splitting one large page into smaller pseudo-
pages. You can either select Single full page, Tile full pages, which creates the most possible
full-sized pages on your artboard or you can select Tile imageable areas, where Illustrator creates
tilesto fill the entire artboard.
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Paths

In the Paths section, you can choose a printer resolution, which helps Illustrator determine
smooth gradients and clean curves, plus you have the option to Split long paths. What that means
is that sometimes paths become very long and complex, filled with many anchor points (anchor
points are part of a Bézier object, aswe will learn later on). When a path has so many points, its
complexity could cause problems at print time (see Figure 2.4). In such cases, in order to print
thefile, you can have Illustrator split the one big path into several smaller ones, which would
make printing them possible (see Figure 2.5). Always save and keep a copy of your file before
you split long paths, for future editing purposes--once a path is split, it is difficult to edit it.

Figure 2.4

For demonstration purposes, a

/ path with several hundred

) unnecessary anchor points has
been created. Thisimage will
"choke" on an imagesetter and

will not print.

Options

In the Options section, you can choose to use the printer's default line screen setting, or, if you're
printing to a Postscript Level 1 device, check the box marked Compatible gradient printing (if
you're not sure about this, leave it unchecked, and if you have problems printing afile, try

turning it on).
/ﬂ_\ ™~ Figure 2.5

"
\
\

)
b

| After sdlecting Split long paths,

_/ saving thefile, closing it, and
reopening the file, you can see
(:F how Illustrator has split up the
/j ‘\\ one large object into several
smaller ones, and, more

( ,] importantly, made the file

\_/f\\.._._// printable.

NOTE: Any settings that you set in the Document Setup dialog box, or those that you will be
setting in the Preferences dialog box (coming up next), are changeable at any time, even after
you've saved it, closed it, and opened it again. Changes will take effect when you close either
dialog box, except for the Split long paths option, which takes effect only when you save and
close thefile, and then reopenit.
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SETTING PREFERENCES

Okay, so we've decided where al of the furniture goes, but there's still more to do. As|I've come
to realize, it'sthe smaller thingsin life that really make adifference in our daily lives. It isn't the
bed or the refrigerator that gives that homey feeling, it's the rug on the floor or that cute little end
table with the lavalamp on it. It's the pictures and paintings on the walls and the potpourri in the
bathroom that creates a comfortable, safe feeling.

Aswe set Illustrator's preferences to our tastes, we will be creating our own little environment--
our custom workspace--which enables us to use Illustrator comfortably, as well as conveniently.
There are six screens of preferences, al located in the Preferences dialog box, found in the File
menu. The six screens are General, Keyboard Increments, Units & Undo, Guides & Grid,
Hyphenation Options, and Plug-ins & Scratch Disk.

New EMN
Open... 320
Close 1L
Save S
Save As... i3S
Save a Copy... =t 3
Hevert

Place...

Export...

Document Info...
Separation Setup... =GP
Document Setup... <3P
Print... #P

Preferences General...
Color Settings...

Keyboard Increments...
Quit %0 | Units & Undo...

Guides & Grid...
Hyphenation Options...
Flug—ins & Scratch Disk...
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To cycle through each of the six preferences screens, you can either select them from the pop-up
menu at the top of the Preferences dialog box or you can use the Previous and Next buttons
found on the far right of the dialog box.

Preferences

| General |'r| m
Keyboard Increments 1 &
Units & Undo -
Guides & Grid
Hyphenation Options L
Plug-ins & Scratch Disk | pinels

Auto Trace Gap: |1 pisels

Options

Snap to Point Area Select

[] Transform Pattern Tiles [] Scale Line Weight

[] Use Precise Cursors Show Tool Tips

[] Paste Remembers Layers [JJapanese Cropmarks

(] Al 6.0 Tool Shortcuts [] Disable Warnings

General Preferences

General Preferences has two sections: Tool Behavior and Options.

Tool Behavior

Constrain Angleis areally cool feature that sets the default angle of your document, which
means if you set the angle to 30 degrees and draw a square while holding the Shift key, the
square is drawn on a 30-degree angle. Thisis a great feature for creating 3D drawings, aswell as
for creating isometric drawings.

The Corner Radiusiis set here, which is used when drawing with the Rounded Rectangle tool.
This setting can be overridden when drawing the rectangle (see Hour 3, "Drawing Basic
Objects'), and the number hereis only the default setting.

Curve Fitting Tolerance is used to determine how smooth or jagged a path is when drawn with
the Freehand tool. The higher the setting, the smoother the path is (see Figure 2.8).

Auto Trace Gap is used to determine where Illustrator ends a path when doing an autotrace.
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Figure 2.8

The top line was drawn with a Curve Fitting Tolerance of 2, the bottom one with a setting of 10.
Options

Snap to Point is one of Illustrator's most underrated features. This setting makes every point in an
illustration work like a guide and makes working and moving items easy.

When performing transformations on objects, you can choose to Transform Pattern Tiles as well
asthe object. Say you have asquare that is filled with a pattern, for example. If you have
Transform Pattern Tiles activated, and then you scale the square, the pattern fill scales as well.
But if you have Transform Pattern Tiles turned off, the scale function resizes the square, but the
pattern tiles remains the same size. This setting is only adefault and can be overridden from

within atransformation dialog box.
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The box on the left isthe original item, and the center box has been rotated without Transform
Pattern Tiles selected. The third box was rotated with Trans-form Pattern Tiles selected.

Y ou can choose to Use Precise Cursors, which replaces Illustrator's tool cursors with crosshairs,
allowing for more precise control. Y ou can toggle this setting to see the standard cursors while
working by using the Caps Lock key. If Use Precise Cursorsis not checked, then pressing Caps
Lock while working changes the cursor to a crosshair cursor.

Paste Remembers Layers keeps layer information intact when moving artwork to and from the
Clipboard. Y ou can set this from within the Layers pal ette as well.
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[llustrator 6.0 Tool Shortcutsis applicable only to the Macintosh platform. As of Illustrator 7,
several keyboard shortcuts were changed to keep things consistent across computer platforms.
For those people who want to keep with the "old way," selecting this option activates those
shortcuts.

Area Select enables you to specify how Illustrator selects objects viathe selection tools. With
Area Select turned on, you can select objects by clicking anywhere within the object (if itis
filled). With Area Select turned off, you must click the point or border of an object to select it.

The box ontheleft is

being selected with

Area Select activated,

g a whereas the box on

theright is being

.: selected with Area
Select deactivated.

k
Scale Line Weight determines whether Stroke weights are scaled when you transform objects. In

other words, with Scale Line Weight activated, enlarging abox with a1 pt. rule to 200% results
inabox with a2 pt. rule. With Scale Line Weight turned off, the rule remains at 1 point.

Did you forget the keyboard shortcut for that tool? Or did you forget which tool was the Scale
tool ? Illustrator makes it easy with Tool Tips. When activated (the default is set with Tool Tips
on), simply drag your mouse over atool and wait a second. A little teeny window pops up,
telling you the name of the tool or function, and it also lists the keystroke command, if thereis
one.

Japanese Cropmarks are simply a different kind of crop mark, obviously used in Japan.

If you've used Illustrator before, you probably got those annoying dialog boxes that tell you that
you can't do certain operations or functions (which was usually because you clicked just afew
pixelstoo far). Well, Disable Warnings sends those dialog boxes home crying, and Illustrator
will then alert you with a simple beep, upon encountering any violations.

KEYBOARD INCREMENTS

The Options section in Keyboard Increments refines how some keyboard shortcuts for type
controls are implemented. Y ou can enter numerical input using any of Illustrator's measurement
systems.

Options

The mouse is a nice little gadget, but when it comes to positioning something precisely, it can be
abit difficult to control. That's why Illustrator lets you nudge objects by using the arrows on
your keyboard. The Cursor Key setting determines just how much each nudgeis.
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- Preferences =

Keyboard Increments '1

Options
Cursor Key:

Size/Leading: |2 pt

Baseline Shift: |2 pt
Tracking: |20 S1000 em

0 it

Greeking Type Limit: |6 pt

Anti-alias Type
[ Type Area Select

Size/LLeading (pronounced "ledding") specifies how much leading is added or removed from a
line of type when using the leading keyboard shortcut (Option-up arrow and Option-down
arrow).

Baseline Shift specifies the increment when using the Baseline Shift keyboard shortcut (Option-
Shift-up arrow and Option-Shift-down arrow).

The Tracking increment, measured in em's (literally, the width of the letter "M™) determines the
amount of tracking added or removed when applying the tracking keyboard shortcut (Option-left
arrow, Option-right arrow).

The Greeking Type Limit setsthe size at which text is greeked. When small typeisrendered
onscreen, the computer has to work hard to calculate the letterforms. Because very small typeis
not readabl e onscreen anyway, the computer "greeks" the type by simply drawing gray bars
where the type should appear. Of course, if you zoom in closer, Illustrator renders the type
correctly. Type greeking applies only to the screen, and when printing, all text appears correctly.

With Anti-alias Type turned on, type appears onscreen with smooth soft edges. Usually, text
appears jagged onscreen because of a computer monitor's low screen resolution (72 dpi). This
setting is purely aesthetic and has no bearing when you print your file, for al type prints with
smooth sharp edges from your PostScript printer. This should not be confused with anti-aliasing
for web and raster images--we'll cover that in Hour 23, "Web Graphics."
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Basically the same as Area Select, mentioned earlier, with Type Area Select active, you can
select type by clicking anywhere within the bounding box of the type (see the following TIP).
With Type Area Select turned off, you can only select type by selecting it on the baseline.

The word on top has the type bounding box
visible, and clicking anywhere within it
with Type Area Select selects the word.
The word below shows the type's baseline,

which you must click to select type if Type
00 Area Select isturned off.

TIP: When using the Baseline Shift option with type, keep in mind that although you can't seeiit,
the bounding box still takes up all the space, and clicking what might seem like white space
selects the type. Of course, only the type prints. By the same token, when selecting type by the
baseline, if a baseline shift was applied, the baseline may be well above or below the type. In
these cases, it is easiest to select the type when in Artwork mode.

UNITS & UNDO

Rather straightforward, the Units & Undo dialog box contains two sections: Units and Undo.

- Preferences -
— - o
General: | Inches -
Type: | Points |
[l Numbers Without Units Are Points
Undo

Min. Undo Levels:
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Units

[llustrator can use five different measurement systems--inches, millimeters, centimeters, picas,
and points. Y ou can set Illustrator to use any of these.

Y ou can aso enter any mathematical function within any of Illustrator's palettes and dialog
boxes, and Illustrator does the math for you on the fly. Y ou can a'so mix measurement systems
in dialog boxes. Y ou can, for example, enter 4 in. + 3p2 - 12mm, and Illustrator automatically
does the math for you.

We will be doing severa exercises later in the chapter, so it would be a good idea to set
[llustrator's units to Inches for now.

TIP: If you're working with one measurement system, and you want to quickly switch to another,
press Command-Control-U to toggle through all five measurement systems. Thisworks directly
in the document, and there is no need to open the Preferences dialog box.

Undo

Hey, we all make mistakes sometimes, and that's okay because Illustrator has multiple undos.
Just how many, you ask? Well, that depends on how much RAM you have allocated to
[lustrator. Illustrator keeps track of as many undos as memory allows, but it never goes below
the amount that you set here. But remember, the more undos you have, the less RAM Illustrator
has for other things. Illustrator's default setting is 5, and unless you're working on really large
files, I don't recommend using anything higher than 10.

GUIDES & GRID

An important feature of almost any program, Guides & Grid helps you easily align objects and
create perfect layouts and art. Guides are vertical or horizontal lines that you can place anywhere
on your page. These guides will not print; they are only visible onscreen. The grid is similar to
graph paper--a set of non-printing boxes that fill your page, making for easier layout. The Guides
& Grid Preferences dialog box contains two sections: Guides and Grid.

Y ou can specify what color guides should be either by choosing from the pop-up list of pre-
defined colors Illustrator provides or by choosing Other and selecting any other color from the
Color Picker. You also have the option of having Illustrator render guides as solid lines or dotted
lines.

Y ou have the same options with Illustrator's Grid settings as you had with Guides. Y ou can
choose any color that pleases you, as well as specify a solid or dotted line.

Y ou can also specify how the grid is drawn up, with main gridlines at any increment, and
multiple subdivisions.
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- Preferences
Guides & Grid - | —
Guides M
Color: [ Other... - ‘ I
Style: [ Dots 1»'] .
Grid
Color: | Other... - | j
Style: | Lines -

Gridline every: _|

Subdivisions: (8
Grids In Back

Working with Guidesand Illustrator's Grid

If you've worked in any page layout program, such as PageMaker or QuarkX Press, you know
how important guides are. They help in layout and design and for aligning objects.

As guides and the grid are important, | would like to leave the preferences alone for a moment

and talk about how to use these featuresin Illustrator. If you have the Preferences dialog box
open, please close it, aswe will be working in Illustrator for alittle while.

Rulers

When Illustrator opens, you are presented with a new blank file. Let's turn on our rulers. From
the View menu, select Show Rulers.

I|||1|||h-_I|||2|

Notice that your rulers appear across the top and left side of your screen. If you set them earlier,
they should be set in inches. If not, you can use the keyboard shortcut (Command-Control-U) to
toggle over to inches



HOUR 2

Creating Guides

1. Drag your mouse so that your cursor isdirectly on theruler.
2. Press and drag the mouse onto the artboard.
3. When you've positioned your guide, release the mouse button.

IWindow

Artwork ;Y
Preview Selection <3%Y

In its default setting, guides are always locked.
After you've placed them, you cannot select
them, move them, or delete them. To do so, you
must unlock the guides by choosing Lock

Zoom In a6+ Guides from the View menu. (Choosing Lock
Zoom Out - Guides toggles between locked and unlocked
Fit In Window %0 guides.)

Actual Size ##1

Y ou can aso turn any Illustrator object (such as
asquare, astar, or an ellipse) into aguide by

Hide Edges #H simply selecting it and choosing Make Guides

Hide Page Tiling (Command-5) from the View menu. Y ou can
return a guide back to its origina state as an

Show Rulers %R object by selecting it, and then choosing Release
Guides (Command-Option-5) from the View

Hide Guides %; mend.

v Lock Guides \ s lllustrator's Grid

Make Guides =

Release Guides =] A new and welcome addition to Illustrator 7 is
the Grid feature. Turn the grid on by selecting

Show Grid gan Show Grid from the View menu. Y our screen

snap To Grid g should now look like a sheet of graph paper. To
change how the grid appears, select Guides &

: Grid from the Preferences submenu, as we
HE_L” l!"ﬂ”'" mentioned before.
Edit Diews...

TIP: Besides helping with layout, Illustrator's grid serves another great purpose. With the grid as
the backmost object (which you can set in Preferences), you can quickly tell whether an object is
filled with None, or white.

Snap To Grid

The grid is nice, but what makes it powerful isthat Illustrator snapsto it. Gridlines act as akind
of magnet, and your mouse "sticks' to them when it gets near them. Sometimes this can get
annoying, though, and you can turn off the Snap To feature by choosing Snap To Grid from the
View menu.
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Okay! You've learned how to work with guides and the grid, so let's get back to the rest of
[llustrator's preferences. On with the show!

Hyphenation

Rather simple, the Hyphenation Options screen of the Preferences dialog box lets you select a
default language, as well as add and delete entries into the dictionary.

Plug-ins & Scratch Disk

In this dialog box, there are two sections: Plug-ins Folder and Scratch Disks.

- Preferences =

| Plug-ins & Scratch Disk - | —_—
Plug-ins Folder m!
Folder: MORDY Il: adobe llustrator & 7.0:Plug-ins:

Scratch Disks
Primary: | Startup |
Secondary: | None ~|

Plug-ins Folder

The Plug-insfolder iswhere Illustrator keeps all of its "extensions" or add-ons, including third-
party filters and plug-ins. There might be times when Illustrator "loses touch” with its Plug-ins
folder. If this happens, you'll need to remind Illustrator where the Plug-ins folder is. Y ou may
also want to keep more than one Plug-ins folder, and this dialog box enables you to switch
between the two.
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To specify the Plug-ins folder:

1. Under the File menu, select Preferences (Command-K).
2. From the pop-up menu, select Plug-ins & Scratch Disk.
3. Click the Choose button to locate the Plug-ins folder.

4. Click OK.

5. Quit and relaunch Illustrator.

Scratch Disks

Those of you familiar with Photoshop are probably familiar with the term scratch disk. A scratch
disk islike Illustrator's scrap paper, where it temporarily holds data to perform operations. Asthe
default, your scratch disk is your startup drive. When working with large files, your scratch disk
can fill up rather quickly.

[lustrator lets you specify which disk should be the scratch disk, and it also enables you to
specify a secondary scratch disk--where Illustrator goes if the primary scratch disk isfull. If you
have only one hard drive, you can specify aremovable disk, such as a Syquest, Jaz, or Zip, to be
your secondary scratch disk.

To specify a scratch disk:

1. Under the File menu, choose Preferences.

2. From the pop-up menu, choose Plug-ins & Scratch Disk.
3. Select a primary and a secondary scratch disk.

4. Click OK.

Y ou will need to restart Illustrator for both plug-ins and scratch disk info to take effect.
Creating an lllustrator Start-up File

When you quit Illustrator, it "remembers’ the position of the palettes, and the next time you open
[llustrator, it looks just like it did when you quit it. But all of the other settings, such as colors,
page size, which typeface is the default, and so on, are defined by afile called the Illustrator
start-up file, and those settings revert to match the start-up file every time you launch Illustrator.
Whatever isin thisfile appears whenever you launch Illustrator.

To create a customized Illustrator start-up file:

1. Create adocument with whatever settings you'd like to make the default.
2. Savethefilein Illustrator format, and name it "Adobe Illustrator Startup.”
3. Place thefilein the Illustrator Plug-ins folder.

4. Restart Illustrator.
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SUMMARY

WEe're learning more and more about Illustrator, and the dust is beginning to settle as we become
more familiar with Illustrator's feel and metaphors. We learned how to customize Illustrator to
tailor-fit our needs, and we learned how to set up afile, ready for use, with guides and grids.
Next, we will begin learning how to draw simple shapes, using Illustrator's primary drawing
tools.

Term Review

* Artboard -- Illustrator's term for the actual page you work on.

* Gradient -- An attribute referring to the blending of colorsinto each other.

* Anchor point -- The heart of a Bézier curve. More on thisin Hour 6, "Drawing Bézier Paths."

* Line screen -- Printing term referring to the number of dots per inch.

* Stroke weight -- The stroke is the outline of a shape, and the weight refers to the thickness of
the outline.

* Transform -- A function, such as scaling, rotating, or moving, performed on an object.

* Nudge -- The act of moving a selection incrementally using the keyboard arrow keys.

* Leading -- Typographical term for the space between lines of text.

* Baseline shift -- Typographical term for the vertical movement of text relative to the base.

* Tracking -- Typographical term for the addition or removal of space between |etters.

* Greeked type -- Gray lines used to substitute for small type on screen.

* Multiple undos -- An undo is the act of deleting the last thing you just did, making asif it never
happened (something we all need in real life). Multiple undos means you can go back several
steps.

* Plug-ins -- Adobe or third-party add-ons or extrafeatures for Illustrator. Extensis VectorTools
isan example of a set of plug-ins.

* Scratch disk -- A temporary area on your hard drive that Illustrator uses to calculate operations.
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DRAWING BASIC OBJECTS

Now the fun begins--you actually start drawing something. Y ou start with the easy shapes, such
as rectangles and ovals, moving up to polygons, stars, spirals, and freeform objects. One of the
great things about Illustrator is that there is usually more than one way to accomplish the same
thing. Asyou progress, you get afeel of when using one technique might be better in certain
situations than another. Specifically, this hour covers.

* Drawing rectangles and ellipses

* Drawing polygons, stars and spirals
* The Paintbrush tool

* Saving your work

TIP: Probably the most important thing about Illustrator--let me correct myself--the most
important things about Illustrator are the modifier keys--Shift, (Option), and (Command). Using
combinations of these keys when you are drawing with the mouse controls different options. It's
important that you become familiar with these key combinations to the point where they become
second nature, and you don't even think about them--you just do it.

RECTANGLESAND ELLIPSES

The most primitive shapes, rectangles, and ellipses are also the easiest shapes to create in
[llustrator. There are several ways of drawing these shapes, each a slight variant of the other, and
asyou work more in lllustrator, you get a better feel for when to use each method.

Aswe discussed in thefirst hour, Illustrator is avector art program. A vector rectangle or ellipse
consists of three things: a starting point, an ending point, and a center point. Y ou define the start
and end point and Illustrator cal culates the center point for you automatically. They say the best

way to learnisto do it yourself, so let's draw, shall we?

Drawing Rectangles

: 1. Select the Rectangle tool. Notice your

wg@ cursor becomes a crosshair.
C - |
[:i: 2. Position your cursor =i~ where you
' want the upper-left corner of the

rectangle to be.

F F

T

] 3. Click the mouse button, but don't let
g{' go. Drag down and to the right, and

3 release the mouse button.

F

k
g
O
4
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TIP: Holding the Shift key while dragging forces your box, or constrains it, to be a perfect
square, even on all sides. Throughout Illustrator, the Shift key is almost always the constrain key.
Using it often takes the guesswork out of creating and manipulating your illustrations, as
[llustrator does the work for you.

Using the Rounded Rectangle T ool

A rounded rectangle is one where the corners don't come to a point but are rounded.

1. Select the Rounded Rectangle tool. ' =
- ot
% 2. Position your cursor where you want
h_: [;: the upper-left corner of the rounded
- rectangle to be. .
v ARES
o 3. Click the mouse button, but don't let
& go. Drag down and to the right, and
7 e release the mouse button.
=i 1. =4

TIP: Holding the Shift key while dragging forces your rounded rectangle to have four even sides.
To change the corner radius of the rounded rectangle, see "Drawing Rectangles Numerically,"
later in this hour.

Drawing Out From the Center

Until now, we have been drawing our shapes by starting from the upper-left corner and dragging
to the lower-right corner. Illustrator can also draw shapes out from the center.

1. Select the Centered Rectangle tool.

ﬁ% Notice your cursor has changed to
| e 7 5] centered cross hairs.

g,
O

7,

Fl1A

2. Position your cursor ©i% where you
want the center of your rectangle to be. n

-

-

3. Click the mouse button, but don't |et
go. Drag outwards and release the
mouse button. -

L

p e T B |

-

-
-4

TIP: If you have the Rectangle tool selected and you want to draw a box out from the center,
hold down the (Option) key before dragging. See how your cursor changes between the regular
and centered cross hairs.
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Drawing Rectangles Numerically

The previously mentioned ways of drawing a box are great when you want to draw something
freely, but there are many times when you need to create a rectangle or square with exact
proportions.

1. Select the desired rectangle creation tool.

2. Click the screen and let go of =——— Rectangle

the mouse button. Illustrator

presents you with a dialog box. width:[3in |
3. Enter the width and height Height: (Cancel |
(and corner radius if necessary)

Corner Radius:|.25

and click OK.

Depending on which tool you have selected, Illustrator draws the shape from either the center or
the upper-left corner of where you clicked. Again, you can use the (Option) key to quickly toggle
between these two modes.

Ellipses

Ellipses (also known as ovals or circles) are dlightly different than the rectangles we've been
drawing. Whereas arectangle is made up of four straight line segments, acircle is made up of
four curved segments. In Hour 6, "Drawing Bézier Paths,” we talk more in detail about straight
and curved segments. Actually, drawing an ellipsein lllustrator is very similar to drawing a
rectangle.

: 1. Select the Ellipse tool. Notice your
Mg e cursor becomes a crosshair.
LSS

h [} 2. Position your cursor where you want
& - the upper-left edge of the ellipse to be. .
T
slln 3. Click the mouse button, but don't let
o — go. Drag down and to the right and ”
7 Eas rel ease the mouse button.

TIP: Holding the Shift key while dragging constrains your €ellipse to a perfect circle.
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Drawing Out from the Center

Y ou can also draw acircle from its center point.

1. Select the Centered Ellipse tool.
—E-%:’E Notice your cursor has changed to
¥ as centered crosshairs.
h‘ [§ 4 2. Position your cursor o where you
& T want the center of your ellipse to be. .
D. 3. Click the mouse button, but don't let
‘,:? y S go. Drag outwards and release the iz
: ’ mouse button.

Drawing an Ellipse Numerically

Aswith the rectangles, you can create an ellipse numerically.

1. Select the desired dllipse creation tool. |mm——— Ellipse
2. Click the screen and let go of the
mouse button. Illustrator presents you Width:| 2.5 in ll
with a dialog box. ) -

Height:|{4 in

3. Enter the width and height and click
OK.

Depending on which tool you have selected, Illustrator draws the shape from either the center or
the upper-left of where you clicked. Again, use the (Option) key to quickly toggle between these
two modes.

Great! Now that we can draw primitive shapes such as rectangles and ovals, let's move on to
drawing more complex shapes. Of course, after you create a shape in Illustrator, you can edit it in
all sorts of ways. We get to editing and transformations in Hours 7 and 12.

DRAWING OTHER SHAPES

The next three creation tools are really cool. They first appeared in lllustrator 6 as plug-in tools,
in their own little palette. Now they are fully integrated into the interface (grouped with the
Ellipse tool in the Toolbox), with all of their coolness intact. The three tools are the Polygon tool,
the Star tool, and the Spiral tool. These interactive tools create complex shapes in afraction of
the time it would take to draw them manually.
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The Polygon Tool

The Polygon tool is used to create shapes such as triangles, pentagons, and octagons (for those of
you who like making stop signs).

i 1. Select the Polygon tool.
m Notice the cursor is now a
SR A S different, smaller crosshairs.
ALY -
dh 1T, 2. The Polygon tool always
draws out from the center.
{:}; D. Click the mouse button, and
3= drag outwards. Do not let go
—— of the mouse button until

the last step of this '
exercise.

3. Rotate the polygon by moving your mouse in a circular motion.

4. Add more sides to the polygon by pressing the up arrow key on your keyboard. If you hold the
key down, it adds sides repeatedly.

5. Remove sides from the polygon by pressing
the down arrow key on your keyboard. Holding
the key removes sides repeatedly.

6. To keep the polygon straight (constrained at
90deg. or whatever the Constrain Angleis set to
in Preferences), press the Shift key.

7. Press the Spacebar, and the polygon "freezes,"
enabling you to move the mouse and position the

polygon on the page.
8. Thetilde key (~) creates duplicates of the ¥

polygon as you drag and moveiit. '
9. Release the mouse button.

Y ou can use any combination of the modifier keys simultaneously as you create your polygon.

A polygon can aso be created numerically by selecting the Polygon tool, clicking the mouse
button, and entering the radius size and the number of sides in the dialog box.
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The Star Tool

The Star tool is one of the great time-savers. It used to be areal drag to create stars and
starbursts--now it really isjust adrag!

' 1. Select the Star tool. \
=y ]
ﬁ 2. Stars are always drawn from the
I center. Click the mouse button and
- drag outwards. Do not let go of the
T, mouse button until the end of this
O] exercise.
Sel 3. Rotate the star as you are dragging SO
— it by moving the mouse in acircular
motion.
the star. w
5. Press the down
arrow key to remove
points from the star.
6. Press the Shift key
to keep the star
straight and aligned T8
with the baseline. L
7. Pressthe
(Option) key to
make the star's
"shoulders' form
straight lines.
8. Pressthe
(Command) key
to adjust the inner
radius of the star. ]
This controls '
how " pointy"

the star is. ol

Ll I

-

Ev

i

4. Press the up arrow
key to add points to

9. Press and hold the Spacebar to "freeze" the star, and position it on the page.



10. Pressthetilde (~) key to make numerous copies of your star as you drag.
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This image was created by holding down the Option, Shift, Spacebar, and tilde keys

simultaneously, while dragging the mouse.

Y ou can use any combination of the modifier keys simultaneously as you create your star.

Creating a Star Numerically

1. Select the Star tool.

2. Click the mouse and release the
button to bring up the dialog box.

3. Enter values for the outer and
inner radius (Radius 1 and 2,
respectively) and the number of
points. The outer radius, Radius 1,
is where the points facing
outwards extend to, whereas the
inner radius, Radius 2, is where
the points facing inward extend to.

4. Click OK.

Star
Options
Hadius 1: [3.04 in
Radius 2: [1.52 in
Points: = FN
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The Spiral Tool

There was atime when drawing spirals was very difficult, but it's easy now thanks to the Spiral
tool. By simply clicking and dragging, you can create interesting spirals while controlling the
number of winds (how many times it goes around) and attributes, such as whether the spiral goes
clockwise or counterclockwise. Do not confuse the Spiral tool with the Twirl tool, which looks
similar. Well cover the Twirl tool later in the book.

1. Select the Spiral tool.
ﬁ 2. Spirals are aways drawn from &
e the center. Click the mouse
- button and drag outwards. Do

& |'T not let go of the mouse button

g until the end of this exercise.
G L,
7 | 3< 3. Rotate the spiral asyou are

= dragging it by moving the mouse

in acircular motion.
4. Press the up arrow key to add segments (or winds) to the spiral.
5. Press the down arrow key to remove segments from the spiral.
6. Press the Shift key to constrain the rotation of the spiral to 45 degree increments.

7. Pressthe (Option) key to control the style of the spiral. This determines whether the winds go
to theright or the left.

8. Press the (Command) key to adjust the

decay of the spiral. This controls how far

"into the distance" the spiral goes.

9. Press and hold the Spacebar to "freeze"

the spiral, and position it on the page.

10. Pressing thetilde (~) key makes

numerous copies of your spiral asyou

drag. (See example on the next page.) i
Y ou can use any combination of the

modifier keys simultaneously as you

create your spiral.



Creating a Spiral Numerically
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1. Select the Spiral tool.

2. Click the mouse and
release the button to bring
up the dialog box.

3. Enter valuesfor the
radius, decay, and
segments and choose
astyle (clockwise or
counterclockwise).

4. Click OK.

T
Spiral
Options
Hadius: |1.05 in
Decay: |80 S
segments: =TT

Style: @ @j

0 ©)
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The Paintbrush Tool

Until now, we have been drawing predefined, symmetrical shapes. Now
W we move into the world of freedom--creating freeform shapes with the
| M ¥ Paintbrush tool.

k| k.

Drawing with the Paintbrush tool is easy. Just select the tool, press the

ﬁ F mouse button, and drag. Let go of the mouse button as you complete
r— each stroke in your drawing.
oo, y g
Sl The Paintbrush is actually creating afilled object in the shape you draw.
ﬁ El When using the Paintbrush, there are several options that can change the

way your drawing looks.

Double-click the Paintbrush tool in the Toolbox, and Illustrator presents you with the Paintbrush
Options dialog box.

Y ou can give the Paintbrush a calligraphic style for effect . Y ou can also change the line caps
and joins. But the most powerful feature of the Paintbrush tool is the ability to change the width
of your shapes. If you have a pressure-sensitive drawing tablet, you can set a variable width, and
the harder you press as you draw, the thicker your shapeis. If you do not have a pressure-
sensitive tablet, variable width is grayed out, and you are only able to set afixed width.

Save Your Work

No doubt, after thislesson, you created a masterpiece that you want to keep forever, so let's save
your work.

1. Choose Save from the File menu,

2. Givethe file aname and click OK.

You just learned to save afile. The very nature of a computer isto crash when you least expect it
to, and when you are relying on it most. It's agood idea to get into the habit of saving your files
frequently and keeping backups of them in case you lose them or they become corrupt.

SUMMARY

Y our feet are definitely wet, as you learned to draw simple shapes. Y ou had fun creating
polygons and using the Paintbrush tool, and you learned the power of using the modifier keys as
you draw. Next, you begin to learn to edit and manipulate the shapes you created today.

Term Review

* Modifier keys -- The Shift, Control, (Option), and (Command) keys found on your keyboard.
* Corner radius -- The amount of curve at the corners of arounded rectangle.
* Interactive tools -- Tools that et you change options on-the-fly as you are drawing with them.
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WORKING WITH SELECTIONS

Besides actually drawing your illustration, the most important things to master in Illustrator are
the selection tools. Please allow me to explain. Illustrator can do lots of things, but it has to know
where and when to do them. Let's say you have a picture of aface. If you want to make the eyes
smaller, you have to select the eyes before you perform the transformation, or Illustrator will
scale the whole face. By selecting only certain objects, or even just certain parts of an object, we
can tell Illustrator exactly what we want it to do and, more importantly, have complete control
over our file (see Figure 4.1). In this chapter we talk all about selecting objects, including:

* The selection tools

* Grouping objects

* Locking and hiding objects
* Arranging objects

There are three selection tools: the Selection tool, the Direct Selection tool, and the Group

Selection tool. We'll discuss each of them in detail, aswell aslearn to use each of them
effectively.

The Selection Tool

The Selection tool (or the black arrow, asit is most commonly called
because of its appearance) is used to select entire objects. You select an
object ssimply by clicking it (see the section "Area Select,” later in this
chapter). After an object is selected, you can move it by clicking the
mouse button and dragging the object.

Let's give the Selection tool awhirl, shall we? Make sure you have Illustrator open, and if you
don't already have an empty file opened, select New (Command-N) from the File menu.

1. Press D to set your colors to the default setting of awhite fill and a black stroke. Don't worry,
we'll go into detail about fills and strokesin Hours 10, "Fills," and 11, " Strokes."

2. Draw several rectangles on your page.

3. After you have drawn the last rectangle, choose the Selection tool from the Toolbox.

4. Click any rectangle. Notice that the object has become selected (see Figure 4.2). Y ou can see
the four anchor points of the rectangle, and its Bézier path has become highlighted in light blue

(when we discuss Layers in the next hour, we'll talk more about what color selected objects are).

5. Now that the rectangle is selected, click and drag the rectangle to move it to a new position
(see Figure 4.3). Release the mouse button when you have moved the rectangle to its new home.
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Figure 4.2 Figure 4.3

6. Deselect the rectangle by clicking any blank space on the page.

Now let's select and move more than one
object at atime.

1. Click any rectangleto select it. -

2. Press and hold down the Shift key.

3. Click another rectangle to add it to
your selection.

4. Now click and drag one of the rectangles,
and both selected rectangles move together.

5. Deselect the rectangles by pressing .
(Command-Shift-A), or by clicking any
blank space on the page.

" h‘ &
TIP: The Shift key is actually atoggle that adds or subtracts from your selection. In the previous
example, we selected rectangle number one and then selected rectangle number two while
holding down the Shift key. Now, with both rectangles selected, if you were to Shift-select

rectangle number two again, it would become deselected (go ahead and try it). The Shift key
makes an unselected item selected, or a selected item unsel ected.

The Shift key technique can really save time when making certain selections, too, asin the
following exercise, where we will try to select all the rectangles except for the one in the middle.
From what we've learned until now, you would Shift-select each rectangle until all were selected
except the one in the center. Depending on how many rectangles you have, that could be alot of
work!
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Now let'sdo it in two easy steps.
1. Using the same rectangles as the above exercise, press (Command-A) to select all.
2. Hold down the Shift button and, using the Selection tool, click the center rectangle.

Sure, this may not seem like such a big deal now, when we have just a few rectangles on our
page, but imagine if we had fifty, or even a hundred rectangles. Imagine how much time you'd
save then.

There isyet another way to select objects, and this one is called the marquee method, which
defines a selection by drawing a bounding box around what we want selected. Anything that falls
within the bounding box becomes selected. We will continue to work on the same file with all
our rectangles, as| am becoming rather fond of them.

1. Click any blank area onscreen or press (Command-Shift-A) to make sure that nothing is
selected.

2. Position your mouse to the upper left of the object(s) you want to select.

3. Press and drag the mouse down and to the right. Asyou drag, a dotted line appears (see Figure
4.5). Any object that falls within this "bounding box" is selected. If there are multiple objects,
you do not need to hold down the Shift key.

4. Release the mouse button, and the objects are selected (see Figure 4.6).

Figure 4.5 Figure4.6 =

Sometimes, using the marquee method saves alot of time, too, asin the case we presented
earlier, when trying to select all rectangles except for the middle one. Y ou can marquee-select all
the rectangles, and then Shift-click the center one to deselect it. Thisis especially useful when
working on one portion of a page, where using (Command-A) would select other unwanted
objects.
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The Direct Selection Tool

The Direct Selection tool, or as| liketo call it, the white arrow, isthe
E il selection tool used the most in Illustrator. In afew moments, you will see
= why. Aswe just learned, the black arrow is used to select entire objects.
k [% I The white arrow, on the other hand, is used to select parts of an object.

Although we could only move an entire object with the black arrow, the white arrow enables us
to move parts of an object, individually. Let's go back to our file with the rectangles and try to
move asingle point.

1. Click any blank area on the screen or press (Command-Shift-A) to make sure that nothing is
selected.

2. Choose the Direct Selection tool from the Toolbox.

3. Carefully select the lower-right corner of one of the rectangles.

=

NOTE: When you select just one
corner, notice that the selected
point you clicked onis solid, o
wheresas the other, unselected
points are hollow.

4. Press and drag down and to the
right. Notice that only the point that
you selected is moving--the rest of
the object stands still. Release the
mouse button.

-

Let'stry something alittle different now
and move a single line segment:

1. Carefully move your mouse right over
the edge of one of the rectangles. I
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2. Press and drag outwards. Notice how
just the one side moves--like moving two
points with one click.

3. Press and hold the Shift key as you
drag to constrain your move to 45deg.
angles.

= [{; ]
You're doing great! Now let's apply what we've learned up to now and move multiple points:

5

u]

1. Click and select one of the corners
(anchor points) of arectangle.

2. Now hold down the Shift key and
click the anchor point directly

opposite that point.

3. Click and drag one of the points. T
Because both points are selected, \
they both move as you drag. Y '

4. Release the mouse button.

Marguee selecting works here as well. Let'stry it.

1. Deselect any objects by pressing
(Command-Shift-A).

2. Marquee-select the bottom two
points of arectangle.

3. Press and drag on one of the points.
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Great! Now that we are familiar with the black and white arrows, we can go on to grouping
objects, and we'll learn about the Group Selection tool, which is avariation of the white arrow. |
mentioned before that the white arrow is the most used selection tool in Illustrator, and if you
hang in there just a few more minutes, you'll see the light.

GROUPING OBJECTS

Let's have alittle fun, shall we? Create a new document by choosing New from the File menu.
Draw 10 rectangles randomly throughout the screen. Now draw 10 circles. Okay, now imagine
you are showing thisincredible work of art to your boss. | can just hear him say it now: "That's
not what | wanted! | want you to shift all the circles over one inch to the left!"

He leavesin a huff, and now you must make a change. So we begin the wonderful task of

moving each circle one inch to the left--a time-consuming task, | assure you. So what do we do?
| was hoping you'd ask that question...

1. Using the black arrow, select one circle.

2. While holding down the Shift key, Type Filter
click and select the rest of the circles. %ri N

3. Choose Group from the Object menu. Arrange 4

Ungroup JETETE
I nrlr a8

You've just created agroup! To see what you've actually done, deselect everything (Command-
Shift-A) and then, using the black arrow, select just one of the circles. You'll be pleasantly
surprised to see that all the circles have now become selected. It is now easy to move all the
circles together. In fact, anticipating even more changes from our favorite boss, it might be a
good ideato group the rectangles as well. But before we begin selecting all our rectangles, |
think | feel another step-by-step coming on...

1. From the Edit menu, choose Select All (Command-A).
2. While holding down the Shift key, click acircle.
All the rectangles are selected. Because the circles are a group, deselecting one of them

deselected all of them. Now would be a good time to group the rectangles by pressing
(Command-G).
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Groups are extremely helpful when you are working in complex documents, and it's a good idea
to group items as you create them. After creating alogo, for instance, group it. Thisway you can
move it around easily, and more importantly, you won't accidentally lose parts by trying to select
each and every piece, every time (inevitably, you'll forget one or two).

To break up agroup, choose Ungroup from the Object menu (Command- Shift-G).

Groups can be nested, meaning you can have a group within a group, and so on. To better
demonstrate the next tool, please select both the circles and the rectangles and group them. You'll
now have one group of shapes that contains a group of rectangles and a group of circles.

The Group Selection Tool

The Group Selection tool is avariation of the Direct Selection tool (the white arrow) and can be
found by pressing and holding the mouse button on the white arrow in the Toolbox. In complex
illustrations, you may have nested groups that contain many groups. The Group Selection tool
makes working with these files easy. To demonstrate, we'll be working in the file with all the
circles and rectangles.

1. Deselect everything (Command-Shift-A).

2. With the Group Selection toal, click one of the circles. Only the circle you clicked becomes
selected.

3. Now click that same circle again. All of the circles are now selected.
4. Click that same circle again, and all of the rectangles become selected as well.

Each time you click with the Group Selection tool, it selects the next higher group, giving you
easy access to any group within a nested group.

| promised earlier to tell you why the white arrow is so important in lllustrator. Switch back to
the Direct Selection tool by selecting it from the Toolbox. Now press and hold down the
(Option) key. Notice that the Direct Selection tool has changed to the Group Selection tool.
Releasing the (Option) key returns you to the Direct Selection tool. Now you have the power to
select parts of an object, or, simply by holding down the (Option) key, you can select an entire
object, or entire groups! For 90% of your work, you never have to go back to the black arrow.

WORKING WITH SELECTIONS

We can already see that selecting objects can become complicated. Now we will learn how
[llustrator can help us out with selecting objects with certain settings and functions.
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Area Sdlect

We briefly mentioned Area Select in Hour 2, "Customizing lllustrator." In lllustrator's General
Preferences, we had the option of activating Area Select, which makes selecting objects easier
(by default, Area Select isturned on).

With Area Select turned on, you can select filled objects by clicking anywhere within the object.
When Area Select is turned off, you must click an anchor point or the Bézier path of an object to
select it. An object filled with the None attribute is considered unfilled and can only be selected
by clicking its Bézier path.

h

The box on the left is being selected with Area Select activated, whereas the box on theright is
being selected with Area Select deactivated.

Area Select only works in Preview mode. When in Artwork mode, you must click an object's
Bézier path (or center point--see the following sidebar) to select it.

There is also another option called Type Area Select, which is covered in Hour 14, "Adding

Text." Similar to Area Select, Type Area Select enables you to select type by clicking anywhere
on the text.

Journey to the Center of the Vector

One of the characteristics of PostScript art is that each object has a center point.

When you select an object, or view a page T T

in Artwork mode, you can usually see an [ Attributes ™, | b
object's center point. Illustrator has the

capability to show or hide the center point [ overprint Fil [ ] Overprint Stroke
of any object viathe Attributes palette. oy . .

Simply click the Don't Show Center or the 2 NESER ar!

Show Center button. When Snap-To-Point uRL:| [+]
isturned on, using the center point of an

object can be a big time saver and also [ Launch Browser |

make for easier alignment of objects.
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L ocking Objects

[llustrator gives you the ability to lock items. Locked items cannot be selected, moved, or edited
until they are unlocked. Thisis an important feature for when files get complex, and you don't
want to accidentally select objects you are not working on. There are aso times when severa
objects are very close to each other (or even overlaying each other), and selecting the right one
can be very difficult.

Type Filter By locking items that are not being edited, you can
o —a— ) quickly select and edit the correct objects.
Arrange 4 To use the lock and unlock feature, select an object
and then choose Lock (Command-L) from the
Group b Object menu. Y ou can lock several objects at atime,
Ungroup A or you can keep locking items separately. To unlock

all of your locked items, choose Unlock All
Unlock Al T (Command-Shift-L) from the Object menu.

Hidao Salartinn aol

Hiding Selections

If locking itemswon't do thetrick, Illustrator also lets you hide objects from view. This has
several uses. When working on one section of a complex file, hiding other parts makes it easier
to concentrate on what you are working on, aswell as make it easier for you to view what you
are drawing onscreen. Even more importantly, hiding certain objects can give you a big speed
boost. Placed images, objects filled with gradients or patterns, and other such items can severely
slow down your screen redraw. If seeing those itemsis not critical to what you are working on,
you can choose to hide those items, saving Illustrator from having to constantly redraw them.

To hide a selection, choose Hide Selection (Command-U) from the Object menu. Y ou can keep
hiding objects as often as you like, individually or in groups, but when you choose Show All
(Command-Shift-U) from the Object menu, al hidden objects become visible. Thereisno way to
reveal only certain hidden objects.

Hide Edges

Those of you who have used Photoshop are probably familiar with this function. When you
select an object, its path becomes highlighted in a color, and the object's anchor points become
visible. This can sometimes interfere with viewing the object, and can make editing and creating
artwork difficult, as well as annoying.

To hide a selected object's edges, choose Hide Edges (Command-H) from the View menu. With
edges turned off, you are not able to see which item is selected, so make sure you pay attention
to what you click.
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TIP: The Hide Edges command is atoggle, which means that it stays on until you turn it off by
pressing (Command-H) again. Too many times, it's easy to forget that you turned edges off, and
then you go crazy trying to figure out why nothing can be selected, when in reality, you just can't
see that they're being selected.

Arranging Items

Although all drawn objectsin Illustrator are on the same screen, they each appear in the order
that they were drawn. In other words, if you were to draw two rectangles, one on top of another,
the second rectangle would cover the first one and hide it from view. It's similar to having a stack
of papers on your desk. If you want to shuffle the order of pages, you would take a paper from
the bottom or middle of the pile and put it on top. Or you might take a paper from the top of the
pile and move it to the bottom.

[llustrator gives you the
ability to move objects
all throughout the "pile."
Under the Object menu

ILEIA e Type Filter UDiew Window
Transform rEeEeE———
Arrange Bring To Front %] [

you can find the Arrange : Bring Forward ]
submenu, which Group %6 | Send Backward 3
contains four Ungroup <+#06 | Send To Back {3
commands. Lock 8| |

Bring to Front:

Bring Forward:
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Send Backward sends the selected object one level backward, similar to putting a paper directly
under the one it's resting on.

Send to Back sends the selected object to the rear, similar to putting a paper on the bottom of the
pile.

When using groups, each group hasits own set of levels. So if you bring an object that is part of
agroup to the front, it goes to the front of that group. In order to bring the object to the front of
everything, you need to select the entire group and bring the whole group to the front.

SUMMARY

After learning all about selections and how they work, you should be feeling comfortable with
moving things around, as well as know how to work with groups. Y ou should also be ableto
lock and hide objects to make working easier. We also learned about arranging items and how
objects are layered. In the next hour, we discuss Illustrator's layers, which is a powerful step
above the kind of layering we just learned.

Term Review

* Fill -- The attribute that determines a color, gradient, or pattern for the interior of a shape.

* Stroke -- The attribute that determines the outline of an object.

* Group -- A collection of objectsthat all become selected when just one item in the group is
selected.

* Selection tool -- The tool that looks like a black arrow; used to select entire objects.

* Direct Selection tool -- The tool that looks like a white arrow; used to select parts of an object.
* Group Selection tool -- The tool that looks like a white arrow with a plus sign next to it; used
for selecting groups.

* Marquee -- A rectangular-shaped bounding box indicating an area to be selected.

* Center point -- A non-editable point that appears at the center of a vector object.
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WORKING WITH LAYERS

In the last hour we covered moving objects to the front and to the back. We learned that each
object was on its own level. Continuing on the topic of levels, it's time to learn about the king of
al levelsin lllustrator: layers. If you've worked in Photoshop, you're probably familiar with the
concept of layers. If you'll forgive me for using the analogy, layers are similar to mechanical
overlays. Clear sheets of acetate, these each contain parts of artwork, and when they arelaid over
each other, they form the complete art. Layers are extremely versatile and can really help keep
complex illustrations under control and manageable. By viewing only certain layers, you can
concentrate more easily on the task at hand.

The Layers Palette

. New Window
[llustrator's layers are specified

in the Layers palette. When you

start adocument, all artwork is Hide Tools
automatically placed on alayer.
To open the Layers palette, Show Info
choose Show Layers from the Show Transform
Window menu. Show Align
Hide Color
Show Gradient
Hide 5troke

Show Swatches
Swatch Libraries 3

Show Layers
Show Attributes

|

1 Layer | &l |

Editing Layers

There's asmall controversy between designers as to when to create layers. Some artists prefer to
create several layers before they begin working, adding the art to each layer as they progress.
Others prefer to add or delete layers as necessary, as they work on a project. Still otherslike to
create the entire piece, and then chop it up into different layers. No matter which way you do it,
though, you have to learn how to add and discard layers.
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Creating a New Layer

The easiest way to create anew 1]
layer isto click the New Layer L :
button at the bottom of the Sl | EI.,,J | @ |
Layers palette.

_reate new layer |

[llustrator creates the layer and assigns it a name. Don't worry, you won't have to keep your
layers named "Layer 1" and "Layer 2." We'll change that when we learn about layer options later
this hour.

Another way to create anew layer isto select New Layer from the Layers pal ette menu.

[ i
4 E :
"S- Duplicate Layer
o B Security Delete “Parking Garage”
Pate] Suites Options for “Parking Garage”...
= B Co-ops
| F || Cheap Hotel Rooms Show All Layers
B Offices Preview RIl Layers
B | | O Health 5pa Unlock All Layers
B Restaurants Paste Remembers Layers
w O Retai Stores
o E Lobby Merge Layers
JL
10 Layers | = | T P__J

Deleting a Layer

To delete alayer, click the name of alayer and drag it to the Trash icon in the lower-right corner
of the Layers palette. Alternatively, you can delete alayer viathe Layers pal ette menu. But what
if the layer you are deleting contains artwork? Turns out Illustrator is keeping a watchful eye out
for us. If you try to delete alayer with art on it, you get a warning message alerting you about the
situation, and Illustrator only proceeds to delete the layer and its contents if you click OK.
Otherwise Illustrator returns you to the document with the layer intact, where you can copy the
art to another layer (see "Moving/Copying Items Between Layers' later in this hour).



HOUR 5

Duplicating a L ayer

Sometimes you want to make a copy of an entire layer. Y ou can easily create a duplicate of a
layer by clicking the name of an existing layer and dragging it to the New Layer icon on the
bottom of the Layers palette. Again, you can also create a duplicate by selecting Duplicate Layer
from the Layers palette menu. The attributes, as well as all the artwork contained on that layer,
are duplicated, and Illustrator adds the word "copy" to the layer name.

LAYER OPTIONS

Each layer has severa attributes that facilitate your work, as well as add functionality to the
layers. Double-clicking the name of alayer brings up the Layer Options dialog box. Here you
can name the layer, which is an important step. As you add more and more layers, it becomes
increasingly difficult to remember which items are on Layer 23 and Layer 14. By giving intuitive
names to layers (such as "Template," "Wheels," or "Ad Copy"), you can quickly identify where
items are. In the Layer Options dialog box, you can also assign a selection color (see"Layer
Colors," later in this hour), and choose to show, preview, or lock the layer (these are also
discussed later in this chapter).

Layer Options

Name:

Color: | Green - | [ Cancel |
Show Print
L Preview [ Dim Images
Lock

There are two more options found in the Layer Options dialog box: Print and Dim Images. By
unchecking the Print box, you are telling Illustrator that you do not want the objects in this layer
to print. Y ou might want to create a layer where you write notes to yourself or a colleague, and
putting it on a non-printing layer assures the text won't print when you send it to aclient or for
film separations. There also might be times when you have a complex illustration but only want
to print specific parts of it.

TIP: In today's fast-paced world, a designer is sometimes forced to send afax of adesignto a
client for instant approval. Fancy backgrounds and tints, however, can make text very difficult--
if not impossible--to read when faxed. If you create your text and backgrounds on separate
layers, you can use Layer Optionsto print only the text layer so that your client can read the clear
text without the background. Just remember to set the background layer to print again before you
send for final output.
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The Dim Images button is used for when you want to use placed images as a template. Upon
placing a bitmapped image, Illustrator dims the image to make it easier to trace over it. Try to
avoid using thisfeature if possible, asit slows screen redraw. Of course, if you have no other
choice, remember to turn the option off when you are done tracing. For more details on tracing
images, see Hour 21, "Working Smart in Illustrator.”

Layer Colors

If you have one or two layersin your document, it's pretty ssmple to keep track of which objects
are on which layer. But in a document with many layers, it becomesincreasingly difficult to
remember which objects are on each layer. To make it easier to identify which object is on which
layer, acolor is defined for each layer. When an object is selected, it is highlighted in the color of
its layer. When you create anew layer, Illustrator automatically assigns a new unique color to
that layer. To change the color of alayer, simply double-click the layer to bring up the Layer
Options dialog box, choose a new color, and click OK.

Arranging Layers =
Layers

What good would layers be if you T B Parking Gar
couldn't shuffle the order of them A 2nd a3t age
around? By simply pressing and 2 B Security
dragging on the layer name, you can B Hotel Sujtes
change the order of the layers. The order =
of layers determines which objectsarein = Co-ops
front of others. The objects of alayer W | [ | @ Cheap Hotel Rooms
closer to the top of thelist in the Layers 3
pal ette appear on top of those objectsin ': Eoee £
layers closer to the bottom of the list. T R Y

: : B Rest t
M oving/Copying | tems iadshadi
Between L ayers w O Retail Stores

o @ Lobby

Many times you need to move objects i
from one layer to another. Instead of =
making you copy and paste objects, | 10 Layers | & | & [&

[llustrator has an intuitive feature built
into the Layers palette specifically for moving and copying objects between layers.

M HATelSURES 5 When an object is selected, notice alittle
dot on the far right of the layer name in
the Layers palette.

@ | 3% | @ cheap Hotel Rooms

To move your selected object to another layer, simply click and drag the dot to another layer,
and the object istransferred to the new layer. The selection color changes to the new layer's
color, too.
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To copy objects to another layer, press and hold the (Option) key as you drag the dot. A copy of
your selection is put into the new layer.

Locking and Hiding Layers

One of the advantages of using layersisthe ability to quickly lock or hide the objects on each
layer. Notice that to the left of each layer are two boxes.

Offices The left-hand box controls the view,

W | F | O Health Spa whereas the right-hand box controls
locking. An eyein the left box indicates that
the layer isfully visible in your document.

B Restaurants

To hide the layer, click the eye, and the objectsin that layer aren't visible in your document.
Clicking again in the left box makes the layer visible. If you press and hold down the
(Command) key while you click in the left-hand box, you set the layer to Artwork mode, as
opposed to Preview mode.

o The little eyeicon is hollow, indicating the change. Simply
(Command-click) again to return the layer to Preview mode.

Click in the right-hand box and a pencil with aline through it appears indicating that the layer is
locked. Objectsin alocked layer are visible in your document, but cannot be selected. To unlock
the layer, click again in the right-hand box.

It'simportant to remember that regardless of whether alayer isvisible or locked, it prints unless
you specify it as anon-printing layer in the Layer Options dialog box.

SUMMARY

Layers are an important part of Illustrator, and we covered that in depth today. Although you
may not use layers for ssimple illustrations, they can really come in handy as your illustrations
become more complex. Speaking of complex, the next chapter introduces you to the most
difficult part about Illustrator: the Pen tool and the Bézier curve--the heart of Illustrator.

Term Review

* Layer color -- Refersto the selection color of items on that layer (that is, if an object is
selected, its anchor points appear in the color of that object's layer color).

* Layer order -- The stacking of layers upon each other. The layer order is determined by the
position of each layer in the stack.
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DRAWING BEZIER PATHS

Strip away al of Illustrator's fancy features and new interface, and you're left with the heart of
[llustrator--the Bézier path and the Pen tool. Since version 1.0, the Pen tool is probably the main
reason why Illustrator has become one of today's best illustration programs. Comfortable,
elegant, and functional, the Pen tool gives you complete control when creating and editing the
base of al vector illustrations--the Bézier (pronounced BEH-zee-ay) path. In this hour, we
discuss:

* The Bézier path
* Anchor points
* Drawing with the Pen tool

The Bézier Path

So what is a Bézier path anyway? It's a mathematical way of representing graphics, developed by
Pierre Bézier (it was originally created to put designs of aircraft on a computer, and then later for
designing cars). All vector objects are made up of Bézier path segments. Bézier paths comein
two flavors, lines and curves. Let's discuss the difference between them.

The first type of Bézier path is a straight line and contains two anchor points with a straight line
connecting them. Thisisthe simplest Bézier path and requires the least amount of memory to
store and print. All that is needed is the coordinates of the first point and the second point.

B u
Anchor Point Anchor Point

The second type of Bézier path isthe curve, and hereis where it gets complicated. A curve
consists of two anchor points, with a curved line connecting them. The curve is determined by
control points, which are attached to each anchor point (see Figure 6.2). The control points (also
called handles) define exactly how the curved line is drawn between the two anchor points.

Of course, when the paths print, you won't see the anchor points or the handles. They are just
there onscreen so that we can edit them, but when they print, all you seeistheline.

Up until now, we've been creating Bézier paths without even knowing it. The rectangles,

ellipses, stars, polygons, and spirals that we've created are all made up of Bézier paths. We were
doing fine until now, so why bring in all of this complicated anchor point and control point stuff?
Asthey say, ignoranceis bliss. Sure, you could do alot of thingsin Illustrator without knowing
what Bézier paths are. But you lose out on all the power that Illustrator offers. There are other
programs out there that have more features than Illustrator. In fact, | think it would be safe to say
that of al of the major illustration packages on the market, Illustrator has the least number of
features. lllustrator's power lies within the Pen tool and the implementation of Bézier paths.
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Figure 6.2
Control Point

Anchor Point

Anchor Point

Control Point

CAUTION: Before we begin learning how to create and edit Bézier paths and use the Pen toal, |
want to make the following disclaimer:

Drawing and editing Bézier paths requires much patience and time. But you have alot to look
forward to--it also gets better with experience. | look back now at some of the art | created asa
beginner, and | can't help but wonder, "What was | thinking?' There is no doubt that you will
become comfortable with the Pen tool; you just have to give it time. Do the exercises listed here,
practice alot, and before you know it, you too will be looking back in wonder. But more
importantly, you will have harnessed the power of the Pen tool.

THE PEN TOOL

[llustrator's Pen tool is rumored to be the most inhumane torture tool ever devised by man. But
fear not, there is a method to the madness, and perseverance will prevail. The Pen tool is used to
create precise Bézier paths of virtually any shape or form. It works by creating anchor points,
which are the basis of Bézier paths.

NOTE: Some of you who have used Photoshop know that there is a Pen tool in Photoshop as
well, for defining clipping paths and precise selections. Both the Photoshop and the Illustrator
Pen tool work identically, and you can even move Bézier paths between the two programs easily
using cut and paste or drag and drop. It's integration such as this that really makes for intuitive,
useful, and practical applications.
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THE ANCHOR POINTS

There are three different kinds of anchor points: the straight corner point, the smooth point, and
the combination point. Each kind of anchor point has its specific attributes, and each is used to
create different types of paths. A Bézier object can be made up of any of the three kinds of
anchor points and can contain any combination aswell. A square is made up of four straight
corner anchor points, for example, whereas a circle is made up of four smooth anchor points. A
shape such as a pie wedge contains both straight corner and smooth anchor points. Aswe go
through the following hands-on exercises, you'll get a better feel for anchor points and
understand how they work.

The Straight Corner Anchor Point

The straight corner is the simplest form of the anchor point, and it is used to define straight lines
such as the ones shown previously. Before we begin using the Pen tool, it should be mentioned
again that Illustrator's cursors change to indicate the current status of atool. The subtle
differences in the Pen tool cursor will be pointed out as they occur. If you goof anytime
throughout the exercises, don't worry, just use the Undo command (Command-Z).

1. Let's start by opening a new Illustrator document (Command-N).

2. Select the Pen tool from the Toolbox. Feb i AR |
ol T,

ﬁ"x Notice that the Pen tool cursor has asmall "x" | [
on the lower right. Thisindicates you are starting a new path. =

|
-,

3. Let'screate a
triangle. Click once.
Click again to the lower
right, and again to the
left . Notice that the
cursor has now changed
to aplain Pentool,
indicating that you are
in the midst of creating .
a shape. s -

g

4. Now drag your cursor up to the first point you created. Notice that when the cursor touches
the point, alittle "0" appears on the lower right of the Pen tool cursor. {5&
This indicates that you are about to close, or complete, a path.

5. Click the top anchor point to complete the triangle. The Pen tool cursor @
appears with the "x" again, ready to start a new path.

Congratulations! Y ou have just created your first shape with the Pen tool.
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The Smooth Anchor Point

The smooth anchor point contains two control points, or handles. By adjusting the control points,
you determine the slope and sharpness of the curve on either side of the point. Because the path
continues through the point without a sharp change in direction, it's called a smooth anchor point.

1. Using the Pen tool, press and drag a point to the right, about half &
an inch. Notice that when you drag, you are pulling a control point out from the anchor point.

2. Release the mouse button. 4. Press and drag down about half an inch.

B e i

3. Move your cursor about one inch down
and to the right of the first anchor point--not
the control point.

= e &

v 4
5. Release the mouse button. Y ou should now seethefirst arc of acircle.

6. Move your cursor one inch down and to 7. Press and drag to the left about half an inch.
the left of the last anchor point you created.

[ =

-
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8. Release the mouse button. We're halfway there!

9. Move your cursor one inch up and to 10. Press and drag up
the left of the anchor point you just created. about half aninch.

11. Release the mouse button.

12. To complete the circle, repeat Step
1--click the first anchor point we created
and drag about half an inch to the right.

13. Release the mouse button, and voilal
acirclel

So we see that by pressing and dragging
apoint, we can create a smooth anchor
point with control handles. Control
handles determine the direction of the
curved path. To demonstrate, switch to
the Direct Selection tool (the white
arrow) and click the line of the circle.
The control points are now visible for
that section of the path. Press and drag
on one of the control handles, and see
how the path behaves when you move the control point.

Generaly, the direction of the curve follows the control point. Try to avoid stretching the
handles too far from the anchor point as it makes for difficult editing (the ideal guideline
shouldn't exceed one third the length of the curve). Again, as you work more and more with
control points, you get a better idea of where to place them and how to achieve the curve you
want.
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The Combination Anchor Point

Okay, we're building confidence now, and we're really going to need it. The Combination Point
Is--get this--a combination of the straight anchor point and the smooth anchor point, and things
can get a bit confusing.

1. Let's begin by pressing and dragging a point down about one inch. Release the
mouse button.

2. Position your cursor one inch to the right of the first anchor point.

3. Click the mouse. (A single click 4. Position your cursor directly atop
completes the path--the first anchor atop the anchor point you just created.
point was a smooth point, the second Notice that the pen cursor now
astraight point.) includes asmall inverted "V"

L

ﬂ 4 4

5. Click the point, and drag down one inch (holding the Shift key while you drag keepsit a
straight line).

6. Repeat Steps 2 through 5.

In the above exercise, you create a straight anchor point, which has no control handles, when you
click. By dragging out of the straight point, you are defining the next connecting path and anchor
point. So, in reality, the combination point has two sidesto it: astraight side (from the single
click) and a curved side (from the click and drag).
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Open the folder called Templates--included with the PDF version of this book. Inside, you will
find four Illustrator files that lead you step-by-step through the examples shown above, plus two
extras, so you can get a better feel for the Pen tool.

True, in these examples, you were told where to place the anchor points and the control points. If
you were creating any other random shape, you would have to decide where those points belong
on your own. After getting afeel for how anchor points and control points affect the path, you
will be able to make these decisions on your own.

Open and Closed Paths

A pathin Illustrator can either be open or closed. An open path has two endpoints, whereas a
closed path has none--one end joins the other. As you draw with the Pen tool, Illustrator uses the
current fill and stroke attributes for your shape. As you complete each click, Illustrator attempts
to fill the shape using the current fill, so do not be alarmed by the pop-up alert boxes. Just
continue following the steps in the exercise. We cover fills and strokes in detail in Hours 10 and
11.

SUMMARY

Whew! Thiswas the hardest chapter yet. Give yourself abig hand for making it through the
horrors of the Pen tool. But don't worry, it will become second nature before you know it. We
also learned about Bézier paths and the different kinds of anchor points. Next we work with
Bézier paths after we've created them. Thisis going to be fun!

Term Review

* Bézier path -- A mathematically defined line consisting of anchor points and control points.
* Open path -- A Bézier path with two open (unconnected) endpoints.

* Closed path -- A Bézier path that is fully enclosed; it has no beginning and no end.

* Anchor point -- A defined point on a Bézier path.

* Control point -- A defined point that is part of an anchor point, used to control the curve of a
path.

* Smooth point -- An anchor point in which its control points are tangent to the anchor point.

* Corner point -- An anchor point with no control points; for defining straight lines.

* Combination point -- An anchor point that shares the attributes of both a smooth point and a
corner point.
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EDITING BEZIER PATHS

No oneis perfect, and there are always times when you need to edit a path to get it just right.
There are also plenty of times when you create a simple path and modify it to create amore
complex path. Perhaps the greatest advantage a computer offersisthe ability to easily make
changes over and over again. In lllustrator, editing a path can be done in several ways, and this
hour we discuss these issues, including:

* Adding and deleting anchor points
* Using the Reshape tool

* Cutting paths

* Joining paths

* Manipulating Existing Points

After you draw a path, you might want to change the shape or style of the points, adjusting the
curve of the path or making a corner point a smooth point. There are several tools that enable
you to modify a path by changing, adding, or deleting points.

The Direct Selection Tool

Perhaps the simplest form of editing a path is with the white arrow, or Direct Selection tool. By
selecting only one anchor point you can reposition it. By selecting a path and then dragging on a
control point you can change the shape of the curve.

*

TIP: The P key isthe keyboard shortcut for the Pen tool. Pressing it repeatedly cycles through
the Pen tool, the Add Anchor Point tool, the Delete Anchor Point tool, and the Convert Direction
Point tool.
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The Add Anchor Point Tool

Simplein concept, the Add Anchor Point tool enables ﬁ-’r 5

you to put additional anchor points on an existing path. ..‘ [3':

The new point takes on the attributes of the path that you :

click. If you add a point to a straight path, the new anchor ﬁ & + ﬁ_
point is a straight anchor point, and clicking a curved

path results in a new smooth anchor point. QT | X

here...
and here...

The Delete Anchor Point Tool

The Delete Anchor Point tool, shown in Figure 7.4, ﬁ# =

simply deletes existing points. By clicking an anchor k|

point with the Delete Anchor Point tool, the point is :
removed, and Illustrator automatically joins the ﬁ & ¢+ &_
preceding anchor point with the next point on the

path. Here, we've deleted the lower-right point: = E

¥ ] ] L]
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The Convert Direction Point Tool

What do you do when you already have an anchor F

point but you need to change it from one type of -

point to another? Y ou use the Convert Direction h [j;:

Point tool. The last tool from the pen tool quartet, ===

the Convert Direction Point tool can easily be h R I
accessed by pressing (Command-Option) when the T g
Direct Selection tool is active. Notice the cursor - :

changesto an inverted "V" shape.

[

Working in the same way the Pen tool does, clicking a point converts it to a straight anchor
point. Pressing and dragging on a point makes that point a smooth anchor point. In order to make
a smooth point into a combination point, press and drag on a control point.

&+

If you want to convert a straight anchor point to a combination point, you must first make the
point a smooth point, then press and drag on the control point.

EDITING PATHS

[llustrator 7 offers several toolsfor controlling and editing paths. The newest, the Reshape tooal,
modifies the shape of a curve without requiring you to select a control point. The Knife and
Scissors tools cut paths, whereas the Join and Average commands connect paths together.
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The Reshape Tool
One of the new features of Illustrator 7 is the o Wy
Reshape tool. By simply clicking and dragging ﬁ 155
apath, you can reshape a curved path without - |E1 =
having to select a control point. Even more 1] (7] iJ
important, the Reshape tool has the capability 4] a?|
to edit multiple control points at the same time. 0. | Reshape Taol (S} ]
In contrast, the Direction Selection tool can O | WUH,
only edit one control point at atime. T
% s .'E.l Thefirst star isthe
mais L /f_.-*" e R original. The second star
S i / has been scaled, but notice
T o N S it was only stretched at
) \ f \ Fa one point in the object.
N 4 ! The third star was scaled
W) a 1y ! ¥ = o with the Reshape tool.
i 4 iy ; . = Notice how the scale has
= - 5 _l' “'h.:' - .
Ve o p o ; \ been applied evenly
T B ‘iII"J:.J #=F g EQ*H‘:.J =T 7 g *i_:“-:u thr_oughout the selected
|.'|'lr 'EI t 4 I"E'I i |:|Ilr \/ \. points.

The Reshape tool can also quickly add pointsto a path to increase the editabilty of the path.
When you move the Reshape tool over a part of the path where no point exists, the cursor
changesto indicate that a point can go there.

By Simply clicking or pressing and dragging places the point.

The Scissors T ool

Sometimes editing a path calls for splitting it in two. The Scissors tool f:f ]
is used to sever an individual path. With the Scissors tool selected, you 7 : g{
can click anywhere on any path and Illustrator severs the path where : :
you clicked. A path need not even be selected when using the Scissors o B
tool, so be careful where you click when using it. S R

The Scissors tool can be quite a pain to use, as you have to click exactly on the path you want to
cut. Also, in most cases, you are using the Scissors tool to cut aline and join it to another, which
just means more editing. If all the clicking and joining frustrates you (as it does me), then stick
around when we get to Hour 13, "The Pathfinder Commands,” where we learn about some cool
path editing commands. Y ou'll never use the Scissors tool again...
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Based on the same premise of the Scissors tool,

the Knife tool is used to sever objects.
The similarities end there, however.

!

i) (54 ]
*

To usethe
Knife tool, drag
it over an
object, and the
object isdliced
where you
dragged, just as
if you had cut it
with aknife,
leaving you two
(or more) filled
objects.

An important
thing to
remember hereis
that the Knife
tool cuts through
all objects that
crossits path,
even unselected
ones. So
dragging the
Knife tool over a
group of items
dicesadl of the
items.

Thisisagreat feature that has alot of uses, but there are aso times when you only want to cut
through one selected object without cutting what is underneath.
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To cut through one selected object, hold down the Shift key before pressing and dragging, and
[llustrator only slices the selected object. Holding the Shift key also constrains the Knife tool to
dicein straight lines only.

TIP: After you start dragging with the Shift key down, you can release the Shift key and draw a
freeform path, and Illustrator still only slices the selected object. Y ou can also slice multiple
objectsin straight lines by first pressing and dragging with the Knife tool and then pressing the
Shift key.

The Join and Average Commands

Alas, there will come atime when you want to connect one path with another. Say you have a
square, for example, but only three sides have lines between the points. Y ou need to connect the
last two points to complete the square. It's easy with the Join command. Found by choosing Path
> Join from the Object menu, Join does one of three things:

* Close an open path if the entire path is selected (see Figure 7.17).

* Connect two separate points with aline, be it the endpoints of a single path or the endpoints of
two different paths (see Figure 7.18).

* Connect two overlapping points by combining them into one point.
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Figure 7.17

Figure 7.18
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When joining two =—— Juoin
overlapping points,

[llustrator asks if you want Points

to make the new combined @ Corner
point a smooth or corner ¢ Smooth

anchor point.

The Average command is also found in the Path submenu. Basically, Average enables you to
align selected endpoints of a path or paths. When you have two or more points selected, using
Average aligns them either vertically, horizontally, or both.

From left to right: original lines with the left endpoints selected, then averaged horizontally,
vertically, and both.

Drawing Paths with The Freehand Tool é Iil
Now that you've learned al about the Pen tool, there's a much i-,? F<
easier way to draw a Bézier path. The Freehand tool--no relation - -

to therival program FreeHand--lets you click and drag on the E'
screen, and Illustrator places the anchor points for you. s s

7

So why bother with the Pen tool ? Because it's very difficult to create precise drawings with the
Freehand tool. It's great for say, signing your name, or making quick sketch lines, but for most of
your work, the Pen tool is better. Besides, after creating a path with the Freehand tool, you may
still haveto "clean it up" by editing the path. Now that you can edit anchor points and handles,
it's easy to work on any path, no matter how it was created.

Drawing with the mouse (or even atablet) is not anything like drawing with a pencil, and it takes
time to get comfortable with the way a mouse or tablet stylus feels. To make life a bit easier, you
can control how sensitive Illustrator's Freehand tool is by changing the setting in the Curve
Fitting Tolerance box found in General Preferences.



HOUR 7

Curve Fitting Tolerance: [10 pizels

Auto Trace Gap: |0 pisels

As| mentioned in Hour 2, "Customizing Illustrator,” you can use a setting anywhere from 1 to
10, 1 being the most sensitive to every move, and 10 being the least sensitive, making for
smoother lines.

TIP: Holding down the (Command) key while dragging with the Freehand tool changes your
cursor to an eraser that you can use to quickly delete parts of your path while still drawing with
it. [llustrator only erases the path in the reverse order in which you drew it, and you cannot erase
aportion from the middle of your path.

SUMMARY

We now know the different ways you can edit Bézier pathsin Illustrator, and we learned how to
modify paths by cutting them with the Scissors and Knife tools and aso by joining and averaging
them. We also learned how to use the Freehand tool. Y ou're doing great, and in the next hour we
explore compound paths and masking techniques.
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COMPOUND PATHSAND MASKS

Until now, we have dealt with single objects in Illustrator--a square, acircle, a star, even a set of
waves. Now, we begin to utilize several objects together. | am not referring to the kind of groups
we covered back in Hour 4, "Working with Selections.” Each of the concepts covered in this
chapter use more than one object to create what looks like just one object, such as:

* Compound paths
* Masking objects
* Masking placed images

COMPOUND PATHS

Let's think back to our chemistry days. Remember what a compound is? It's a substance made up
of amixture of two or more elements. Similarly, a compound path is a path made up of two or
more paths. So you're probably wondering, how is that different from making a group? Well, a
group isjust abunch of objects al thrown together, but each object is separate by itself. Ina
compound path, all the paths included are considered to be one path. Y ou can't fill each shape
with a different color--the entire compound path can only have one fill and stroke attribute.

So what are compound paths used for? For making objects with holes "cut out” of them, such as
the letter "O."

As acompound path (left) you can see through the letter "O," but if the "O" istwo paths, just a
black circle with awhite one on top, you can't see what is behind the "O."



Now let's create our own
compound path:

1. Draw anice-sized
rectangle.

2. Draw acircle within the
rectangle.

3. Select both objects.

4. Press (Command-8), or
choose Object > Compound
Paths > Make.

You canrelease a
compound path by pressing
(Command-Option-8) or by
choosing Object >
Compound Paths > Release.

So now | know how to
create a compound path,
but how does it work?

[t'sAll in the Direction

The most significant and
unigue aspect of a
compound path is the ability
to change the direction of a
path within the compound.
All shapestravel in one
direction, either clockwise
or counter-clockwise. In a
compound path, paths can
run both clockwise and
counter-clockwise.
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Let'slook at the "O" again. Notice that the direction of the inner path is going in the opposite
direction of the outer path.

How does this give the "O" a hollow center? Well, imagine you had a pair of scissors, and you
had to cut out the letter "O." How would you cut it out using only one cut, not two? Y ou'd cut
around the outside of the "O" then dlice through the "O," and cut the inside out (see Figure 8.5).
Notice that when you're cutting the inside, you're going in the opposite direction than you were
when you were cutting the outside. Although you can't see where the diceis, in redlity, that's
what Illustrator is doing.

There might be times when you need to change the direction of a path in a compound path
(especially when you have more than two paths) in order to make the path hollow. In the
Attributes pal ette (Command-Shift-1) are the Reverse Path Direction buttons (see Figure 8.6).
They are only active when a compound path is selected. Click either button to reverse the path to
make a shape hollow.
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Figure 8.5
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MASKS

What's a mask? Just like a mask covers part of your face, amask in Illustrator covers part of your
artwork. Say you have this photo of your graduating class, for example, and you want to just
show the part with you and your best friend, who is standing next to you. By drawing a square
and making it amask, you can have only the parts of the photo that are behind the square be
visible. Therest of the photo does not show.

For this next exercise, | created afile, called Shapes, that contains many circles and squares. Y ou
can either try and duplicate thisfile, or create one of your own (If you create your own file, make
sure to group al of the art when you are done).

@0 0
HOENONO
JE ]

HOEONO

1. With the file open, draw a new shape, about half the size of the artwork. I've chosen to use a
star. Notice the shape blocks out a good portion of our artwork becauseit isin front. A mask
must always be in front of the artwork (see Figure 8.8).

2. Select everything by pressing (Command-A) (see Figure 8.9).
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Figure 8.8
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3. From the Object menu, choose Masks > Make. Deselect all by pressing (Command-Shift-A).

You just created amask! Y ou only see the artwork that is within the mask; the rest is hidden.

I\
advhw

' 4 ‘\

But don't worry, the rest of the artwork is still there. In fact, one of the greatest things about
[llustrator's Mask feature is that you can move the artwork within the mask. Let'stry it!

1. Choose the Selection tool (black arrow).

2. Click one of the circles or squares. Because the artwork is grouped, it al becomes selected,
except for the mask of course.

3. Movethe artwork about an inch to the | eft.

Of course you can even edit the artwork, and the mask will still be in effect. To remove the
mask, select it and choose Object > Mask > Release.
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So amask isjust like awindow where you can place different images behind it and move them
around for quick and easy editing and positioning. Masking is also great with placed images and
with type, which we get to in later chapters.

SUMMARY

This hour covered two very important concepts. compound paths, which basically enable us to
cut holes through the middle of objects, and what a mask is and how we can use masks to control
what parts of an image or what parts of objects are visible. Are you ready for alittle splash of
color? Better get your smock ready for the next hour!
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COLORING OBJECTS

Well, all these shapesin black and white are nice, but let's move out of the dark ages, and start
our own renaissance. Let's add some color! Illustrator has lots of options when it comesto
coloring objects. Besides solid colors, Illustrator can fill objects with gradients and patterns--all
customizable. Illustrator also has support for custom colors such as Pantone, TRUMATCH, and
even web-specific colors (for use on the World Wide Web). Throughout this chapter we discuss
each of thesein detail, including:

* The Color palette

* The Swatches palette
* The Eyedropper tool
* The Paint Bucket tool
* Fill and Stroke

In lllustrator, each object has two attributes: afill and a stroke. And as we'll soon see, Illustrator
has several kinds of fills and strokes. Y ou can give afill and a stroke to just about any object
(with the exception of amask), even one that is an open path.

Illustrator fills an open path by using the two open points as a boundary.

At the bottom of the Toolbox are the Fill and Stroke indicators. |5 4] ™
These are very similar to Photoshop's Foreground and Background col or H
indicators. The box to the upper left isthe Fill indicator, and the one to

the lower right is the Stroke indicator. Y ou can click either one to make Oy

it active, or you can press X to toggle between them. ———




When the Fill box is selected, any changes you make in the Color palette are applied to the fill of
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a selected object, and the same is true for the Stroke.

There are two more icons there: One with little arrows to the upper right, and one with little
boxes to the lower right. Clicking the arrows swaps the fill and stroke, meaning if thefill is
currently white and the stroke is black, clicking the arrow makes the fill black and the stroke
white. Clicking the little boxes sets the fill and stroke to Illustrator's default setting (as does
pressing D), which isawhite fill and black stroke. Note that this does not affect the weight

(thickness) of the stroke.

NOTE: When changing the color of the fill or stroke, any object that is selected while you make
the change will take on the new color attributes. If no object is selected, the next object you
create will take on the new color attributes you just set.

The Color Palette

[llustrator's Color palette consists of a
single large swatch, a color slider (or
sliders) with percentage boxes, and a color
bar, which, depending on what colors are
selected, is either a color spectrum or a
grayscale/tint ramp.

= ]

| {ulnr-"”-\ | 4

CF%
qu%
TFH
H*%

If al you seeisthe =
color bar, select | Color ™,
Show Options from | : | |

RGB

HSB

« CMYK

[llustrator works with any of four different = i
color models: CMYK, grayscale, RGB, | Color ™ | b
and HSB. To quickly cycle through each R oo
of the color models, hold down the Shift =
key, and click the big swatch in the Color G
palette. 3
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Selecting a Color

To select acolor, either click anywhere in the color spectrum or tint ramp, or adjust the sliders
manually by clicking on the little triangles and dragging them to the left and right. Y ou can also
enter percentages manually by clicking in the field, entering a number, and pressing the Tab key
to advance to the next field, or Shift-Tab to go back to the previousfield.

TIP: After you put the "focus' into the color palette, you can quickly move through all the fields
by pressing the Tab key. If you have other palettes docked to it as well, such as the Gradient or
Stroke palette, you can cycle through those fields aswell. To put Illustrator's focus into the last
used palette, press (Command-~).

TIP: Illustrator's ider bars are very intuitive and change color as you drag to approximate other
colors. You can also hold down the Shift key while dragging any one slider and all sliders move
proportionately, making it easy to get lighter or darker shades of process colors.

COLOR MODELS

| mentioned that Illustrator supports four different color models. Illustrator also enables you to
have colors from different color models within the same document (see the following NOTE).
It's important to keep thisin mind as you work on each project. Some jobs may require that you
work in CMYK, othersin RGB, and so on. In order to assure that your finished artwork looks as
you intended it to be, make sure you are using the right color model from the beginning.
Switching between color models after ajob isin progress or finished may result in color shifts
and changes.

NOTE: Although Illustrator |ets you have a document containing colors from different color
models, that doesn't mean you should do it. In fact, it can be very bad. If you are working on a
job that will be printed, use only the CMYK or Grayscale color model. If you are doing
multimediawork, use RGB or HSB. Using different color models within the same document can
make for non-consistent color shifts and can become a production nightmare.

CMYK

The CMYK color model (cyan, magenta, yellow, and black) is the standard for most of today's
offset printing and is also known as four-color process. If your color artwork will be printed on
paper, you're most probably going to createitin CMYK. To select aCMYK color from the
Color palette, either Shift-click to cycle through the color models until CMY K shows up, or
choose CMYK from the palette menu (see Figure 9.6).

Grayscale

For black and white work, use grayscale, which supports 256 levels of gray. Y ou have the ability
to create different percentages of black. In this mode, the Color palette has a grayscale ramp to
choose different percentages (see Figure 9.7).
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Figure 9.6 Figure 9.7
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The RGB color model (red, green, and blue) is the standard used for today's tel evisions and
computer monitors. If you are designing work for multimedia applications or for the World Wide
Web, use the RGB color palette. RGB colors have a much wider range, or gamut, and have more
colors that are brighter than CMY K. For more information on web colors, see Hour 23, "Web
Graphics."

HSB

The HSB color model (hue, saturation, and brightness) is not as widely used and is based upon
the human perception of color. The hue value determines which color you get, while saturation
determines how intense that color is, and brightness determines how light or dark it is. In most
cases, though, if you are using HSB colors, you will eventually have to convert them to RGB or
CMYK for output.

Custom Colors

Though not a color model, there is another kind of color supported within Illustrator: custom
colors. A custom color is a predefined color that you can either create or choose from alist such
as Pantone, Focoltone, TOY O, or TRUMATCH. Custom colors are also called spot colors.
These are standard colors that have been designated to assure color accuracy.

The Pantone system, for example, was created so that when a designer wanted to print red, he
could specify a Pantone number, which a printer could match exactly by using ared ink, instead
of producing the color with a combination of cyan, magenta, yellow, and black inks. Custom
colors act the same way as grayscale does. Y ou can specify atint of a custom color, and the
Color palette looks identical.

L oading Custom Color Palettes

Included with Illustrator are several useful custom color libraries. These include DICCOLOR,
FOCOLTONE, PANTONE (coated, process, and uncoated), TOY O, and TRUMATCH, plus
system palettes for both Macintosh and Windows for multimediawork. Illustrator aso hasa
wonderful color-safe web palette for use when creating art for the World Wide Web.
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To load any of m
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THE SWATCHESPALETTE

Imagine if every time you wanted to apply a color, you had to enter the percentages of that color
in the Color palette. Besides being a pain, it would also be abig waste of time. That's where the
Swatches palette comes in. A swatch isa color that you define. It can be a process color, a spot
color, or even agradient or pattern, aswe'll soon see. After you define a swatch, you can apply it
to any object. You can aso edit and modify an existing swatch.

Let'stake alook at the Swatches palette. If the palette is not already open, press F5 to open it, or
choose Show Swatches from the Window menu.



First, notice the little "chicklet" icons
across the bottom of the palette. From the
left, the first one is Show All Swatches.
The next three are for Color, Gradient, and
Pattern swatches, respectively.

]

Swatches
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At first glance, the palette may ook too
cluttered. By clicking the color, gradient, or
pattern icons, you can choose to view only
those swatches, making it easier to choose a
swatch.

1 El

| [ OJ@EIBE[[E[T =

Next are the New Swatch and Trash icons. Clicking the New Swatch icon creates a new swatch
with whatever color is currently selected. (Selected swatches have awhite border.) Clicking the
Trash icon deletes any selected swatch. To select a swatch, simply click it.

Y ou can select several contiguous
swatches by holding down the Shift key,
or you can select non-contiguous swatches
by holding the (Command) key when

sel ecting the swatches.

1]
Swatches

L] [

.H.H@ddd

N
N

TIP: Hlustrator has drag-and-drop capabilities. Y ou can delete swatches by dragging them into
the Trash icon, and you can also create a duplicate swatch by dragging an existing swatch on top
of the New Swatch icon. Y ou can drag colors between the Fill and Stroke indicators, the Color
palette, and even between custom color and Swatches pal ettes!

Double-clicking a swatch brings up the Swatch Options dialog box. Y ou can then edit the name
of the swatch, as well as determine whether it should be a spot or process color.

Swatch Options

swatch Name: [{TTRITEITI

Color Hude:[ Spot Color

v

Cancel
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If you want to change the values of an existing swatch, follow these steps:

1. Select the swatch you want to modify.

2. Inthe Color palette, edit the color.

3. When you're done editing the color, click and drag the color swatch.

4. While still pressing the mouse, hold down the (Option) key, and drag the color swatch (either
the one in the Colors palette or the one in the Toolbox) on top of the swatch you want to edit in
the Swatches palette.

Y ou'll notice that some swatches have a small dot in the lower-right corner. The dot indicates

that the swatch is a spot color. You can also change the order of the swatches simply by dragging
and moving them around.

Viewing the Swatches Palette

Y ou aso have three ways to view the Swatches palette: Small Swatch, Large Swatch, or Name.

o [ B ]
| Swratchies ™

3 i
i

rr,k"n . ..]—I-.'-:”ﬂ | | |D'ﬂ"'ﬂill i =
liamacanaacl . . | A

o O O

To choose a viewing mode, select a choice from the pal ette menu. When you view swatches by
name, an icon on the far right of the swatch name indicates whether the swatch is spot or process.

You can aso T N i s o s i e e O 1

select the Swatches p| MNew Swatch...
funct_ionswe'V(_a 41 Duplicate Swatch
mentioned earlier, IS UM D1 AD) @) | Delete Swatch
such as Duplicate 1 &

SNatCh and ey 1. .

Delete Swatch, — - Name

aswell as sort ; ' : M Small Swatch

the swatches | O @8 | & | % [E Large Swatch

by kind or name.

Cinatrh NMntinne
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TIP: Although there is no swatch in the Swatches palette for the None attribute, remember that
there is akeyboard shortcut for it. To quickly fill an object or stroke it with None, press the slash
(/) key. Whether thefill or stroke of the selected object is changed to None depends on the focus
of the Fill and Stroke icons on the Tool box.

TIP: After you put the focus into the Swatches pal ette (Command-~), you can type the first few
letters of a color, or the numbers of a Pantone color, and Illustrator jumps to that swatch. Press
Enter to bring the focus back into your artwork.

The Eyedropper Tool ¢ LA
The Eyedropper tool is used to sample colors for use in applying & f

those colors and attributes to other objects. | fmi'l ':l |

Say you have a shape with one color, for example, and you want it to be the color of another
shape. Without deselecting your shape, you can switch to the Eyedropper tool and click the other
object. This colors your selected object to be the same as the one you double-clicked on.

Y ou can aso press and hold down the mouse while using the Eyedropper tool, and then drag
anywhere to sample the pixel color of anything on your screen (in real time, | might add--it's
cool to watch the colors zip through the Fill indicator).

To control exactly which attributes the Eyedropper (and Paint Bucket) picks up, double-click the
Eyedropper tool in the Toolbox. Illustrator presents you with a comprehensive dialog box where
you can specify settings for picking up strokes and fills.

Paintbucket/Eyedropper

Paintbucket Hpplies: Eyedropper Picks Up:

Fill Fill

Color Color

Overprint Overprint
Stroke Stroke

Color Color

Overprint Overprint

Weight Weight

Cap Cap

[x] Join Join

Miter Limit Miter Limit

Dash Pattern Dash Pattern
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The Paint Bucket Tool

Working in tandem with the Eyedropper tool, the Paint Bucket tool < | L4
applies colors to unselected objects. You just click an object and @3 f
[lustrator fills that object with whatever color is selected.

If you press the (Option) key with the Paint Bucket tool selected,
it toggles to the Eyedropper tool and vice versa. This makesit simple to quickly sample a color
and apply it to other objects.

SUMMARY

What a colorful hour! We learned al about the different kinds of colors Illustrator uses, and we
learned how to create and edit swatches of colors. We also learned about two new palettes: the
Swatches palette and the Color palette. Next hour, we learn what we can do with all of these
wonderful colors.

Term Review

* Color model -- A specific defined color space such as CMYK, RGB, or HSB.

* Custom color -- A color defined in Illustrator that separates to its own plate. See Spot color.

* Spot color -- A specified color that isindependent of any other colorsin ajob, and separates to
its own plate.

* Swatch -- lllustrator's metaphor for a defined color, pattern, or gradient.
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FILLS

Aswe mentioned before, avector object in Illustrator has two attributes: A fill and astroke. This
chapter focuses on the fill attribute. Remember how, when you were little, you used to use
crayons on coloring books, and you were so careful not to "go out of the lines?' Well, that's what
afill in lllustrator is--coloring an object, up until the boundary of the path. The good thing about
[llustrator isthat it never draws out of the lines--it's perfect every time--and you don't have to
worry about sharpening the crayon. In this hour we discuss:

* Applying afill to an object
* Gradient fills

* Pattern fills

* The Expand command

Solid Color Fills

A solid color fill israther ssmple. Using the same crayon example as earlier, asolid color fill is
akin to using one particular crayon for the interior of the object. In the last hour we learned how
to define new colorsin Illustrator, as well as how to apply them to objects.

There are two other kinds of fillsin Illustrator: gradients and patterns. Here we discuss how to
define and apply these kinds of fills.

GRADIENTS

Gradients are a powerful feature in Illustrator, enabling you to specify afill of different colors
blending with each other. Illustrator can create a gradient between just two colors or up to 32
colors. Gradients can be used to achieve cool shading effects, to add dimension to objects, and
are also agreat design element.




HOUR 10

The Gradient Palette

Y ou can apply agradient by simply = i E]
selecting a gradient swatch from the [ Gradient ™ |y
Swatches palette. To create or edit a

gradient, however, you need to open Ijl Type:

the Gradient palette (F9). There you : 3 e
will find a gradient swatch, an option G El R |:| =
to make the gradient Linear or Radial,

fieldsfor Angle and Location, and a | H
gradient slider. O |

Defining a Gradient

Y ou create a gradient much the same way you create a color. First, we define the gradient, and
then we click the New Swatch icon in the Swatches palette. After you create the new swatch, it's
important to double-click it and give it aname. Illustrator will just call it "Unnamed gradient,”
and after you have 15 unnamed gradients in your Swatches palette, you just might forget which
oneiswhich.

Notice that underneath the gradient slider are icons that look like little houses. These are color
stops indicating the point at which a color is used in the gradient. To create a new color stop,
click anywhere underneath the gradient slider. A new house appears that you can drag to the | eft
or right. You can also drag any color from the Swatches or Color palettes onto the gradient slider
to create a color stop in that color. To change an existing color stop, either drag a new color
directly on top of it, or click the icon to select it, and change the color in the Color palette.

Also notice that there are little = : ]
diamond-shaped icons on top of the | Gradient ™ | 4
gradient dlider. These indicate the

location of the midpoint of the m TYPE:
gradation. In other words, angle:[1784 |° Location:[25.45 ] %

wherever the diamond is,

that's where there is 50%
of each color. m
E

Let's define a gradient:

1. Open the Gradient palette (F9), the Color palette (F6), and the Swatches palette (F5).

2. In the Gradient palette, click the gradient swatch (it's the large square in the upper left of the
palette). Notice that the gradient slider below becomes active, and the color stops and midpoint
indicators become visible.
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3. Click acolor stop. Thereis now a color stop visible underneath the color swatch in the Color
palette.

4. Using the dliders in the Color palette, or using the spectrum at the bottom of the Color palette,
select a color for the selected color stop. Alternatively, you can drag a color from the Swatches
pal ette directly onto the color stop in the Gradient palette.

5. Let's create anew color stop. Click anywhere directly underneath the gradient slider in the
Gradient palette. Notice that another color stop appears. Apply acolor to it the same way asin
Step 4. Alternatively, you can drag a color from the Swatches palette directly onto the gradient
dlider. When you let go of the mouse, a color stop of the color you dragged appears.

6. Now let's delete a color stop. Y ou need at least three color stopsin order to delete one (a
minimum of two color stopsis required). Click and drag downwards on the color stop you want
to delete. When the color stop disappears, rel ease the mouse.

7. Now make your final adjustments by moving the color stops and the midpoint indicators.

8. Now that your gradient is complete, click the mouse on the gradient swatch and drag it into the
Swatches palette, where it appears highlighted with a white outline.

9. Double-click the new swatch and give it an appropriate name. Click OK.

Editing a Gradient

To edit an existing gradient, modify the gradient in the Gradient palette, and then drag the
gradient swatch on top of the swatch you want to update while holding down the (Option) key.

The angle of the gradient can be changed in the Angle field in the Gradient palette. The angle
does not affect the object in any way; it only affects the gradient that fills the object.

Using the Gradient Tool

The Gradient tool is used to control the direction and placement of a =i, |l
gradient in an object or over several objects. After an object isfilled
with agradient, select the Gradient tool (G), and with the object still
selected, click and drag across the object in the direction you wish
the gradient to go. Where you begin dragging is where the gradient
starts, and where you let go is where the gradient ends. If you stopped dragging before the end
of the object, Illustrator continues to fill the object with the color at the end of the gradient.
Thistool is perfect for specifying where the center of aradia blend should be when making
3D spheres.
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PATTERNS

Patterns can be real time savers. A pattern is a defined
piece of art created in Illustrator that, as afill attribute,
is repeated over and over again, much like wallpaper.

Defining a Pattern

Defining a pattern is alittle different from

defining gradients or colors. Instead of clicking

the New Swatch icon, we drag our artwork directly
into the Swatches palette to define the pattern. Again,
after you create the swatch, give it a unique name so
that you can find and edit it quickly.
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When creating a pattern design, remember that your art will be repeated over and over again, so
be careful how you set it up. If you need extra space around your art, create a box with afill and
stroke of none, and send it to the back of your artwork. Then, select your art along with the
background box and define the pattern. Illustrator treats that empty box as the boundary for the
pattern.

TIP: A pattern tile cannot contain another pattern or a gradient. If you want to have a gradient
effect or use a pattern within your pattern, use the Expand command to convert the gradient or
pattern into individual filled objects. The Expand command is covered later in this hour.

To edit a pattern, drag the new artwork on top of the swatch you want to change while pressing
the (Option) key. Also, if you lose the artwork for your pattern, don't worry. If you drag a pattern
swatch out of the Swatches palette and onto the page, it automatically becomes the art for the
pattern.

To move the pattern around within the object, select the object with the Selection tool, and then
click and drag the object while holding down the tilde (~) key. When you let go, only the pattern
is repositioned; the object does not move.

Using the Expand Command

Gradients, as we now know them, first appeared in lllustrator 5 for the Mac. In versions prior to
that, you were able to achieve a gradated look by blending objects into each other. Basically, the
Blend tool created many objects, or steps, each with a color dlightly different than the next. This
gave the appearance of a gradation. Of course, gradients are more intuitive and are easier to edit,
but if you need to bring your artwork, which was created in version 7 with gradations, into
version 3.2, you will lose the gradient information, asit is not supported in version 3.2.
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In these circumstances, as well as others, you need to convert an object filled with a gradient into
actual art or blended steps. To make this conversion, select the filled object and choose Expand
Fill from the Object menu. When expanding the gradient, you can specify how many steps
[llustrator breaksit into.

Y ou can also expand an object filled with a pattern. By doing so, the fill that until now has been

uneditable turnsinto actual art and ceases being a patterned fill. The shape also becomes a mask
that blocks out parts of the pattern tiles that should not be visible.

i ore
ey
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SUMMARY

Areyou al filled up? This hour we learned how to fill our shapes with not only flat solid colors
but with interesting multicolor gradients and patterns as well. We also learned how to use the
Expand feature to convert our gradients and patterns into editable art objects. Next hour we
discuss the Stroke attribute.

Term Review

* Gradient -- Term used to describe afill that contains two or more colors that blend into each
other.

* Color stop -- The point in a gradient where a new color is introduced.

* Steps -- Individual parts of a blend. Each step isadlightly different color giving the illusion of
a smooth transition.
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STROKES

A stroke isthe line around an object. Y ou can give an object's stroke a different color than itsfill.
Y ou also have severa options when it comes to strokes, which actually makes for some very
interesting and useful implementations, which we cover later in this hour. Throughout this hour,

we will learn about:

* The Stroke palette

* Stroke weights, miters, and caps
* Dashed lines

* Layered strokes

The Stroke Palette

The Stroke palette (F10) can be set to either
show only the stroke weight or all of the
stroke attributes including Miter Limit,
Line Caps and Joins, and Dashed Lines.

Y ou can choose either setting by selecting
Show Options from the pal ette menu.

Weight and Miter Limit

]

]

Stroke ™, | b
Weight:lzl‘ 2 pt |*r| Cap:| £ i=|[=
miter Limit:[2{4  |x  oin: [[] [

Dazhed Line

|05 pt|[20 pt]|

dazsh  gap

dazh gap  dash

gap

The most used option in the Stroke palette is the stroke weight. Thisis what determines how
thick or thin the stroke is. Illustrator's default is 1 point. For hairline rules, most people use .25
point. Y ou can enter any amount from O to 1000 points, and you can even enter numbersin
different measurements (such as 2.5 in.) and Illustrator converts it to points for you.

CAUTION: In Illustrator, if you enter aweight of zero points, it prints the stroke as a PostScript
Hairline, which is defined as the smallest line width possible on your printing device. This means
if you are printing to a 300 dpi laser printer, your "0" point stroke prints at 1/300 of an inch. Print
that same "0" point stroke on a high-end 3386 dpi imagesetter and you get a stroke of 1/3386 of
an inch, which is barely discernible, even using a10 x loupe. My adviceisto avoid using "0"
point, and when you want a hairline, use .25 point. Y ou'll be happy you did.

The Miter Limit determines how far the stroke sticks out on a sharp point. A thick line, for
example, needs more room to complete a sharp point than a thin one does (see Figure 11.2).

(Shown from left to right: a 2 point stroke with a miter limit of 2, a 20 point stroke with a miter
limit of 2, and a 20 point stroke with a miter limit of 4.)
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Figure 11.2

Line Capsand Joins

Line caps determine the ends of a stroked path. This setting is only used for open-ended paths.
By choosing different caps, you can make the ends either flat, rounded, or have the stroke width
enclose the end of the path as well. (Notice how the bottom two actually protrude one-half the
stroke weight from the actual anchor point.)

BUTT CAP

LINE CAF

PROJECTING CAP

Linejoins control how the stroke appears at each anchor point on the path. Y ou can choose
Mitered, Round, or Beveled joins (see Figure 11.4).

(Shown left to right: a star with mitered, round, and beveled joins.)
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Figure11.4

Dashed Lines

The last option in the Stroke pal ette can be one of the most powerful. Here you can specify
dashed or dotted lines. Depending on what settings you have set for weight, line caps, and joins,
you can create a stitched line, a skip line, or almost anything. Y ou control the dash and gap (the
space between each dash) by entering numbers into the Dash and Gap fields at the bottom of the
palette. If you're just using one sequence, you can enter just the first two fields. Or you can enter
up to three different Dash and Gap settings to achieve complex dash patterns. (The last stroke
uses round caps to achieve the dotted line effect.)

(1,6.8 1) D omm mm mme ommr e mmr omm omm mm w
(2, 10, 10, 10) : mmm 5 s 5 Emm s emm ow
(2, 8,8) : EmEE  SEEE s EEE. s -
(12, 2) s e s i i
(4,2, 4, 20) -m - -m - -

{1, 6 — Round Cap) - 5 8 @B 8 5 B B S 8 B S S S B BSOS

CREATING SPECIAL EFFECTSWITH LAYERED STROKES

Using strokes with different settings, and layering them on top of each other, you can achieve
some interesting results. How interesting, you ask? Well, how about railroad tracks? or maybe a
nice highway? With some imagination and forethought, you can apply the power of strokesto
more and more functions. The possibilities are endless!
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Everybody's Doing the L ocomotion

1. With the Freehand tool, draw anice curvy line with afill of None and a stroke of black.

2. Giveit astroke weight of 20 points, and a miter limit of 4.

3. Press (Command-C) to copy the path, and then press (Command- F) to paste the path directly
in front of the existing path. (Y ou won't see a change onscreen, but it's there.)

4. Givethis path afill of None and a stroke of white.

5. Change the stroke weight to 14 points. Y ou should now see a double line. Because the white
line is narrower, you see 3 points of the bottom line on either side (20 minus 14).
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(Inreality, what you're seeing is a white line blocking out the middle of athicker black stroke.)
6. Again, press (Command-C) and then (Command-F) to create another copy of the path.
7. Give the path afill of None, and a stroke of black.

8. Change the weight to 26 points, and give the stroke a dash of 2 points and a gap of 10 points.

Look at that! We created train tracks from just three paths. Even more amazing, switch to
artwork mode (Command-Y) and what do you see? Only one thin line.

Lifein thelllustrator Fast Lane

Think that's cool? Well, my good friend Ted Alspach of Illustrator fame put together something
even cooler: an eight lane freeway, made up entirely of strokes.

1. Draw a path with the Pen tool that looks like the one shown. Y ou can make your path longer if
you'd like; I've created a path that's fairly short so it looks good in the sample figures.

2. Change the paint style (Fill=none; Stroke=300 pt., C=100, M=10, Y=90, K=18). This path is
the grass border of the highway.

3. Copy (Command-C) and Paste in Front (Command-F). Change the paint style (Stroke=240 pt.,
K=80). Thisisthe dark asphalt edge of the highway.

4. Paste in Front (Command-F). Change the paint style (Stroke=165 pt., white). Thisisthe white
line along the outside edge of the highway.

5. Paste in Front (Command-F). Change the paint style (Stroke=160 pt., K=40). This path isthe
main road.
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6. Paste in Front (Command-F). Change the paint style (Stroke=85 pt., white, dash=12, gap=20).
Though it doesn't look like it right now, these are the dashed lines.

7. Paste in Front (Command-F). Change the paint style (Stroke=80 pt., K=40). Thisisthe
passing lane.

8. Paste in Front (Command-F). Change the paint style (Stroke=8 pt., M=10, Y=100). Thisisthe
double yellow line.

9. Paste in Front (Command-F). Change the paint style (Stroke=3 pt., K=40). This path is used to
separate the double yellow lines.

OFFSET PATH AND OUTLINE PATH

For outlining and special effects, Offset Path is agreat function. Offset Path creates an object
that perfectly outlines, or traces, a selected path at an offset that you specify. To useit, select one
or more objects and choose Path > Offset Path from the Object menu, and the Offset Path dialog
box appears.

Offset Path

Offset: |10 pt
Joins: | Miter |

Miter Limit: |4 pt

Enter an amount to offset (you can use positive or negative numbers), and click OK. Note that
Offset Path always makes a copy of your selection, and does not affect the original (see Figure
11.112).

TIP: Y ou may notice that the Offset Path command may produce what looks like extralinesin
each object (refer to Figure 11.11). To "clean up" these lines choose ObjectPathfinderUnite. It's
best to run this function right after you use Offset Path because your selection is still active.
(More on the Unite and Pathfinder commands in Hour 13, "The Pathfinder Commands.")

Outline Path is another great feature that converts strokes into filled objects (see Figure 11.12).
Found in the same location as the Offset Path command, the Outline Path works by taking the
stroke width and creating afilled shape the size of the width (see Figure 11.13). Thiscan be a
real timesaver in a production environment, as well as enable workarounds such asfilling an
outlined stroke with a gradient (a gradient cannot be applied to a stroke).
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Figure11.11
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Figure 11.12
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On the left, a stroked path. On the right, the path converted to an outline.
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Figure 11.13
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With the same images viewed in Artwork mode, you can see how the stroke has been outlined.

Unfortunately, Outline Path does not use dash information when converting a path to an outline.
When used, the path (actually the object) becomes solid.

SUMMARY

Before things even got started, we learned that strokes are a good thing (at least in lllustrator they
are). We learned all about stroke weight, and how different joins and caps can make a stroke
appear very different. After we covered dashed patterns, we even made an entire illustration out
of nothing but strokes!

Term Review

* Stroke weight -- The thickness of aline (path).

* Miter -- The extrusion of the stroke weight at a sharp change in direction.

* Cap -- The stroke attribute used at the endpoints of a stroke.

* Dash -- The part of astrokethat isvisible.

* Gap -- The part of a stroke that is transparent.

* Stitched Line -- A steady dashed line, giving the appearance of a sewn stitch.
* Skip Line -- A dashed line in which the dash and gap are not consistent.
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TRANSFORMATIONS

One of the biggest advantages computers give us in terms of creating art is the ability to edit or
transform art. | remember when | used to draw squares for alayout, and send out for severd
copies of them to save time when doing layout. Now | can create numerous duplicates of art in
nanoseconds. By scaling, rotating, and reflecting existing art, we not only cut production timesin
half, but we create better, more accurate art as well. In this hour we discuss:

* Moving

* Scaling

* Rotating
* Reflecting
* Shearing

By drawing only half

of the image, and then
reflecting a copy of it, you
can create a symmetrical
imagein half the time.

The Transformation Tools

[lustrator has five transformation functions: Move, Rotate, Scale, Reflect, and Shear. Illustrator
7 aso has anew feature called Transform Each that enables you to apply several different
transformations to several different objects--all in one step. There's also the Transform palette,
which makes for quick and precise transformations.

Before we begin, | want to point out one particular keyboard shortcut that isareal time-saver--
especially when it comes to transformations. Pressing the (Command) key at any time activates
the most recent selection tool you've used. If, for example, you last used the black arrow,
pressing the (Command) key while using any of Illustrator's other tools temporarily activates the
black arrow.

When it comes to transformations, you are always selecting objects and making minor changes
to the art, and it's a pain to have to switch back and forth between the transformation tools and
the selection tools. With the (Command) key, the selection tool is always just a keystroke away.
By the way, pressing (Command-Tab) toggles between the black and white arrow.

MOVING OBJECTS

Although not necessarily atransformation in that the actual object is changed, moving an image
is considered a transformation because the coordinates of the object are being changed.



To demonstrate, press F8 to open the Info =

| -Ilnfn\;\

palette. Now, select the Rectangle tool
(press R) and move your mouse around
the screen. There are four fieldsin the
Info palette: X, Y, W, and H. Notice the
X and Y numbers are changing as you

move the mouse.
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These are the coordinates of your cursor and they represent the starting point of your rectangle
(either the center point or the upper-left point, depending on which rectangle tool you are using).
After you begin drawing the rectangle, the other W and H (width and height) coordinates become

active, giving you rea-time feedback as to the size of your object.

We aready learned one way to move an object; by clicking and dragging on a selection.
[llustrator also lets you move things more precisely. If you click and drag a selection, and then
hold down the Shift key, you are only able to drag your selection in increments of 45 degrees.

Want to get even more precise? After you make your selection, you can use your keyboard's
arrows (up, down, left and right) to "nudge" your selection, one increment at atime. Y ou can
control how much each nudge is in the Keyboard Shortcuts section in Preferences.

Preferences

Keyboard Increments

v

Options

Size/Leading:
Baseline Shift:
Tracking:

Greeking Type Limit:

Cursor Key:

2 pt

2 pt

20

1000 em

b pt

Anti-alias Type

[x]Ty

pe Area Select

Cancel

Pren
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But you say you need even more precision? After al, we are dealing with a computer, right?

To move aselection ———— Moue
numerically, make your
selection and then double- Position

click the Selection tool in :
the Toolbox (the black Horizontal:|3.436 pt

arrow). Y ou are presented Vertical:[6.342 pt

with adialog box where
you can specify an exact
amount to three decimal : !
places. The dialog box Distance:|?.223 pt
also letsyou create a Angle:[61.413 e
copy, and even sports a
Preview button that =
enables you to view Options

the results of the move Objects [|Patterns Preview
before clicking OK.

Copy

There's yet another way to move something: Illustrator's new Transform pal ette, which we get to
soon.

ROTATE, SCALE, REFLECT, AND SHEAR

The remaining four transformation tools, Rotate, Scale, Reflect, and Shear, are all very similar.
Asyou should know by now, before making any transformations, you must first make a
selection. Otherwise, Illustrator has no ideawhat it is you want to transform. A rectangle works
best for demonstration purposes.

Rotate

When you select the Rotate tool (R), notice that a different symbol has appeared at the center of
your selection. Thisisyour origin point.

With the Rotate tool, your origin point e S

is the rotation point, which means your | —
selection revolves around that point. i
To rotate the object, smply click and '
drag. Clicking the outer portion of a <
selection makesiit easier to control the
transformation. Holding the Shift key i
while dragging constrains your rotation . -
to increments of 45 degrees. /
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Y ou can move the origin point to better control your transformations by clicking and dragging it.
Go ahead, try it! Drag the origin point to the lower-left corner of the rectangle. Notice that the
origin point takes advantage of Snap to Point, which makes aligning images a lot easier to do.
Now click and drag from the opposite side of the rectangle, and notice how the object now

rotates from the lower-left corner.

&
|

II

II

Besides being able to freely rotate a selection, you can also precisely rotate an object
numerically. To do so, double-click the Rotate tool. This brings up the Rotate dialog box. After
specifying arotation angle, you can choose OK to rotate your selection, or you can choose Copy,
which rotates a duplicate of your selection, and leave the original selection untouched.

Rotate =—8F——— _."a""H-.,_,_“
7 T
Angle: |75 ® { T
Options i!'r _,-':

Objects [ ] Patterns . /
Preview e /
e /

~ :

T

Double-clicking the Rotate tool always rotates the selection numerically from the center, but
what if you want to rotate a selection numerically from a different origin point? After you have
the Rotate tool selected, hold down the (Option) key and click where you want the origin point to
be. The Rotate dialog box appears, and the origin point is where you clicked.

TIP: When using the Rotate dialog box, if the object you are rotating is filled with a pattern, you
have the option to rotate the object without rotating the pattern, to rotate the pattern and the
object simultaneoudly, or to rotate just the pattern (see Figure 12.10). Without using the dialog
box, you can rotate just the pattern fill if you press and hold the tilde key (~) while dragging to
rotate. The tilde key shortcut works with any of the transformation tools, including Move.

(Shown from left to right: the original object, the object rotated without the fill, the object and
thefill rotated together, and the fill rotated without the object.)
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Ay Probably the most frequently used transformation tool, the Scale tool (S) is used
—= to resize selected objects, making them larger or smaller. Just like the Rotate tool,
i |7 the Scale tool also uses an origin point to determine which point to scale from.

Figure 12.10

.

7

Scale

To use the Scale tool, drag inward toward the origin point to reduce the object in size. Drag
outward from the origin point to enlarge the object. Y ou can move the origin point by pressing
and dragging it or just clicking to create a new origin point. If you hold down the Shift key as
you drag, the object scales proportionaly.

To scaleitems from the center, numerically, double- —_— Sraln

click the Scale tool to bring up the Scale dialog box. (Eniiarm =) . :
Although Scale line weight appears in General ' sale: [ 5
Preferences (see Hour 2), it appears here again, in Clfeiinsica
case you want to make an exception. To scale a ' -
selection from a specified origin point, select the “":::"f_ e [ Eeps J
Scale tool and (Option-click) where you want the i sl

origin point to be.

O —0

The box on the left has been reduced with Scale line weight off. The box on the right has Scale
line weight turned on. It appears to be an optical illusion, but the stroke has remained the same in
the first example and been scaled proportionally in the second.
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| The Reflect tool (O) is aso known as the mirror tool. Working in the same way
—- as the Rotate and Scale tools, the Reflect toal flips a selection horizontally or
pid]| L7 vertically. Thistool ismost useful for creating symmetrical artwork.

After creating
half of your
art, simply flip
acopy of it to
complete the
image.

Aswith the other Reflect

transformation tools, AxHis

holding the Shift key () Horizontal

constrains movement

to 45 degree increments, @ Uertical Cancel
A ——

and double-clicking the
Reflect tool or (Option-
clicking) in the document Options

brings up the Reflect Objects []Patterns

dialog box. [ ] Preview
Shear
| The last of the transformation tools, the Shear tool (W) is used to skew
— objects. Again, this transformation tool is like the others when it comes to
pid |22 specifying an origin point, and using the Shift key.

Of course, double-clicking the Shear tool brings up the Shear dialog box, and (Option-clicking)
in your document defines an origin point and enables you to specify a shear numerically.

Notice that
by shearing
acopy of the
star, you can
create a cast
shadow.
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TRANSFORM EACH

The Transform Each function offers two excellent features. the ability to perform Scale, Move,
and Rotate transformations simultaneously; and the ability to transform each object in a selection
independently of each other. Let's take a closer |ook.

First, multiple transformations are a snap with Transform Each. Choose Transform > Transform
Each in the Object menu to bring up the Transform Each dialog box. Here you can specify
measurements for Scaling, Moving, and Rotating your selection. A Preview button enables you
to view your transformation in real-time. We'll see in a minute how this feature is more powerful
than you think.

Transform Each
S5cale
Horizontal: 100 kA
o
Uertical: 100 e -
e,
Move
Horizontal: 0 pt
= ] Random
Vertical: 0 pt
= [ ]| Preview
Rotate
Angle: |0 = G

The second feature we mentioned was the ability to transform multiple objectsindividually. To
demonstrate, I've created agrid of squares (see Figure 12.20). If | select al of the squares, and
use the Rotate tool to rotate my selection 45 degrees, my entire selection rotates as one piece (see
Figure 12.21). If | use the Transform Each command with the same selection and specify a 45-
degree rotation, however, each square rotates individually (see Figure 12.22).

The Random button in the Transform Each dialog box transforms each object alittle differently,
making for an irregular, amost hand-drawn look (see Figure 12.23).
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Makin' Copies!

Asyou've seenin al of the transformation dialog boxes, there is a button to make the
transformation on a copy of the object. Holding the (Option) button as you drag with any
transformation tool does the same thing. If you want to rotate a copy of a selection, just hold
down the (Option) key as you drag to rotate. Even when dragging items with the black or white
arrows, holding the (Option) key creates a duplicate. Be sure to rel ease the mouse button before
you let go of the (Option) key.

Dolt Again!

Without a doubt, the most powerful transform function in Illustrator is Transform Again. The
keystroke combination for it is (Command-D). Learn it. Transform Again applies the last
transform that you've done, which is why Sandee Cohen, of vector fame, likesto call the
function "Do It Again," which also makes it easier to remember (Command-D). Let'sdo afew
simple exercises:

1. Draw arectangle.

2. Using the black arrow, move the square a bit.

3. Press (Command-D). Notice how Illustrator applied the same move command to the square
again.

4. Now rotate the square 20 degrees (see Figure 12.27).

5. Press (Command-D) again. And again. The square rotates another 20 degrees each time (see
Figure 12.28). Getting dizzy?

6. Select the black arrow again.

7. Now create a duplicate of the square by clicking and dragging it while holding the (Option)
key (see Figure 12.29).

8. Press (Command-D) several times. You just performed a step-and-repeat, creating several
squares, each equally distant from the other (see Figure 12.30).

| L |
"____.--"' "'.. f’

"1__
“m
- /
£

\ ﬁxgv g’f
Figure 12.27 o Figure 12.28 N Figure 12.29 L3
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Figure 12.30

Now let's go back to the Transform Each function. Remember, using Transform Each, we can
apply several transformations in one step. Using the Transform Again function in conjunction
with Transform Each gives us a powerful means to apply multiple transformations again and
again--quickly.

The Transform Palette ] - ]
| Transfnrm’"\,‘
Y ou knew it was coming, didn't you? - |.:, in | Wi |.:, in |
That's right, another Illustrator palette. §E§
The Transform palette lets you quickly v [Qin | H:|oin |
specify transformations. First, notice
the funny-looking icon on the far left. £:|o° | & | |
atain Thisisaproxy that determines where the origin point is. Although you can't
H precisely position the origin point as you could with atransform tool, clicking
the little squares lets you quickly specify center, upper-left corner, and so on.

Y ou can move objects around in your document by entering the X and Y coordinates. To change
the width and height of your selected objects, enter new valuesin the W and H fields. But what if
you only know one dimension and want to transform your object proportionally? Let's say, for
example, you want to make your object 3 inches wide. Put 3 inchesin the W field and then hold
down the (Command) key and press Enter. Illustrator automatically figures out the correct
height, scaling your object proportionally.

There are also fields for rotation and shearing. If you hold down the (Option) key when pressing
enter, lllustrator creates a duplicate and leaves the original item untouched.

The Align Palette

Since we're talking about moving things around, | thought now might be a good time to
introduce you to the Align palette (yet another Illustrator palette to deal with). The Align palette
was at one time alist of commands under the Filter menu. As apalette, it is much easier to use
and understand. To useit, ssmply select your objects and click any of the Align or Distribute
buttons. Distribute works by taking the two outermost objects, and then evenly spacing the
objects that appear between them. To center two objects vertically and horizontally, for example,
you would click the Horizontal Align Center button, and then the Vertical Align Center button.
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SUMMARY

Today was topsy-turvy day. We flipped, flopped, turned, moved, rotated, scaled, slanted, and
jolted. We also learned about some new palettes, plus some pretty cool features, such as
(Command-D) and Transform Each.

Term Review

* Scale -- The act of resizing an object.

* Rotate -- The act of making an object turn on a 2-dimensional axis.

* Reflect -- The act of flipping an object to create a mirror image.

* Shear -- The act of skewing an object, giving the appearance of a dant.

* Align -- Command used to align objects in respect to each other.

* Distribute -- Command used to evenly distribute objects throughout a specified distance.
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THE PATHFINDER COMMANDS

If you were to ask me

what the best feature

in lllustrator is, | would Tr?nsfnrm >
tell you the Pathfinder PSSR >
functions. One of the adS. L FB..,

greatest time-saving

featuresin Illustrator, Path b

the Pathfinder commands
are a set of powerful path-
editing functions found

Pathfinder a2 hRepeat Unite ¥4

under the Object menu. Masks ¥ B Unite

Compound Paths p| {4 Intersect
In this hour we cover Cropmarks 2 % Enclude
these functions, including: Graphs bl

* Unite
* Divide
* Crop
* Trap

Once a et of filters
(since version 5.5), the
Pathfinder commands
enable you to quickly
perform complex path
functions on multiple

objects. Later, we describe

each function, aswell as

Lol Minus Front
P Minus Back

B Divide
By Dutline

Bl Trim
iy Merge

[ Crop

L& Hard
[ Soft...

present an example to [l Trap...

demonstrate what each

command does. n
Options...

Unite, I nter sect, Exclude, Minus Front, Minus Back

The first group of Pathfinder commands is used to make complex shapes out of simple ones. Y ou
can quickly create unique art by using Illustrator's basic drawing tools, and then modify them
using these Pathfinder commands.
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Unite

The most commonly used Pathfinder command, Unite simply takes al selected objects and
combines them into one object. Unite doesn't just group the objects together; it "glues’ them all
together, leaving just one large shape, removing all paths that overlap. When running the Unite
command, the final object is automatically brought to the front. Whatever color the front-most
object in your selection is becomes the color of the final, united object.

I nter sect

The Intersect function is used on two objects that overlap each other. After you choose Intersect,
the area in which the objects overlap remains as one combined path, and the rest of each object is
deleted. This command won't work if you have more than two objects selected.

Exclude

The exact opposite of the Intersect command, Exclude takes two objects that overlap each other
and deletes the areas where they overlap (see Figure 13.4). The remaining objects are grouped
together. This command won't work if you have more than two objects selected.
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Figure 13.4

O-a

Minus Front

Minus Front takes two objects and subtracts the front-most object from the object behind it. This
command is great for cutting little shapes or bits out of larger objects. If the front image fits
within the back image, Minus Front creates a compound path for you. It works alot like a cookie
cutter, only what you end up seeing is what's left of the dough, not the cookie. This command
won't work if you have more than two objects selected.

(O~

Minus Back

The reverse of Minus Front, Minus Back subtracts part of an image based on the image behind it.
Going back to the cookie cutter example, this filter would produce the cookie. This command
won't work if you have more than two objects selected.

(O— L
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Divide, Outline, Trim, Merge, and Crop

The next group of Pathfinder commands deals with splitting objects into parts or deleting
unwanted parts of objects.

Divide

Divide takes any overlapping shapes and cuts them up into separate shapes wherever they
overlap. An invaluable tool, Divide enables you to quickly split up objects without once having
to use the Scissors tool. Also, using the precision of drawn shapes, you can perform careful slices
and divisions without using the clumsy Knife tool.

®_..

Divide looks at each object and divides each overlap individually, so it makes no difference if
you're dividing compound paths, groups, or whatever--they all become individual shapes. After
Divide runs, al objects are grouped together. Y ou have to ungroup them if you want to work
with each piece separately.

Outline

Choosing the Outline command converts all shapesto outlines, and also divides the lines where
they intersect (similar to a Divide command for strokes).

@%
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Trim

The Trim command removes the parts of the back object that are behind the front objects. It also
removes the stroke.

O o

Merge

The Merge command operates differently, depending on the fills of the selected objects. If
they're al the same, it's similar to Unite, making them one object. If they're all different, it works
like the Trim command, mentioned above. If some of the objects are filled the same, the like
objects are united, and the rest are trimmed.

| I'n._____._.-'
@

Crop

The Crop command removes any parts of selected objects that are not directly underneath the
front-most object (see Figure 13.11). Thefinal result of the Crop command is exactly what a
mask would do. The only differenceis, the Crop command actually deletes the art that is not
visible, unlike a mask, which just coversit up. Be careful before you run this command, because
you cannot retrieve the artwork that is cropped out.
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Figure 13.11

Hard and Soft

One of the most common uses for these two commands is for simulating transparency effects.
These filters mix overlapping colors.

Hard

The Hard command takes overlapping objects and mixes the values of the colors where the
shapes overlap.

« ©

Soft

The Soft command isidentical to the Hard command, except for the fact that you can control
how the colors are mixed by specifying a percentage. Although Hard might produce an image
that looks transparent, Soft might be used to create an object that appears translucent (see Figure
13.13).
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Figure 13.13

Trap

The Trap command takes selected art and traps it as specified. Many printers today require that
you provide artwork that is trapped properly. It is best to speak with your printer and discuss
your options. If you need to trap your own artwork, make sure your printer provides you with the
settings he needs.

Pathfinder Trap

—Settings -
Thickness: |2 points
Height/Width: |100 T Cancel

Tint Reduction: |40 5

Defaults

—0Options
[] Traps with Process Color
[] Reverse Traps

A computer is perfect. When you draw a square of one color and place it right up against another
square of another color, you get two squares touching each other, with one color ending where
the next one begins.

Out in the real world, however, thisis not always so easy. A printing pressis (usualy) alarge
machine, and it's nearly impossible for every color to print in the exact same place every time.
What usually happens, in our case with the squares, is that there is a slight shift between the
colors that enables a sliver of white, or whatever color the paper is, to sneak through between the
two squares.
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To get around this problem, printers rely on a process called trapping. By slightly extending the
colors (called choking and spreading) and having them overprint each other, the squares do not
just touch each other, but actually overlap a bit. Now, if the press shifts a bit, there is enough of
an overlap of color that awhite sliver won't show through. By setting a color to overprint, you
areinstructing the colorsto print over each other, achieving the trap. Because the Trap command
makes changes to your artwork, it's a good ideato save a copy of your file before you use it.
Also, saveit for the last step to make for easier editing.

Overprints
Because we're mentioning traps, | thought i =
I'd al'so show you how you can specify [ Attributes ™, |y

overprints through Illustrator's Attributes
palette. After you select an object, you can

choose to overprint the fill or the stroke by e ; i
. . B |5 =5 Qutput: -BDD dpi
checking the appropriate box. k2 x i

Crverprint Fill Crverprint Stroke

URL:| |~

One More Shortcut

[ Launch Browser ]

Before we wrap things up, I'd just like to

point out that (Command-4) performs the

last-used Pathfinder command. Many times when editing multiple objects, you need to apply
Pathfinder commands over and over again, and it'sabit of a pain going all the way into the
Pathfinder submenu so often. (Extensis VectorTools 2.0 has a floating palette with all of
[llustrator's Pathfinder commands).

SUMMARY

Pathfinder rules! Today we learned how the Pathfinder commands slice, dice, mince, chop, and
mix together all of our favorite vector recipes. We even dived right into a conversation about
trapping and overprinting. And if al this wasn't enough for you, the next hour talks about using
text in lllustrator.

Term Review

* Trapping -- The process of spreading or extending colors to compensate for printing press
error.
* Overprinting -- Technical term for forcing one color to print on top of another.
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ADDING TEXT

[llustrator would be incomplete without text capabilities. No matter if it's designing alogo,
creating a headline and body copy for an ad, or creating a caption for atechnical illustration,
[lustrator can handle it. Text alone can also be a powerful way of graphic expression. Illustrator
works with type in avariety of ways, and as we go through this hour, you learn where and when
to use each one. Topics this hour coversinclude:

* Point text
* Areatext
* Text on a path

NOTE: Before we begin using the Type tool, et me remind you that there is an option in your
Preferences dialog box on how to select type: Type Area Select. With Type Area Select activated
you can select text by clicking with the Selection or Direct Selection tool anywhere within the
type's bounding box. With Type Area Select turned off, you must click the baseline to select the
type. If you have trouble selecting type because other objects get in the way, lock or hide those
objectsfirst, and then you can select and edit your type easily.

Using the Type T ool

[llustrator has three types of text: point text, —

areatext, and text on a path. To create text ﬁ - 1 A{' IT 1 @
in lllustrator, you use one of the many type @, Lol k

tools, found in the Toolbox. {3? Spar

POINT TEXT

The most popular kind of text
in Illustrator is point text. Also
called headline text, point text
is defined by a single point,
meaning that justification (such
as left, right, or centered text)
is based on that one point (see
Figure 14.2). Creating point text
isalso very easy: with the Type
tool selected (T), just click a
blank area anywhere on the
page and start typing.
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Editing Text

After you create the text, you can edit it by simply using the Text tool to click and drag on
letters. This highlights the text, and typing something new replaces the highlighted text. To
simply add text to an existing block of type, click where you want the type to begin, and a
blinking cursor appears, ready for you to add text.

AREA TEXT * cuare e
Areatext, also called body text, is defined by a shape--much SRR T RN T
like QuarkX Press where all type must be within aframe. , CIRLE B | Gt L Y
Y ou can create areatext in several ways: I

* With the Area Type tool selected, & ' T “{' IT 1 “@

click an existing path. Any type you E::l. L]

enter fills the interior of the path. 7 [3< [ drea Type Tool (T}]
* With the Type tool selected,

click and drag diagonally to .

draw a box.

* With the Type tool selected,
click an existing path. Asyou
drag your cursor over a path,
notice it changes to the Area
Type tool cursor.

A 5
Linking Text Blocks HARRY
If you have more type than can fit into .}__CHAPIN SAE"IG-' .
the selected shape, asmall plussignin “ALL MY LIFE'S A
abox appears at the lower right of the 1'C|RC|.E. "SUNRISE

shape. The symbol indicates that there J
is more text that overflows from the AND SUNDOWN.

shepe. THE MOON
ROLLS,
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[llustrator enables you to link shapes so that overflow type from the first shape flowsinto the
next shape. Y ou can do this by selecting the object with the overflowing type, along with the
object you want to link it to. Then choose Blocks > Link from the Type menu.

Lonem ipsum doelor sil amel
conseciemer adiprscag el sed
Hinm sonnmeky nibh e uismod
unciunt ul Boreet delos: nlagna
pliguany enut velwipat. LIt wisi
e o iy vemiam, gus
nostrud exerc tstion ullamcompar
suscipil oborts pisl ut aligusp ex
gacommodo consaguaal. Duis
mitena vel cum inure doler in
hendrerit in yolputaie velil e
melestie consequal. vl illem
Habone eu feugiat nulla fxchbisis

il were eros et aocumsan ¢ insto
ey chgmissum gua blandil

\pracsent Iupiatum zznl delenit
e duis dodene e feugast
nulla facilisi, Looem ipsum
holor 21k el consscielag
ndipiscing elit. sed diam

mamu iy nibh clisnsd
tncidant vl laoreet dolone magnn
biguam aral volplpal LI wisi
enbm ad mism veniam, gaks
nosinad exenci Ebon ullamoorpen
suscpil oboms mel i alaguip ex
i comnede consagual.

Duris awiem vel eom s dolor
i b et in vulputade velit
s meoleste consequal. vl

illnm delore ou fewmgial nulla
(acilisis ab viero ¢rod ¢l accumsan,
it imste odio dignissim qui
blandin pracsent luptatum el
dilenit apguse duis dolone
feugait nulla fualis), Nam hiber
lempor cum scdus pobis eleifiend
opfion congue nifil impendiet
doming [d guod mazim plscera
[aCer possiim assum.

Liapem Lpsur dolos s10 amed,
consecletuer sdipiscing efil sed
diam noaummy nibh ewismod
timcidunt wi laoreset dolore magn.
aliguam eral volulpat. Ut wisi

Rows and Columns

All thistalk about linking text blocks reminds me about a wonderful feature in Illustrator called
Rows and Columns. Although you can't create columns of text within one text block, you can
create several blocks of type and link them. This handy feature makes creating rows and columns

of type easy.

First, draw an ordinary box. It should be large enough to contain all of the rows or columns you
want to create. Next, select Rows and Columns from the Type menu. Y ou are presented with the

Rows and Columns dialog box.

Rows & Columns

Text Flow:

c

th

RHows Columns
oK

Number: =1 Number: =1 @

Height: |=4132 pt Width: 24272 pt | Cancel |

Gutter: =412 pt Gutter: =12 pt

= E ] Preview
Total: =132 pt Total: =272 pt

Options

[] Add Guides
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Simply enter the number of rows (horizontal) and columns (vertical) and the gutter (the space
between each row or column). The height and width are adjusted automatically. If you have the
Preview button checked, you can see the rows and columns changing in real time as you enter
the numbers.

i el a1 cebemee el o aligip e i gt el
chu -c'll!lllh: [ RN Ry LCECRN ik it
rcl vomoipml Dk wien dobore Le Tengai malla
ify (S S TH R FTTeEs 3 R ] LiEale. Luienh | rid
[LTE T8 Rt sembier il in Vel pukile ikkr aiumncl
odnes ::J:I'J vl coen mnid eedie asaot T ielipecing
sl vk groerapmk vrl piarr chi, s duam
I TR IE dedive o loapnd malls Tl Ty T bl
FiEH I| P U Ta TR e s rurrmed nneslum wi
1 shhir 1
romenrl| dignring gui Mandi Jgpaair erd ool el
W i T ] L Sk cu IS
FrEiEn || =Eing aullsdsaliem ol ves
SETEY L Lram £ e imsan ol
EH R wEAE aiiz cida diparsam i
h- f1z md nidupap Hamihil prararn
1maadn sptsius wenl cklons
|r | g dims dedonn e tham saiEmney mibh
um ST T TR FTRTEET] ruFaTEd Bl s B
el road S Db W ieoE R lanregi
"!|.|||_ =i e siilila midE el el |l evmi ol Lt
..... TIPC T I B TP PO LA Bl ol TR

To make life even easier, the Rows and Columns feature even links the boxes for you so that
type automatically runs from one to the next.

By choosing from the Text Flow icons you Options
can specify which direction the type should

flow. Y ou can also choose to add guides, Text Flow: =) | =0 1o
which is a great time-saving feature in itself.

Now I'll tell you alittle secret: Y ou don't have to use Rows and Columns for just text blocks. It's
great for making quick grids or rows of even boxes, too!

w SANG, "ﬂtz
@’y\ Ay A

oA
Type on a Path o -
T o
T ;g
One of Illustrator's most popular type < c
featuresisits capability to place type E
along a path. Y ou can place text along m
any path in lllustrator, whether it's ,_.':_:*
$
-r.'.;-

an open path or a closed one.

To place text on a path,
do one of the following: ﬁ‘{h
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* With the Path Type tool selected, & . T "'1:'_\' T |IiT} “’:S’
click any path. 2550 B K
f?. F< | Path Type Tool (T3]

* With the Type tool or the Area Type
tool selected, click and hold the (Option)
key while clicking any path. Notice that
the cursor changes to the Path Type tool
icon when you press the (Option) key.

Moving Text Along a Path

When typeis on a path, you can move
its position as well asflip it to the other
side of the path. First, select the type or
the path using the Selection tool (the
Direct Selection tool or Group
Selection tool do not help here).

Notice that the path is highlighted
aswell asthe I-beam insertion point
for the type. To edit where the type
lies on the path, click the I-beam and
drag in the direction you want to move
the type. To flip the type to the other
side of the path, double-click directly
on the I-beam or drag towards the
opposite side of the path.

Vertical Text

[llustrator 7 also supports vertical text, as well as complicated alphabets such as Kanji
(Japanese). The Vertical Typetool, Vertica AreaTypetool, and Vertical Path Type tool all work
the same as their horizontal counterparts.

SUMMARY

Up to this point, we've covered just about all the creation toolsin Illustrator. First we covered
drawing shapes, and now we know how to add text to our illustrations. We learned about the
three types of text in Illustrator: point text, areatext, and text on a path. But don't go anywhere
just yet. There's still plenty more, and next hour we discuss how to work with the text we just
learned to create.
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ADVANCED TYPOGRAPHY

In the last hour we learned all about creating text in Illustrator. We learned about the three kinds
of text, and we learned how to move the text around. But there's alot more to text than just the
words themselves. In this hour we learn how to work with the type--or more importantly, how to
make it look good. Of course, that's our goal with anything we do, and Illustrator has the tools to
make text look great. In this hour we learn all about:

* The Character palette
* Fonts

* The Paragraph palette
* Multiple master fonts

The Character Palette ] %
| {haratter\“‘\_ | 4

Y ou control your type (and believe me, type i .
needs lots of controlling) using Illustrator's Font:[Formata [Medium “E'
Character palette. In this palette, you specify alent |v Y T -
fonts, point size, leading, and kerning. The rl’i[‘ zliept [+ I& ST
Character paletteisthe central location for Al FHaute  [»] &% (2o =]
editing type style: how your type looks.

T Efroow_[~] T Eionw [7]
To edit type, you must select it. To do so, -
you can either use the Selection tool to A ot |~
select the entire text block, or you can select Multinational Cptions
type |nd|V|duaIIy by: Language:[ LS. English -
* Clicking and dragging text with the Type Direc ti-:-n'[ Etandard -
tool :

[ ] Proportional €Ik ] Wari-Chu
* Clicking in the text with the Type tool and [[] Japanese Layout Rules
pressing the eft or right arrow keys on the . - _
keyboard while holding down the Shift key cakscas]  [o6 ciiRoman] |

Font

A font isastyle of type, usually grouped in families such as Helvetica or Times. There are many
different fonts available, and afont is basically the personality of your type. Loud text might be
in afat bold font, and more delicate words might be in a script italic font.

After you choose a font, you also specify what style you want, such as Roman (normal), Italic, or
Bold, and so on.
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Size

Typeistraditionally measured in points. Y ou can specify your type to be any size from 0.1 point
(really small) up to 1296 points (really large). Y ou can quickly enlarge or reduce your typein
two-point increments by pressing (Command-Shift->) or (Command-Shift-<), respectively. This
works regardless of how you selected the type (with the arrow or the Text tool).

TIP: Of coursg, if you need even bigger type, you can simply convert your text to outlines (we
get to that later in this hour). Once your type is a vector object, you can scale to virtually any size
with the Scale tool.

Leading

Leading (pronounced ledding) is the amount of space between each baseline in a paragraph of
type. Leading is also measured in points. If the leading size and the point size are the same, it is
called solid leading. A lot of space between each baselineis called open leading, whereas very
little space is called tight leading. Leading isimportant in determining readability. Typically, the
wider your block of text, the more leading you need.

The keyboard shortcut for increasing and decreasing leading is (Option-up arrow) and (Option-
down arrow), respectively.

Kerning and Tracking

Kerning is the space between individual letters. Tracking is the amount of |etterspacing applied
globally across an entire word. Negative numbers mean your kerning or tracking istight, and the
letters are closer to each other. Positive numbers mean your kerning or tracking is loose, and the
letters are further apart from each other.

tight tracking: KATI loose tracking: KATI

The keyboard shortcut for tightening and loosening kerning or tracking is (Option-left arrow)
and (Option-right arrow), respectively. If you have aword selected, Illustrator automatically
applies tracking. Otherwise, invoking the keyboard shortcut applies kerning.

Horizontal and Vertical Scale

Using horizontal and vertical scale, you can adjust the width and height of selected text. This can
result in type that looks squashed and can distort text in unsightful ways. For true horizontal and
vertical scaling, try to use multiple master typefaces, which are covered later in this chapter.
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Basaline Shift

All typeisaligned to abaseline. Y ou can select type and shift the baseline for that selection.

I Thisisuseful for creating superscripts or subscripts and also for
KA—I creating type effects. But in Illustrator, one of the most useful

applications for baseline shift is when you have type on a path.

Y ou can use baseline shift to move the type up off the path, and you can give the path a stroke
(make sure you use the Direct Selection tool, or the type gets a stroke, t00).

ine
X S

"O
>

The keyboard shortcut for raising and lowering baseline shift is (Option-Shift-up arrow) and
(Option-Shift-down arrow), respectively.
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=

The Paragraph Palette = :
| Paragraph""\

w

The Paragraph palette is where you specify
justification, indents, word and letter spacing,
as well as options such as auto-hyphenation
and hanging punctuation.

i 5
M
i
o
i
I
42
i i
o o}
i i

Justification Word Spacing Letter Spacing
Justification is afancy word for paragraph i :l h in: :l
alignment. Y ou can align a paragraph of type Desired: % | | Desired: D %
in five different waysin lllustrator:

¥ Mart::lr; Ma;;:l"r.
* Flush left Options
: Flush right [ ] #suto Hyphenata
N \%e;rﬁrée(jd |:| Hang Punctuation
* Forced justified (flush left and right) |:| Repeated Character Processing

|:| Line Breaking: |:| *

Y ou can select these quickly by clicking the
icons found at the top of the Paragraph palette.

The keyboard shortcuts for justification are as follows:

Left: (Command-Shift-L) Right (Command-Shift-R
Center (Command-Shift-C) Justified (Command-Shift-J)
Forced Justified (Command-Shift-F)

NOTE: For some reason, Adobe assigned the (Command-Shift-L) keyboard shortcut to two
different functions: unlocking objects and making type flush left. Unlocking objects takes
precedence, so if you have alocked item on your page, and you attempt to make text flush left by
using the keyboard shortcut, Illustrator first unlocks the art. Y ou then need to reselect the text
and run the shortcut again.

Indents

There are three different indent settings. Left Indent, First Line Indent, and Right Indent. The left
and right indents affect the entire paragraph of type, whereas the first line indents from the left
on thefirst line of the paragraph.

There is also a setting for space before each paragraph. Sometimes you want to add alittle bit of
extra space before each paragraph to increase readability, aswell as make it easier to identify
where a paragraph ends and the next one begins.
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WORD AND LETTER SPACING
These settings let you control spacing between words and |etters when justified or forced

justified type is used. These settings control when words become hyphenated, or forced to
another line, by specifying how far Illustrator can stretch the spacing between words and |etters.

The Tab Palette

To create tabs in a paragraph, open the Tab Ruler by choosing it from the Type menu. It'sa
floating palette, so you can position it anywhere on the page.

F . E

Ffla 3 ]|+ | B snap % #delates

—t T
2| 4K B B

To add atab, click the ruler where you want the tab to be. After you click, a highlighted tab
arrow appears. Y ou can now make the tab aright, center, left, or decimal tab by clicking the
iconsin the upper-left corner of the Tab palette. To delete atab, drag it off the palette, and to
quickly change the measurement system, Shift-click in the upper portion of the palette.

The MM Design Palette

[lustrator 7 has full support for multiple master typefaces. Developed by Adobe, a multiple
master typeface contains a variable width or weight or even serif axis.

By controlling the axis, you can modify the =

typeface to fit your exact specifications. | MM Design
The MM Design palette lets you modify Font: Myriad MM Italic
multiple master typefacesin real time right Weight o
in lllustrator. Simply drag the slidersto edit

[
the typeface. Y ou need to have a Multiple Width =

Master font to use this feature.

Converting Text to Outlines

One of the most powerful text featuresin lllustrator isthe ability to convert type into fully
editable Bézier paths. By choosing Create Outlines (Command-Shift O) from the Type menu
(you need to have type selected with the Selection tool when you do this), Illustrator turns the
typeinto Bézier paths. Y ou can then edit each individual letter using the techniques we learned
in previous chapters. Y ou can even use the type as a mask.
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There are two other reasons why you would want to convert type to outlines. One isthat certain
plug-in filters don't work on type. So to run those filters, you need to convert your type to
outlines first. Another reason isif you are sending your file out to another person, or to your
service bureau, who might not have your font. Converting the type to outlines assuresit will print

perfectly. When you create alogo, it's always a good idea to convert any type to outlines. This
way whenever you use it, you don't have to worry about fonts.

TIP: After text is converted to curves, it cannot be turned back into text again, so you can't fix
any typos. It might be a good idea to save aversion of your file before you convert your text to
curves, in case you need to edit the text.

Change Case =———— Change Case

It happens all the time: Change Selection To:

you type something all 4 '
in caps, and you need it {® Upper Case (ABC)

in lowercase, or vice O Lower Case (abc) Cancel

versa. Well, with this :
handy little feature, your (J Mixed Case (Rbc)

hands are spared afew
more moments from that
repetitive strain injury.
Simply highlight the type with the Type tool and choose Change Case from the Type menu. You
can then choose how you want your type changed.

Find Font and Find/Change

Y ou just finished an entire job and the client calls to say they loved it, but could you just change
one little thing? They want all instances of the word Fred to be changed to Frederick, andin a
different typeface. After you hang up the phone and slam your head into the monitor, go to the
Type menu and select Find Font. Here you can easily change one font to another throughout the
document.
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Find Font

Current Font List: 9

Bodoni-Book ; || Done ||
OfficinaSans-Bookltalic E

GillSans - [ Find Nant ]
Replacement Font List: 9 [ Change ]
Bodoni-Book el
OfficinaSans-BookItalic E (_Change ANl |
GillSans - [ Skil] ]
Font List:[ Document |« [ Save List... J

Multiple Master Type 1

Standard [x] TrueType

[x] Roman =] CID

Asfar as changing the actual text, select Find/Change from the Type menu and in the
Find/Change dialog box, type in what word you are looking for, and what it should be changed
to. These functions work the same as they would in any word processing program.

Find /Change

Find what:
“ Done “
Fred

]| Search Backward W'rap Around

Change to: [ Find Next |
Frederick [ Change ]
Whole Word Case Sensitive [ Change Al ]

l ]

Change/Find
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Smart Punctuation

If you want to make your type look asif it were set by an expert typographer, use Smart
Punctuation. It replaces regular quotes with the curly kind and inserts ligatures, em and en
dashes, ellipses, and expert fractions in your document.

Smart Punctuation

Replace Punctuation

[x] ff, fi, ffi Ligatures En, Em Dashes (--) l
ff, fl, ffl Ligatures [ Ellipses (...)

[x] Smart Quotes (“ ") [ Expert Fractions
Smart Spaces (. )

Replace In
@® Selected Tedt Only O Entire Document

Report Results

Check Spelling

[llustrator also has a built-in spell checker. 1t works like any other spell checker you would find
inaword processor. You can find it in the Type menu.

SUMMARY

Fonts, points, leading, kerning, indents, justification: We learned all about these fancy words this
hour along with alot of other cool stuff. We learned how to use Multiple Master fonts as well as
how to adjust word and letter spacing. The Change Case filter will save us many hours of extra
typing, and we really felt the power of Illustrator when we converted type to outlines and edited
the Bézier paths. By the way, converting type to paths and analyzing how the points are set up is
agood way to learn more about Bézier paths.

Term Review

* Fonts -- Typestyles of different varieties, such as serif, sans serif, and script.

* Points -- Measurement system used for measuring type. There are 72 points in one inch, and
there are 12 pointsin a Pica.

* Leading -- The amount of space between lines of type (pronounced ledding).

* Kerning -- The process of adding or removing space between |etters.
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WORKING WITH RASTER IMAGES

Way back in Hour 1, we discussed the differences between vector and raster images. To quickly
review, vector images are mathematically defined (Bézier) shapes that can be scaled to virtually
any size without any loss in detail. Raster images are defined by individual pixels, which
combine to create an image. Raster images, however, are bound by the resolution in which they
were created, and scaling pixel images can produce jaggy or unclear results. Althoughitisa
vector program, Illustrator does have support for raster art. In this hour, we learn about:

AV m AN

There are basically two ways to get araster image into Illustrator. The first way isto place the
image. This command takes an existing raster image and placesit into your document. The
second way isto convert avector object into araster object by using lllustrator's Rasterize
command. Thereisareadly athird way--opening araster file directly--but we'll get to that later in
the chapter.

* Placing raster images
* Linking and embedding
* Working with raster art in Illustrator

VECTOR

A Pixdl for Your Thoughts

PLACING AN IMAGE

If you've used any page layout program, either PageMaker or QuarkXPress, you're familiar with
the Place command. Place lets you import an image right into your Illustrator document. The
image could either have been created in another application or it could have been exported from
[llustrator in araster format (see Hour 20, "Saving/Exporting Files").

To place araster image, choose Place from the File menu. Y ou are then prompted with a dialog
box asking you to find the file you want to place. After selecting thefile, click Place. The image
appears in the center of your screen.
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Notice that the image has a box with an = : : 3 —
"Xx" through it that showstheimageis _ .

selected. Note that the "x" appears only :

on linked EPS images. All other placed -

images, whether linked or embedded,
have just a box surrounding the image.
Y ou can only view placed images when = -
in Preview mode. When you arein AHRAPHIC DESIG N~
Artwork mode, you only see the

surrounding box, not the image.

EPS files are the one exception to thisrule. In the View section of the Document Setup dialog
box, there is a Show Placed EPS Artwork option that enables you to see alow resolution black
and white preview of the EPS image when in Artwork mode.

The Rasterize Command

Any object in lllustrator can be rasterized right inside Illustrator using the Rasterize command.
Essentially, you are instructing Illustrator to convert avector object into araster. When an image
israsterized it becomes an embedded image (see "Linked and Embedded Images' later in this
chapter).

1. Select one or more objects.

2. Choose Rasterize from the Object menu (see Figure 16.4).

3. Choose a color model. You can select either RGB, CMYK, Grayscale, or Bitmap.

4. Next, choose a - Hasterive msS8"———=
resolution. When Illustrator
converts your selection to Color Model: [ Grayscale TI

pixels, it needs to know

how many pixelsto create. Hesoliion cancel
For screen and web art, ® Screen (72 ppi)
Chﬁ°§672- dlc;io-llfyour art O Medium (150 ppi)
will be printed on an : ;
imagesetter, you need G High (300 ppi) ,
higher resolution -- closer ( Other: 72 PPt
to 300 dpi for photographic
b P arep Options

images,; 600 or more for
bitmap and line art. L] Anti-Alias

[ ] Create Mask
5. Finally, choose whether
you want anti-aliasing or a
mask. Both of these features
are described in detail later in this chapter.




HOUR 16

TIP: Everyone knows that you can use the Rasterize command on vector objects, but did you
know that you can also apply the Rasterize command to raster art? Thisis most useful for
converting color images to grayscale (select Grayscale from the Color Model pop-up menu) or
for converting grayscale images into color (some Photoshop-compatible filters work only on
RGB images).

Anti-aliasing

One of the biggest advantages of vector art is the smooth lines you get when you print the file.
Today's high-end imagesetters print at resolutions upwards of 2500 dpi, and we are used to
seeing the clean sharp edgesin our logos, type, and illustrations. Onscreen, however, things can
appear jaggy because a monitor's resolution isonly 72 dpi.

When your final art is printed, the images will be ultra-sharp, but what if your images won't be
printed? What if you are designing for the Web or for a multimedia presentation, and the final art
will be viewed onscreen? Do we have to live with jaggy art in these situations? That's where
anti-aliasing comesin.

Anti-aliasing is the process of slightly blurring the edges of an image to give it a softer, smoother
edge onscreen. Adobe's ATM (Adobe Type Manager) uses this technology to enable fonts to
appear smooth onscreen at any size (see the following NOTE). Almost all images on the Web
use anti-aliasing to give a clean and smooth appearance.

NOTE: Y ou may notice that when in Preview mode, al type appears anti-aliased (assuming you
enabled the Anti-alias Type option in the Keyboard Increments screen of the Preferences dialog
box). When you switch to Artwork mode, the type is not anti-aliased. This anti-aliasing appears
only onscreen, however--when you print the file, you still get the sharp lines you are used to.
Thisisagreat feature that Adobe added as of version 7. Of course, after you convert text to
outlines, it does not appear anti-aliased onscreen.

When you use the Rasterize command to convert a vector object to raster, and the final image
will appear onscreen at 72 dpi, anti-alias the object to give it that smooth appearance. To do so,
simply check the Anti-Alias checkbox in the Rasterize dialog box.

Creatinga Mask

A raster image always has a rectangular-shaped bounding box that defines the area of the image.
Although vector files can have irregularly shaped edges, araster requires a clipping path to
achieve a different shaped border. When you rasterize an object in Illustrator, you have the
option to create a mask for the image. This alows you to place the rasterized image on a colored
background without the white background box filling in around the rasterized art. To create a
mask for an object at the time you rasterize it, ssmply check the Create Mask button in the
Rasterize dialog box.
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The raster image on the right was created using the Create Mask option.

Opening an Image

| mentioned earlier that there isathird way to bring a pixel image into Illustrator. Besides
placing afile or using the Rasterize command, you can also use the Open command to directly
open araster image, which creates a new document with the raster image in it. Remember,
however, that when you open araster file, it automatically becomes embedded in the Illustrator
document, and you cannot link it.

[llustrator 7 also sports a brand new and improved EPS parser. This means you can open just
about any vector EPS (Encapsulated PostScript) file and edit it asif it were an lllustrator
document. Y ou can save a QuarkX Press document as an EPS, for example, and then open the
file (not place it) and edit the document. It should be noted, however, that editing text may be
difficult due to the way the text isimported.

NOTE: The EPS format, unlike any other, can support both raster and vector art--even within the
same document. The parser in lllustrator can only convert vector EPS images (or the vector parts
within an EPS) into editable art. Any art that isin raster format remains in raster form and can be
edited only as araster image.

LINKED AND EMBEDDED IMAGES

Asif things weren't already complicated enough, there are two ways Illustrator handles raster
images. A raster image can either be linked, or embedded in an Illustrator document. Except for
certain file formats, Illustrator links placed images by default.

A linked file resides outside of your Illustrator file, and Illustrator notes the location of that file,
beit on your hard drive, on aZip disk, or on afile server. The image in your document is simply
apreview of that raster file. At print time, Illustrator goesto the original file and uses the high
resolution information to print the image where it belongs in the illustration. Y ou cannot print
your file without that original raster image.
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An embedded raster is actually part of your Illustrator document. After you embed araster file,
you no longer need the original raster file because the entire image is contained within your
[llustrator document. Of course, this also means that your file size increases (if the fileisahigh-
resolution one, your lllustrator file could grow to be extremely large).

If you decide not to link afile when you place it, uncheck Link when you import it. The image
will then be embedded.

- fm Desktop * — MORDY |
Preview
[ ] 09TY105 als [ Eject )
[ 09TY106
| 09TYI07.eps | [ _pesktop |
[LZR 1560 Laser

ol MGLOD22.TIF i [ Cancel )

2

[T screens

(<] Show Preview [ ] Show Al Files

Qlink

TIP: If you have alinked image in afile, and then you delete or remove the linked image from its
directory, Illustrator can't access the image anymore. The next time you open the file, Illustrator
alerts you and asks you where the file currently is. If you can't find it, Illustrator opens the
document without the image in place.

File Formats

[llustrator 7 supports a wide range of image formats. Depending on which platform you are
using, Macintosh or Windows, you can open and place an array of different file formats. Some
are specific to one particular program and others are specific to either the Macintosh or Windows
platform, such as PICT and BMP.

There are, however, formats that can be used on either the Macintosh or Windows platforms.
These formats include native Illustrator files, Acrobat PDF, TIFF, and EPS formats. PDF files
can be viewed on any platform (even the World Wide Web) with the Acrobat Reader program.
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Color Management

[llustrator 7 sports arobust color management system that works in conjunction with either
Apple ColorSync (Macintosh) or the Kodak Digital Science Color Management System
(Windows). These are installed when you install Illustrator. Y ou can edit the color settingsin
[llustrator by choosing Color Settings from the File menu. Y ou can fine-tune your options within
the Color Settings dialog box.

Color Settings

Profiles

Monitor:| Adobe Illustrator Default -
Printer: [ Adobe Illustrator Default -
Intent: | Colorimetric g

Use ICC profiles with TIFF

Channels Preview

Simulate print colors on display

Cyan Yellow
Magenta Black

Description
Causes your artwork to be displayed as it will look on the printer. Al
displayed colors are in the printer”s garmut. Also allows you to display

and print only specific color channels,

A color management system strives to keep colors consistent as you work with them--from
scanning, to viewing onscreen, to proofing, to final output. Because each of these processes use
different color technologies and even different color models, there can be a noticeable difference
from what you see onscreen and what you actually get when the job is printed. Technologies
such as ColorSync and Kodak Digital Science compensate for color differences by using color
profiles from each device, such as your scanner, monitor, and printer, and try to make color
consistent across the board.

A great feature of Illustrator isthe ability to ssmulate print colors on display. This option lets you
view filesjust like in Photoshop, when you want to view only certain color channels. It's also
great when doing print work to get a better idea of how your fileis going to print.
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Notice also the checkbox marked Use ICC profiles with TIFF.

With this option =——— TIFF Color Management Options
enabled (whichitis =
by default), when you
place a TIFF image,
[llustrator prompts
you with adialog box
to help calibrate the
colors onscreen,
making for more Select an itern to see a description of the itern here.
accurate color
representation
onscreen. Of course,
you can choose to

leave everything as :
itisby clicking the 1gnore Profile |

Ignore Profile button.

Profile: [ Adobe Illustrator Default v]

Intent; | Colorimetric ~|

Description

What Can | Do with Raster Artin Illustrator?
Placed raster images cannot be edited in Illustrator. Y ou can, however, apply transformations to
them, and you can also apply certain filters. Y ou transform raster images just as you would any

[llustrator object: select it and apply the transformation. This appliesto all the transformation
commands and tools--moving, scaling, rotating, reflecting, and shearing.

Colorize 1-bit TIFFs
[llustrator has the capability to colorize 1-bit (black and white) TIFF images. After placing the

image into your document, you can assign one color to the black part of the image by assigning a
fill to the image.

Usethe Autotrace Tool

One of the reasons why you would place araster image into Illustrator isto traceit. Tracing a
raster image creates a vector object that you can edit and scale without worrying about
resolution. Illustrator's Autotrace tool was created with thisin mind.

1. Place araster image into your Illustrator document.

2. Choose the Autotrace tool from the Tool box.

3. Click the edge of the image to trace.
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The Curve Fitting Tolerance setting in Preferences determines how close and how smooth the
traced object isin reference to the raster image. If you need more detail and accuracy for your
tracing, you might look into Adobe Streamline, a software product geared specifically towards
converting raster to vector art. For more information on tracing images, see Hour 21, "Working
Smart in Illustrator.”

Use Photoshop-Compatible Filters

Finally, one of the most exciting things you can do to raster imagesin Illustrator is apply
Photoshop-compatible filters to them. Illustrator ships with several filters, including the entire
Gallery Effectslibrary of Photoshop-compatible filters. To use afilter, it must be present in
[llustrator's Plug-ins folder when you launch Illustrator.

Photoshop-compatible filters can only be run on embedded raster images, not linked ones. Also,
many Photoshop-compatible filters work only on images that are in RGB color mode. If you
have an image that is not RGB, use the Rasterize command to convert to the RGB color space.

Photoshop-compatible filters can be found under the Filter menu. They look just like the other
filters, but they are grayed-out unless you have an embedded raster image selected.

Have fun with the filters, and remember that you can always use the Rasterize command to
convert vector art into araster image, enabling you to apply Photoshop-compatible filtersto it.

For more information on Photoshop-compatible filters, check out either Illustrator 7 Complete or
Photoshop 4 Complete. These books do a great job of reviewing the filters, their settings, and the
results you get.

SUMMARY

WEell, we learned to live with our pixel friends, and we proved that raster and vector images can
coexist peacefully. We learned about linking and embedding, and also about Illustrator's
powerful EPS parser. Asif that weren't enough, we traced pixel images and even applied
Photoshop-compatible filters to rasters within Illustrator. Next, we get back to the world of
vector images and explore all of the filters we can apply to vector objects.

Term Review

* Color management -- Software on a system level, such as Apple's ColorSync or Kodak's
Digital Science, that assures consistent color on screens, scanners, printers and imagesetters.
* Link -- An external raster file that is referenced from within an Illustrator document.

* Embed -- A raster image that has been included within an Illustrator document.

* Place -- The act of importing an image or art into an Illustrator document.

* 1-bit -- A raster image that contains only black and white pixels.
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VECTOR FILTERS

[lustrator filters, found in the Filter menu, perform awide variety of tasks, ranging from simple
time-savers such as converting all colorsto CMYK to more complex functions such as creating
intricate borders using the Path Patterns filter. In this hour, we focus on some of these filters,

including:

* The Adjust Colorsfilter
* The Object Mosaic filter
* The Roughen filter

* The Twirl filter

* The Zig Zag filter

TheFilter Menu

The Filter menu actually started out as a place

for Illustrator plug-ins, but now that plug-ins can
appear anywhere within Illustrator, the Filter menu
has become the dumping ground for functions that
don't really belong under any other menu. If you
have any third-party plug-insinstalled, such as
KPT Vector Effects or Extensis VectorTools,
you'll find them in the Filter menu. So if you have
some filters that are not covered in this chapter,
please refer to the documentation that came with
those filters. For more information on plug-ins, see
Hour 21, "Working Smart in Illustrator.”

I've broken down the filters as they appear in the
Filter menu, and they fall under the following
categories: Color, Creation, and Distortion. The
rest are Photoshop-compatible filters that apply to
raster objects only.

Before we begin, at the top of the Filter menu,
you'll notice two commands: Apply Last Filter
and Last Filter. These can be used to quickly

View Window
Apply Last Filter #E
Last Filter SR3E |

Colors
Create
Distort
Ink Pen
Stylize

v wvwvw

Artistic

Blur

Brush Strokes
Distort
Pizelate
Sketch
Stylize
Texture
lideo

i . . R . e

invoke the last filter you used. The Apply Last Filter option runs the last filter you used, with the
settings you used. The Last Filter option opens the dialog box of the last filter you ran, enabling
you to adjust the settings before running the filter. Remember the keystrokes--(Command-E) and
(Command-Option-E), respectively--for these two commands, as there are times when you may

want to use afilter repeatedly.
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COLORFILTERS

Adjust Colors...
Blend Front to Back
Blend Horizontally
Blend Uertically
Convert to CMYK
Convert To Grayscale
Convert to RGB
Invert Colors
Merge Spot Colors
Overprint Black...
saturate...

Apply Last Filter 3*¥E
The Color filters are Last Filter A
production-based filters
that you use to fine-tune
colorsas well asto w
address c_olor issues to Distort b
prepare filesfor film Ink Pen b
output. Stylize b
NOTE: It'simportant to A
point out that t%esefilters fElistic »
do not work on objects Blur »
filled with gradients or Brush Strokes 4
patterns. If you want to Distort 4
adjust them with these Pixelate 4
CElratrh [

filters, you have to
convert them into art

using the Expand function (refer to Hour 6, "Drawing Bézier Paths,"for detailed information on

the Expand command.)

Adjust Colors

The Adjust Colorsfilter lets you tweak the colors of an object or a group of objects.

Similar to Photoshop's L evels command,

Ad sl Colors

you can adjust colors by changing the
CMYK, Grayscale, or RGB values. You
can adjust either just thefill, the stroke,
or both simultaneously and preview your
results as well (although this may slow
down performance). Y ou can even click
the Convert button to change all selected
objects to your current color mode,
indicated in the pop-up menu at the top
of the Adjust Colors dialog box.

Codor Mede:| CHYE 1-!

)

L) [-7a ,'*’.“-.
= [ Cance |
Magunta |_H_:".;
= [ Freuiew
Wi | B I-‘iT !'-"c- Ol anupst
=
Elack |75 :"-'E
=
Fll it BORsOn4
[=] Filn [Z] & rok e

Blending Objects

These threefilters, Blend Front to Back, Blend Horizontally, and Blend Vertically, do not affect
the objects (as the Blend tool does) but affect the fill color within them. Y ou must have at |east

three objects selected for these filters to work. Upon running the filter, Illustrator blends the

color across the selected objects.
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After you run the Blend Horizontally filter on the row of circles on top, the color is blended
evenly across the circles, as shown on bottom.

Switching Between Color Models

Thesefilters--Convert to CMYK, Convert to Grayscale, and Convert to RGB--speak for
themselves. When used, any item selected is converted to the color mode chosen. Remember that
these filters do not convert gradients or patterns.

Inverting Colors

The Invert Colorsfilter, identical to the one found in Photoshop, creates an inverted color
(negative) for the selected objects.

Merge Spot Colors

Thisfilter isimportant when preparing spot color jobs for film output. Illustrator enables you to
create multiple spot colors with the same swatch name. This may present problems when sending
out for film separations because if you have several swatches named "red,” how will Illustrator
know which one to use? Running the Merge Spot Colors filter checks your document for spot
colors with the same name and del etes duplicate swatches, leaving you with only one swatch for
each color.

Overprint Black

On most print jobs, you may need to set the black ink to overprint (as opposed to knockout,
where the top color prints, but the color behind it does not). For simple jobs that require trapping,
overprinting the black ink solves most trapping problems. Instead of having to select each object
individually, and then choosing the Overprint option in the Attributes palette, simply running the
Overprint Black filter saves alot of time. Refer to Hour 13, "The Pathfinder Commands,” for
more information on overprinting and trapping.
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Saturate
The Saturate filter can be alot of fun. Using a simple dlider, you can saturate or desaturate the

color in an object or agroup of objects. Thisfilter is great for creating subtle changesin color as
well as making certain objects more or less vibrant than other objects.

CREATE FILTERS

Basically time-savers,

the Create filters let e

you do in one step H;};ii_u _LEE.*E.-. Filter E:EE.

what might normally Last Filter ~a36E

take alot more. You'll &

aso find the Object Colors 4

Mosaic filter here, a Create Fill & Stroke for Mask
powerful filter that can Distort b| Object Mosaic...

be used to create really Ink Pen | Trim Marks
interesting effects. i i

Fill & Strokefor Mask

When you create a mask, the object that is the mask cannot have any fill or stroke attributes. But
sometimes you'd like the mask to have a stroke or fill. With the mask selected, running the Fill &
Stroke for Mask filter applies afill and stroke to the mask based on what the mask attributes
were before the mask was created.

In other words, if you used a square with a1 point black rule and a yellow fill to make a mask,
running the filter applies those attributes to the mask. The way Illustrator accomplishesthisis by
creating a new square with afill of yellow and a new square with a stroke of black and afill of
None and then sending them to the back and front of the mask, respectively.

Although you could actually do this manually, with the filter you can do it in one step.

Object Mosaic

Object Mosaic is a powerful filter used to create a vector tile-like mosaic based on araster
Image.

Follow these stepsto use thefilter:
1. Select araster image.
2. Choose Create Object > Mosaic from the Filter maenu.

3. Set your optionsin the Object Mosaic dialog box. Y ou can choose to delete the raster image
after the filter isrun.
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The image on the left isthe original raster. The image on the right is the mosaic created after
running the Object Mosaic filter.

Try different settings to get different results. Remember, you can also run the Object Mosaic
filter on objects rasterized in Illustrator with the Rasterize command. Try using Object Mosaic
on rasterized type for some cool effects!

Trim Marks

Thisfilter creates a set of trim marks (a.k.a. crop marks) around any selected object. Depending
on what option you have set in Preferences, Illustrator creates either standard or Japanese style
trim marks.

In Preferences, you can choose from either standard (left) or Japanese trim marks (right).
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DISTORTION FILTERS

For those of you who like
to take reality into other Apply Last Filter 2E

dimensions, Illustrator's La<k Filtar =230
distort filters will be right
up your alley. Whether it's

minor tweaking or major E::;:Se :

funk, these filters comply Free Distort

with the most twisted and m
demented tasks. Remember Ink Pen p| Punk & Bloat...

that these filters do not work Stylize | HRoughen...

on gradients or patterns, — Scr_lhhle and Tweak...
unless you expand them first. Artistic p| Twirl...

(Try it; twirling an expanded Blur p|_Zig Zag...

gradient is way-cool!) Bruch Strnkoc [ |

FreeDistort

For simple, straight distortions, the Free Distort filter lets you edit a selection with four straight
points. Dragging each of the points distorts the selection. Clicking the Show Me button previews
your distortion in the Free Distort dialog box.

Free Distort

Cancel

Show Me
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Punk & Bloat

The Punk & Bloat filter, shown in Figure 17.14, does some pretty wild things to art. Thisfilter
changes the Bézier curves in a selection to make either sharp points (punk) or round puffy points
(bloat).

* %k %k

The original star isin the center. To the left isthe "punked” star, to the right, the "bloated” one.

Roughen

Of all the distort filters, Roughen is probably used the most and has some very practical
applications. The Roughen filter makes objects appear rough by adding anchor points and
moving them around. If you keep the settings really low, you can make your art ook almost
hand-drawn. The Distort filter is also great for creating torn or crumpled-looking paper.

* %

The original star (left) and what it looks like after the Roughen filter isused (right).
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Scribble and Tweak

The Scribble and Tweak filter is difficult to describe. Based on your settings, Scribble randomly
moves anchor points away from the original object, whereas Tweak moves anchor points around
on the object, creating interesting distortions, to say the least.

* k%

From left to right: the original star, scribbled, and tweaked.

Twirl

The Twirl filter isreally cool. Thefilter actually curvesthe art in a circular motion from the
center based on the number you enter in the Twirl filter dialog box.

If you want to Twirl an object by eye and watch it change in
real time, you can use the Twirl tool, which can be found with
the Rotate tool (see Figure 17.22). Click and drag with the tool
and watch your selection spin before your very eyes!

From left to right: the original star, twirled 30deg., twirled 100deg.
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ZigZag

The Zig Zag filter, shown in Figure is another distort filter that wreaks havoc on anchor points.
Playing with the settings on this one can also produce some wild and interesting results.

SUMMARY

So many filters! We covered alot of ground today discussing al of Illustrator's filters, which
enhance our productivity and creativity. Y ou never know when you could use the Roughen filter
or even Object Mosaic to add that special touch to your artwork. Y ou're probably wondering
about the rest of the filters found in the Filter menu, such as the Ink Pen. Well, hold on to your
chair because in the next hour we dive right in to the rest of these filters.

Term Review

* Knockout -- Term used in trapping to indicate the top color obliterating any color below it.



HOUR 18

FILTERSWITH STYLE

Aswe al know, style is very important when it comes to working in design. A client always
wants a certain stylein his design or acertain look and feel. The filtersin this chapter can help
define a style in your work and help you achieve that ook you've been searching for. We've seen
that Illustrator's vector filters can do some pretty cool stuff, and in this chapter, we'll see that they
can do some pretty powerful stuff aswell. This hour covers:

* The Ink Pen filter

* Adding arrowheads

* Path Patterns

* Photoshop-compatible filters

THE INK PEN

Sometimes people don't get the credit they deserve. And sometimes filters don't get the credit
they deserve. The Ink Pen filter fits that description perfectly. A powerful filter, the Ink Pen fills
objects with complex stippling and crosshatching effects.

MR

To fill an object with the Ink Pen filter, select the object and choose Ink Pen > Effects from the
Filter menu. Y ou are then presented with the Ink Pen Effects dialog box, where you can set
exactly how you want the effect to look. It should be noted that the Ink Pen filter produces
complex fills that may produce large files and may even cause printing problems in some cases.
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You can even =——— Ink Pen Hatches

create your own

hatchesfor usein Hatch:| Crosshatchi -

the Ink Pen filter.
To do so, choose

rom eFits
menu. You are [—]

presented with a Delete Save as...

dialog box where Preview
you can import and

export hatches.

For more in-depth detail on exactly what each setting doesin the Ink Pen dialog boxes, refer to
the Adobe Illustrator manual.

STYLIZE FILTERS

The Stylize group of filtersis used to add unique and interesting effects and accents to art. Some,
such as Path Patterns, are extremely powerful; others, such as Add Arrowheads and Round
Corners, may not seem so important, but we'll see how they too can be used to save precious
time when creating artwork.

Add Arrowheads

Y ou're creating a diagram and you need to create an arrow to point something out in the
illustration. No problem. Just draw aline and use the Add Arrowheads filter. Y ou can apply one
of 27 different styles at the beginning, the end, or both ends of the line. The head of the arrow is
aligned on the exact same angle as the line, so the arrow is always perfect.

Calligraphy

Looking for that old-

fashioned calligraphy \

style? Look no further.

The Calligraphy filter ‘
takes any stroked path

and makesit look asif it

were drawn with aflat-

edged nib--a calligraphy

pen. The strokeis

converted to afilled path

when you run the filter. Here's an original image (left) and the stylized image (right) after
running the Calligraphy filter.
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Drop Shadow

The Drop Shadow filter is, in my opinion, the most useless filter ever devised. The result of
running the filter is ssmply aduplicate of your object offset from the original. First of all, it's
ugly, and second of al, it can be created in afraction of the time by simply (Option-dragging)
the shape (copying it) and then pressing (Command-Shift-[) (send to back).

Path Pattern

Path Patterns are way-cool because instead of having just an ordinary rule or even a dotted line
as your border, you can create virtually any artwork to follow a path. Any pattern that you define
within Illustrator can be used as a Path Pattern (refer to Hour 6, "Drawing Bézier Paths," for
details on defining a pattern).

To apply a Path Pattern, select an object and choose Stylize > Path Pattern from the Filter menu.
Then choose your settings, click OK, and voilal

Tile Size .
h§ z Z Width: |10 pt @4
Sides Outer Inner Height: |4.8 pt

Spacing: |0 pt

Random circles ir

Rope.side e Tile Fitting

Scales @ Stretch to fit
SolidStar.side () Add space to fit
Stars () Approximate path
Stripes

TriBevel.outer Tile Position

TriBevel.side
Waves-scroll

| u
==
=

[ Flip Horizontally |54

Laliil

[ Flip Dertically i

After a Path Pattern is applied, it isno longer a stroke or a pattern. It's actual art that you can edit
or color as you want (see Figure 18.5).
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Figure 18.5

The stroke before and after the "Rope” Path Pattern is applied.

Round Corners

The Round Cornersfilter didn't appear to be useful to me at first. | mean, if | wanted rounded
corners, | would use the Rounded Corner Rectangle tool, right? Then | realized you could apply
the Round Corner filter to any shape. Sometimes the Round Cornersfilter can be areal time-

saver.

PHOTOSHOP-COMPATIBLE FILTERS

[llustrator ships with many Photoshop-compatible filters, which you can use on any raster image.
Refer to Hour 16, "Working with Raster Images,” for more information concerning applying
these filters.

SUMMARY

Today we learned about some pretty cool filtersthat can help usin our everyday designs, such as
the Add Arrowheads filter and the Round Cornersfilter. We learned all about the Ink Pen filter
and how it can help us make fills that look more natural, and we also covered Path Patterns,
which allow usto be virtually limitless when it comes to creating complex borders.
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CHARTSAND GRAPHS

NOTE: Due to technical difficulties, HOUR 19 is missing.
To fill the gap, here's a quick tutorial on making GEARS.

1. Select the Star tool and
click inside anew Illustrator
document. In the Star Options
box that appears, use the
following settings. Radiusl=1,
Radius2=.25, Points=12.

2. Select the Circle tool and
draw acircle in the middle of
the star so that the outer edge of
the circle goes dlightly past the
inside points of the star. Select
both objects using the Shift key
and then select Pathfinder >
Unite in the Object menu.

3. Now draw alargecircle

around the star with no fill color
and a 1-pt. stroke. Then draw a
smaller circle at the point where
you want to clip the edges of
the star. Select both objects
again and select Pathfinder >
Minus Front in the Object
menu. The two outlined circles
will now become one object

(like a donut).
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4. Select both objects now and then Object >
Pathfinder > Minus Front. Thiswill get rid of
your points on the star.

5. Now draw a small white circle in the middle of
the gear. Select both objects and then Object >
Pathfinder > Minus Front. Now your gear is one
object and it can be imported into Photoshop or

a 3D program for additional work.

6. If youwould liketo keep going in Illustrator,
then here are afew other things that you can do.
Click on the gear and hit Command+C (copy),
then Command+F (paste on top). Then use your
arrow keysto move the top gear dlightly up and to
the left. Now go to the Swatches palette and select
the pre-made gradient that looks like metal. Click
on the Gradient Options pal ette and make sure
that it isalinear gradient at a-45 degree angle.

7. 1f you would like another gear, select both parts
of the gear and copy. Now paste that copy into
your document and move it to where the teeth mix.
Click on the top gear of the new gear and change
the gradient angle to -135 in the gradients pal ette.
We will stop here, but there are hundreds of other
things that you can do from here. Illustrator is
only limited by your imagination.
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SAVING/EXPORTING FILES

Without a doubt, the most important thing about a computer illustration is the ability to open it
and edit it again and again. Compatibility with other software isimportant aswell. Y ou need to
have the ability to bring your artwork into other applications, such as a page layout program.
[llustrator does all of this, and more. With version 7, lllustrator is now completely cross
platform, working identically in both Mac OS and Windows environments.

We al know how important it is to share, and this hour we focus on things such as:

* Saving Illustrator documents
* Exporting in PDF format
* Exporting in cross-platform formats

SAVING IN ILLUSTRATOR FORMATS

When you save afile, you can choose between three different format options: Illustrator,
[llustrator EPS, and Acrobat PDF. Each of these can be opened directly in any version of
[lustrator and will retain the most information for future editing.

Native | llustrator

If your work will be done completely in Illustrator, then saving it in Illustrator format is best.
The file will take up the smallest amount of disk space, it will open and save the fastest, and it
will aways be fully editable.

To saveafilein Illustrator format, choose m
Save As... from the File menu. After giving NeLw %N
your file aname and clicking the Save

button, you are presented with a dialog box Open... #0
where you can specify what version of

Illustrator you want your file saved in. This Close &1
isfor compatibility purposes, and you should : 30!
keep your filein Illustrator 7 format if Saue As... ; SRS
possible. Save a Copy... “CIS
NOTE: Keeping your filein lllustrator 7 Revert

format ensures that any features specific to

version 7 remain intact in your file. The Plara

capability to include URLsin an Illustrator

file, for example, isonly availablein version 7. If you were to save your filein version 6 format,
any URL information in your file would be lost (more on URLs in Illustrator in Hour 23, "Web
Graphics").
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[llustrator EPS

If you need to open your file in other programs, then you want to use the Illlustrator EPS format.
EPS (Encapsul ated PostScript) isawidely supported format. PostScript is a printer language
created by Adobe that is built into many of today's printers and imagesetters. In order to print an
EPSfile, you must have a PostScript printer or a PostScript interpreter.

If you're not sure whether you have a PostScript printer, look for the Adobe PostScript |ogo.

Because PostScript must be licensed from Adobe, PostScript
printers tend to be more expensive than those without PostScript.

If you paid under $500 for your printer, it probably is not
PostScript. Y ou can use a PostScript interpreter, which is software
that runs on your computer and that enables you to print PostScript
filesto a non-PostScript printer, but they tend to be very slow. ;
Two such programs are GCI StyleScript and Freedom of Press. POSTSCRIPT
Because an EPS file will be brought into other programs, you can choose to have a preview file
embedded into the EPS. When you place the EPS into another program, the low-resolution
preview enables you see how the file will look.

To saveyour filein lllustrator EPS format, choose Save As... from the File menu and name your
file. From the Format pop-up menu, choose Illustrator EPS and click the Save button. Illustrator
then presents you with the EPS Format dialog box. Here you can ensure compatibility with
previous versions of Illustrator and choose to enclose placed images or fonts within the EPSfile,
aswell as specify previews for viewing on either IBM PC or Macintosh.

EP% Format

Compatibility Preview
1.8/1.1 {4.8 ® 7.0 {J) None
{88 {)5.8/5.5 {2 1-bit IBM PC
{)3.8/3.2 (6.8 {) 8-bit IBM PC

{J 1-bit Macintosh
Options {#® B-bit Macintosh
[ ] Include Placed Files
[%] Include Document Thumbnails
[ ]Use Japanese File Format

[] Include Document Fonts
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Acrobat PDF

The PDF format (Portable Document File) was developed by Adobe so that you can view
documents, in their correct form, on any platform. Using the Adobe Acrobat Reader, you can
view a PDF file on DOS, Macintosh, Windows, or UNIX. Because PDF uses PostScript
technology asits base, you can open and edit a PDF file directly in Illustrator as well.

PDF files are good in severa instances. If you're showing artwork to a client and they have a
different system than you, all they need is Acrobat Reader to view it. PDF files can also be
viewed on the World Wide Web with a Netscape Navigator plug-in called PDFViewer. Both
Acrobat Reader and PDFViewer are free and available at http://www.adobe.com. PDF files can
also be combined into multipage documents that can aid in making presentations.

To saveyour filein PDF format,
Y Save this document as:

choose Save As... from the File

menu and name your file. From Kall’s Art
Acrobat PDF

the Format pop-up menu, choose
i F t:
Acrobat PDF, and click the Save orma vf lllustrator

' ) | Hlustrator EP%
button. If the PDF file will be .
viewed on a Windows or DOS
machine, make sure you include the file extension of .PDF in the name (FILENAME.PDF).

EXPORTING TO OTHER FILE FORMATS

Aswe mentioned earlier, Illustrator can export filesin many different formats. Some are for
placement in other illustration or paint programs, others are for high-end proprietary systems,
and still others are for use on the World Wide Web. Some are vector formats, some are bitmap,
and some, like EPS, can support both within the same file. Each format has its strengths and its
weaknesses, which are discussed in this hour.

To export afileto any of these formats, Arniga IFF . VAORDY |
choose Export... from the File menu and TR e ‘ i
choose afile format from the Format = oA JPEG E :
pop-up menu. (55 MORD ey Peshtng
i) = :
Based on what platform you have, all Friotoshop 4 e i
of the formats listed here may not be Bport| ;':;r [ Cancel |
availableto you. There are o file Kati's Ad  Targa ) o=
export formats that are available as plug- e R
insfor Illustrator that are not listed here. WaordPerfect

Some are on the lllustrator CD, and
others may be released on Adobe's web
site (such as a FreeHand plug-in that enables you to open FreeHand documents in Illustrator).
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TIFF

The TIFF format (Tag Image File Format) is araster format that is supported both on the
Macintosh platform and on the Windows platform. The TIFF format is widely supported and can
be used in just about any page layout and paint program. Its format also has an option to use the
LZW compression scheme, which makes for smaller file sizes without compromising detail.

When you choose to export your file =———"TIFF Options

asaTIFF, lllustrator presents you

with the TIFF Options dialog box. Color Model:

Here you can choose a resolution for Resolution: | .
your image as well as select a color O Screen CeavicHln
model (RGB, CMYK, or Grayscale). O Medium

If your imageisintended to be @® High

viewed onscreen, select the Anti- O Other dpi

Aliasoption_to ensur(_-:-the_re areno Nt Hias

jaggy edges in your final image. You Embed ICC Profile

can also choose to include an ICC []LZW Compression

Profile (for color management) or

. . . Byte Order:
LZW Compression. Finaly, specify a O BMEL
byte order for the platform the file ® Macintosh

will be used on.

GIF89a, JPEG, PNG

The GIF89a, JPEG, and PNG formats are primarily used for files that will be viewed on the
World Wide Web. All raster formats, these formats specialize in compressing information, which
makes for small file sizes that can be transmitted quickly over modem phone connections. For
more details on these formats, see Hour 23, "Web Graphics.”

PCX

The PCX format is a bitmap that supports up to 24-bit color. It is primarily used on Windows
machines and is actually the native format of PC Paintbrush--a paint program popular on the
Windows platform. Upon exporting a PCX file, lllustrator prompts you with a dialog box where
you can specify what resolution the file should be.

WMF

The Windows Metafile Format (WMF) is avector file format for the Windows platform. It is
supported by most Windows applications and does not require a PostScript printer to print. The
quality of the image is questionable, though, and may not be desirable in al situations. It is best
to run atest before using it on any particular image.
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BMP

BMP means bitmap (literally--"bitmap image" means the same thing as "raster image") and isa
standard format on Windows and DOS platforms. Besides prompting you to specify what
resolution you want the image to be, Illustrator also prompts you with the BMP Options dialog
box, where you can indicate Windows or OS/2 compatibility as well as bit depth and
compression.

AmigalFF, TARGA, Pixar, PixelPaint

AmigalFF, TGA (Targa), and Pixar are formats specific to proprietary graphics systems.
PixelPaint isaMac OS paint program. Whether it's 3D, animation, or full motion video,
[llustrator has the capability to export to these programs, giving you the ability to create complex
and exact elements in a comfortable environment before bringing them into high-end graphic
systems for processing and enhancement.

SUMMARY

[llustrator is not an island. We learned how important it is to be compatible and cross platform.
We also learned about awhole lot of file formats and that each one has its strengths and
weaknesses. Now we can use Illustrator together with other programs such as QuarkX Press and
Photoshop, giving us unlimited creative capabilitiesin our quest for the ultimate design. You
should be fairly comfortable with Illustrator by now as we begin the final stretch--just afew
more hours. Hang in there! Y ou're doing great!

Term Review

* EPS -- Encapsulated PostScript. A standard cross-platform image format based on the
PostScript printer language. An EPS can contain vector images, pixel images, or both.

* PDF -- Portable Document File. Created by Adobe, this format was created to become a
standard file format that could be viewed on any computer.

* Acrobat Reader -- The application necessary to view PDF files.

* TIFF -- Tagged Image File Format. A compression-capable format that is a standard on both
Macs and PCs. A TIFF isaraster file.
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WORKING SMART IN ILLUSTRATOR

We aready know that there are several different waysto get any particular project done. To
build a house, for example, you could use wood or bricks. Either way, you'll have a house, but
one might be better than the other. The same applies to computer files--especially Illustrator
documents. There might be several waysto "build" your document, but there is aways a smart
way, and a not-so-smart way. This hour guides you in the right direction when creating your
artwork in Illustrator. A great computer designer knows not only good design techniques but
good production techniques as well, such as:

* Saving files

* Creating "clean"” files

* Tracing images

* Managing placed images

SAVING YOUR FILES

If | told you that if you ate alarge cheese pizza every day, you would live along life, you would
doit, right? And if | told you that by saving your files frequently, you can be assured that you
will not lose data, you would do that too, right?

Saving your filesis the most important part of working with computers. A computer will crash
when you least expect it to (and it most certainly will crash when you expect it to), so save often.
Y ou might also want to use the Save As command to save documents as you create them,
allowing you the luxury of quickly going back to any stage of your project asit was developed.

Y ou can name each file with version numbers, such as Pizza 1.1, Pizza 1.2, and so on, so you can
quickly identify when each file was created.

Use Intelligent Filenames

Naming your file is more important than most people think. It's very important that you keep
your files organized and that you name them so that you can quickly identify what each fileis.
On the Macintosh you were always able to create long filenames, and now you can in Windows
95, too. Take advantage of it. | remember when | used to name files "Bob's thingy" and "L ogo
with blue type." That's nice for being creative and al, but in two months when Bob needs his
advertisement reprinted, you won't in amillion years remember that you called it "thingy."

Also, if you're working in an environment with other designers and share your files with them,
it's even more important to name your files so that other people can quickly identify and find
them. If you have several versions of alogo, for example, you can name them like this: Apple
Logo.B&W, Apple Logo.Process, and Apple Logo.Spot. Also, when you finish ajob, you might
even want to identify it like so: Apple Stationery.Final.
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Working with Selections

[llustrator has afew tricks up its sleeve when it comes to making selections. Under the Edit menu
thereis a Select submenu that contains a few additional commands for making selections. Click
an object, for example, and choose Select Same Fill. lllustrator then selects all objects in your
document that have the same fill as the one you originally selected. The same applies for Select
Same Stroke as well.

For even more selection tools, see Extensis VectorTools and ILLOM Toolkit in the "Using Third
Party Plug-ins' section, later in this chapter.

Hiding and L ocking

We learned that you can hide and lock artwork to make things easier when working on portions
of your artwork, but this feature has one small problem. Although you can hide and lock items
one at atime, you can only show or unlock all items at once. This meansif you want to unlock
just oneitem, you have to unlock everything, then select the items you want to remain locked,
and lock them again.

To make things a bit easier, if you want to unlock just one item, unlock everything, then Shift-
click the item you want to unlock and then select ObjectLock again. This saves you the time of
having to reselect everything again.

KEEPING YOUR DOCUMENTSCLEAN

You'll never find amess on my computer. What you will find is an organized group of files.
Even more importantly, each filein itself is"clean" and streamlined.

Allow me to explain. When you create afile, edit it, make revisions, and make revisions again,
the file could contain many things that are not necessary in the final version. There may, for
example, be times when you would leave some text loose in the document, such as notes for
yourself or maybe a company's address. Or maybe you created alot of guides. By deleting these
after afileis complete, you are not only making the file smaller in size (saving precious disk
space), but you are also creating a cleaner file that will print faster and have less of a chance of
becoming corrupt.

Cleaning Up Individual Paths

Another important part of cleaning your filesis deleting unnecessary anchor points. Many times,
when you use the Autotrace tool (or even when importing files from Streamline), your Bézier
paths contain extraneous anchor points. Of course, the more points there are in a document, the
larger the file size, and the longer it takes to print.
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Unfortunately, thisis one thing in Illustrator that really needs some attention. Macromedia
FreeHand has a simplify function that automatically removes points and smooths a selected path,
and it would be anice feature if Illustrator did this as well. Some people have FreeHand just for
this purpose--they import the art into FreeHand to simplify it, and then bring it back into
[llustrator to add the finishing touches.

One thing that Illustrator does have is a command called Cleanup, which can be found by
selecting Object > Path > Cleanup.

This handy little janitorial function =——— Cleanup

will gladly delete stray points )

(single anchor points with no EE:E:E ztrﬂu_ Ft"'gt;h_ .
paths), unpainted objects, and DEIEtE E"”T"TE : PJ':: >
empty text paths. sesii AL Bl il

Scanning and Tracing Art

Not everything is created in Illustrator (although I'm sure Adobe would just love for that to
happen), and many times we must scan logos and art sketches and then recreate them in
[llustrator. True, there is the Autotrace tool, and even applications such as Streamline that were
made to do this kind of thing, but more often than not, they produce less than desirable results.
The best way to get logos and sketches into clean, good-looking vector art isto draw them from
scratch yourself.

Relax, it'salot easier than you might think. Illustrator has the tools to get you through. Let's take
this one step at atime, shall we?

1. Scan your logo. Y ou should scan your image at 72 dpi (we'll only be viewing it onscreen) and
try to get it aslarge as possible without blowing out too much detail.

2. In Photoshop, or your favorite raster paint program, use the Levels feature to tint back or
lighten your image so that it's only at 30 percent strength.

3. Saveitin TIFF format. A TIFF does not use a preview for screen viewing but uses the actual
file so that you get better detail when viewing it in lllustrator--especially when you zoom in close
onit.

4. Open anew document in Illustrator.

5. Create anew layer and name it "template.”

6. Place the scanned logo you just saved on = E]
the template layer and lock the layer. | Layers ™| Swatches 4

. W % | Termplate '& i
7. Create anew layer and name it "artwork." I
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8. We can now begin to trace the logo. The first step isto draw guides, which will help you as

you recreate the logo. Remember that you can turn any shape into a guide, so you can use circles
or other shapesif necessary.
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9. Next, try to see if you can recreate parts of the logo using simple shapes, the Rectangle and
Ellipse tools, and the Pathfinder filters.

10. Finally, complete the rest of the logo using the Pen tool where necessary, and add any
necessary fills and colors.

USING THIRD-PARTY PLUG-INS

[llustrator 7 has tremendous support for plug-ins--additions or extensions to Illustrator that add
features, tools, and functionality. In fact, many parts of Illustrator are actually plug-ins
themselves, such asthe Layers palette. Adobe did this to make it easy to make modifications to
the program and to keep Illustrator's core as clean as possible.

Of course, the most obvious advantage of the ability to have plug-insis that other companies (or
even ordinary people like yourself) can create plug-ins for Illustrator. Here | have listed plug-in
packages from severa vendors and have written short descriptions outlining their features.
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Extensis Vector Tools

Extensis VectorTools is probably the best collection of plug-ins on the market. A perfect mix of
production-oriented and special effects plug-ins, VectorToolsis a collection no serious illustrator
should be without. VectorTools includes a magic wand selection tool for selecting multiple
objects with similar attributes, and it also gives you the ability to edit colors using curves, just as
in Photoshop. You can aso turn 2D art into 3D art, set up object style sheets, and more!

Extensis Corporation -- http://www.extensis.com

MetaCreations KPT Vector Effects

KPT Vector Effectsis part of the famous Kai's Power Tools suite of plug-ins and applications.
Although itsinterface is just atad different, KPT Vector Effects offers quick waysto create cool
effectsin Illustrator, including embossing, soft shadows, 3D, envelope distortion, and more.

MetaCreations -- http://www.metacreations.com

HotDoor CADtools

CADtoolsisagreat collection of over 34 drafting and dimensioning plug-ins. Even if you don't
do drafting work, these plug-ins can really be useful. A good exampleisthe Arc Tool, which
enables you to draw arcs easily--alot better than drawing whole circles and then deleting the
parts you don't need.

Hot Door, Inc. -- http://www.hotdoor.com

M APublisher

If you are a cartographer or work alot with maps, MAPublisher isfor you. A suite of plug-ins,
MAPublisher enables you to work with Geographic Information System (GIS) data directly in
[llustrator. It also offers support for DXF files.

Avenza Software -- http://www.avenza.com

Vertigo 3D Words

Vertigo is acompany that makes 3D tools for use on powerful Silicon Graphics workstations.
Recently, they began making plug-ins for use on Power Macintosh computers with Photoshop
and Illustrator. 3D Words enables you to create true three-dimensional text and paths right in
[lustrator.

Vertigo Software -- http://www.vertigo3d.com
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ILLOM Toolbox 1

Toolbox 1 isawonderful collection of plug-ins that add some really great (and really cool)
featuresto Illustrator. First of all, aLasso tool |ets you marquee select objects by drawing a path-
-just as in Photoshop. There's also search and replace for objects (so you can search for red stars
and change them to yellow circles, for example) and text style sheets. Plug-ins for time tracking
and enhanced transformations round out this excellent package.

ILLOM Development AB -- http://www.illom.se

PREPARING A FILE FOR OUTPUT

If you are sending your file out to a service bureau for film output or separations, you want to
make sure that it prints right--the first time. Keeping your files clean, as mentioned earlier, isthe
first step in your quest for perfect film. Streamlining your files allows them to print faster (some
service bureaus charge for processor time) and more reliably. Messy files have atendency to
crash or hang a RIP, the software that interprets files so they can be output on an imagesetter.

Include Typefaces and Linked I mages

In order for anyone to print your file, they will need whatever typefaces you used as well as
copies of any linked (placed) images. In many cases, you can avoid the typeface problem by
converting your text to outlines. In fact, it's usually a good idea to convert your text to outlines
whenever saving logos or mastheads that will be used repeatedly--you might forget about the
typeface, thinking it's just a picture, when working in QuarkXPress or PageM aker.

To quickly check which fonts and linked images are in a particular file, choose Document Info
from the File menu. Here Illustrator gives you an exhaustive list of your file's details and
attributes, including linked and embedded images, as well as fonts used. Y ou can save this
information as atext file that you can then send to your service bureau. This might help them
work on your file faster and more efficiently.

Convert Strokesto Paths

Thisis an important precaution. As you know, when scaling objectsin Illustrator, you have the
option to scale strokes as well as the rest of the object. If your art or logo has strokes of a specific
weight, and then somebody scales the image without scaling the strokes, you might have a slight
problem on your hands. By using the Convert Stroke to Path function, you eliminate the
possibility of such anightmare.

Blends and the Ink Pen Filter

There are two featuresin Illustrator that can really add a special touch to your document: blends
and Ink Pen fills. These are aso the two featuresin Illustrator that cause the most printing
problems.
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Both the Blend tool and the Ink Pen filter create hundreds of objects to achieve their unique
appearance, which can really tax even the latest RIPs. When using the Blend tool, you have an
option to specify how many steps the blend should be. If you are creating a small blend that only
covers a short distance, 40 objects may be sufficient, and very rarely will you need to create a
blend with 255 objects (which is the default setting). Asfor the Ink Pen filter, use it on smaller
objectsif possible, or try to avoid using it excessively.

Working with Linked I mages

We aready know that you can place araster image in Illustrator and have it linked to afile
outside of your Illustrator document. If you've worked in QuarkXPress or PageM aker, you
should already be familiar with this concept. Y ou should also be familiar with the ability to
update your linked images to reflect changes made to them after they're placed in an Illustrator
file--a command missing from Illustrator. But fret not my dear friend; I'll tell you how to do it.
There are two workarounds you can use to update linked images in Illustrator:

1. After you've updated and saved your raster image in your favorite raster application (such as
Photoshop), return to your Illustrator document. Then, select the placed image you want to
update. Choose Place from the File menu and choose the file you just updated. After clicking the
Place button, Illustrator asks you if you want to replace the currently selected image. Choose

Y es, and Illustrator replaces the old image with the updated one. Any transformations you had
previously applied to that image such as scaling or rotating will be applied to the new image as
well! (NOTE: Thisonly worksif the new image is till the same file format as before, such as
TIFF or EPS))

2. After you've updated your raster image in your favorite raster application (such as Photoshop),
save it with the exact same name. Then return to Illustrator. Save and close your document, and
then reopen it. Y our images are then updated automatically.

SUMMARY

This hour we learned a whole lot of tips and techniques on how to be more efficient when
working with Illustrator files. We learned how important it isto save fileswith easily
recognizable names, and we learned how clean files can save us alot of aggravation. Pluswe
learned all about somereally cool plug-ins available for Illustrator, as well as how to re-create
scanned art. After this chapter, you have what it takes to add the title "production artist" to your
business card.

Term Review

* Plug-in -- An extension or function that is added externally to the program.

* RIP -- Raster Image Processor. Software and/or hardware that bridges between a computer and
an imagesetter.

* Stray Point -- A single anchor point that stands alone, with no path associated with it.
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PRINTING

OK, you designed this beautiful piece of art, and now it's time to print it. Then you can show it to
your mother who will be very proud of you and hang it on the refrigerator door (although she
still doesn't know what exactly it is that you do).

Printing is an important part of the design process. If what you are designing will be used in
print, it isagood ideato see how it looks on paper as opposed to onscreen. Sometimes it's
difficult to visualize your art onscreen, and you can get a better grasp of it when viewed on
paper. Thisis especially true with type. It might look okay at 12 point onscreen, but when you
print it out on paper, you will realize that 11 or even 10 point would be much better. These subtle
things often cannot be picked up onscreen. This chapter discusses:

* Printing your files

* Producing color separations
* The PostScript language

* Troubleshooting tips

Printing Files
One of the most basic functions of your computer is the Print command, and it works the same

way in lllustrator asit would in just about any other program. To print a document, choose
Print... from the File menu, or press (Command-P).

Document Setup/Page Setup

Way back in Hour 2, "Customizing Illustrator,” we discussed the different settingsin the
Document Setup dialog box. Thereis also a Page Setup dialog box specific to your printer and
print driver software. This dialog box is accessible through the Document Setup dialog box.

First, choose Document Setup from the File menu. Notice
on the far right of the dialog box, under the Cancel button,
is a button to open the Page Setup dialog box. Y our Page
Setup dialog box contains settings for what paper tray to | 0K |
use and what orientation the page should print (portrait or

landscape--tall or wide). Page Setup is llustrator's direct [ Cancel ]
link to your printer, so the dialog box will be different
based upon which printer drivers you are using
(Laserwriter 7, Laserwriter 8, and so on), and the options [ Page Setup... ]
available will also depend on what printer you are using.
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Tiling with the Page T ool

Not everything can fit on an 8 1/2x11 sheet of paper. When you have artwork that is larger than
what your printer can handle, you can print the artwork in pieces and then paste the pieces
together after the entire file has printed.

To indicate which part of your file gets printed, you use the Page (¥ |
Tool (H). Once the Page tool is selected, press and hold down the

mouse button, and an outline appears. Whatever isinside the borders g\m;.
of the outline will print. The artwork in your fileis not affected in any 1 m
way; you are ssimply instructing Illustrator as to which part of your ==

document to print.

COLOR SEPARATIONS

Before color artwork can actually be printed on press--be it CMYK, spot color, or Hexachrome
(see note)--it must be separated. What that meansis each color is printed on a separate page. If,
for example, you are printing afour-color process job, you need to have four pages or plates--one
each for cyan, magenta, yellow, and black. The process of making these platesis called color
separation.
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COMPOSITE
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MAGENTA E BLACK

SEPARATIONS

NOTE: Hexachrome was devel oped by Pantone to address one of the main shortcomings of
CMYK printing: difficulty in printing bright and vibrant colors, specifically in the orange and
green areas. By adding two more colors, Orange and Green, to CMYK, amuch larger gamut
(range of colors) is attainable. Essentidly, thisresultsin a 6-color job (CMYKOG), hence the
name Hexachrome.

In most cases you send your filesto a service bureau that prints the separations for you on film
and provides you with a Matchprint (a high quality color proof, made directly from the film). But
not every job needs to go to film, and there are times when printing separations on your laser
printer are adequate. There are also times when I'll print separations to my laser printer to make
sure they print correctly. Over the years, this has saved me thousands of dollarsin potential film
Costs.

Printing Separ ations

If al of thistalk about magenta and film is making you nervous, take a deep breath, pour atall
cool one, and welll press ahead. Now let me tell you that printing separationsisreal easy in
[llustrator. There are two ways to open Illustrator's Separation Setup dialog box.
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* Choose Separation Setup... from the File menu, or
* Click the Separation Setup... button in the Print dialog box.

243
Printer: | LZR 1560 Laser w | Destination: | Printer w |

| Adobe llustratoré 7.0 - | et A

| output:| Composi..¥| Postscript&: [ Levelz w| Data:[ ginary

3

After choosing one of these, you are presented with the Illustrator Separation dialog box. Here
you can specify how the separations should appear, as well as specify which colors should be
separated, and how.

Separations on LZR 1560 Laser (LaserWriter Color 120600 PS)

General PPD Oplions

o]
Page Size: | US Letter (584x .| »| ==

Emulsian: | Dovern (Hight Re.... | -r]
Halftone: | 2001pi /600dpi || | Open PPD... |
Image: | Negative (-]

1
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Frequency: | | Angle: |_ |
Options Margins
Eepnr‘utﬁ:l Printable Layers |L| Leﬂ: Inp:

[ Use Defaull Marks Right: .
ight: Bottom: _I'.'S.i‘#
O Conuert to Process

] Dverprint Black Blewd:

| . -2
| [r— #| @
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The first step you need to do is open aPPD file. A PostScript Printer Description file contains
information about your printer such as resolution, available page sizes, and line screens.
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NOTE: Your PPD filesare located in afolder called Printer
Descriptions. Thisfolder can be found in the Extensions
folder in your System Folder.

0K
To specify a PPD file, click the Open PPD button, navigate [[=]]

to where your PPD files are and click the Open button. [ o ]
After aPPD fileisloaded, you can specify options for your

separations such as Page Size, Orientation, Emulsion,

Halftone, and Image. If you don't know what specifications [ Ooen PPD ]
you should use, consult your printer or production expert. p

Specifying Colorsto be Separated

Thisisthe most important part of separating afile: Choosing which inks will print, and how they
will separate.

In the center of the Separations dialog o (i -
. . . Flrunas flamanfa

box isalist of colorsthat are used in u

your document. A printer icon in the [ S saton

box to the |eft of a color indicates that S |l Arocens Sk =

the color will print to its own plate. E |l erown =

(In the above example, magenta and black print, but the yellow plate does not.)

To print spot colors, uncheck the Convert to Process checkbox. Otherwise, spot colors are
converted to process and separated as a process color, as indicated by a process color icon.

Positioning the Plate

Y ou can aso position the separation on

the page by grabbing the edge and E—r' kil ﬁ
moving it as shown here.

Setting Cropmarks

Cropmarks are very important. They
indicate to the printer where to trim the
paper around your artwork. If your
artwork contains bleeds (where the
artwork goes past the edge of the paper),
then crop marks are the only indication as
to where the page should end
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Follow these stepsto create accurate cropmarks:

1. Draw arectangle that exactly matches your trim size.

2. Position your artwork within the rectangle (or position the rectangle over the artwork).
3. Choose Cropmarks > Make from the Object menu

Y ou cannot move or edit cropmarks after you make them unless you select Release Cropmarks
from the Object menu. If you do not have a rectangle selected when you choose Make
Cropmarks, Illustrator draws cropmarks based on the page size.

NOTE: You'll remember that back in Hour 17, "Vector Filters,” we learned about afilter called
Create Trim Marks. Trim marks (Filter > Create > Trim Marks), however, and Cropmarks
(Object > Make > Cropmarks) are different. Trim marks are ssimply lines that Illustrator draws
for you. They are editable in that you can color them, change their thickness, and even delete
individual lines. Cropmarks on the other hand are non-editable, and you can only have one set of
Cropmarks in a single document.

PostScript

At the heart of Illustrator is the PostScript printing language. Developed by Adobe, PostScript is
probably responsible for the success of the desktop publishing industry as well as the use of
computers for graphic design services.

In order to take advantage of Illustrator's capabilities, you must use a PostScript printer. If a
printer does not have PostScript, or a PostScript interpreter, you will get undesirable results, such
as noticeable jaggy edges and the printed colors may not match what you see onscreen.

Troubleshooting:

Although we hope it never happens, there are times when afile failsto print due to an error.
Many timesit is because the document istoo complex for the printer it is being printed on, or
there is a software incompatibility. If such an event occurs, try the following tips:

* Use the Split Long Paths option, which we discussed back in Hour 2. This option can be found
in Genera Preferences.

* Use the Compatible Gradient Printing option, which we discussed in Hour 2. This option can
also be found in General Preferences.

* DoaSave As... onthefilein an earlier lllustrator format. Illustrator 7 utilizes PostScript 3.0
commands (see the previous section on PostScript), which may confuse some older printers.
Saving in an older format, such as lllustrator 6, may help.
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* |solate the culprit. Delete parts of your illustration one by one, starting with placed images
first, sending your file to the printer until it prints. Sometimes a file may become corrupt or a
particular shape may be causing a problem.

* Copy and paste your illustration into a new file. Sometimes afile may become corrupt, and the
best way to correct it isto destroy it.

SUMMARY

Things started out real easy aswe learned to print our Illustrator documents. Things got a bit
harder when we learned all about color separations and trapping issues. Asif that weren't
enough, we finished with aflair as we learned a bit about the PostScript printing language.

WEeéll, | had alot of fun, and | hope you did, too, as you learned all about Illustrator. Because the
computer field is ever-changing, visit my web site at http://www.mordy.com for the latest
information on Illustrator. And don't forget to send me email at mordy@mordy.com.

Term Review

* PostScript -- A programming language devel oped by Adobe Systems for printing and page
layout purposes.

* Separations -- The process of preparing individual color plates for printing.

* Tiling -- Splitting up alarge page into smaller parts for printing purposes.

* Cropmarks -- Marks or lines that indicate to a printer where to cut the paper.

* Hexachrome -- A six-color printing process devel oped by Pantone, Inc.
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WEB GRAPHICS

At first everyone thought it was just afad, but recently the Internet--or more specifically, the
World Wide Web--has become a part of our daily lives. Email addresses and URLs are
exchanged as often as street addresses and phone numbers. Although the Internet has been
around for quite some time, the World Wide Web turned the Internet into what it is today
because of two essential features: images and links. Illustrator brings the power of these two
features into the palm of your hand. This hour, we cover topics such as:

* Web-safe color issues

* Assigning URL s to objects

* Exporting in web-compatible formats
* Animation

* Working with Macromedia Flash

Designing for the Web

| mentioned earlier that the web offers two powerful features: images and links. Asthe old
saying goes, a picture is worth athousand words, and using images to convey your message can
be very effective. Y ou can easily create imagesin Illustrator for use on the web.

A link is something on a Web page that, when you click it, takes you to another page. A link can
be specified in your HTML document as either text or a picture (see the following NOTE). A
picture can aso have multiple links, meaning you can specify different links for different parts of
your image. Thisis called an imagemap. Illustrator can create web-ready graphics, but before we
begin making our art, we need to know afew things about the web.

NOTE: HTML documents are created in atext editor or an HTML editor application. HTML
(Hypertext Markup Language) is the standard programming language used on the World Wide
Web. If you're squeamish and don't want to get involved in "writing code," there are plenty of
WY SIWY G (What You See Is What You Get) HTML editors out there, such as Adobe PageMill
and Claris HomePage, that do all the programming for you.
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Color ontheWeb

When you design a brochure that will be printed, you have control over how the final product
appears. Y ou specify exact colors and papers to give a precise look and feel to the brochure. On
the web, however, you have very little control asto how your art appears to the different people
who view it. Some people might have a small, cheap monitor that displays only 256 colors.
Other people may have large high-resolution monitors set to millions of colors. And if that
weren't enough, different browsers such as Netscape Navigator and Microsoft Internet Explorer
have different settings, so what |ooks perfect on your screen may look completely different on
someone else's.

Dithered Colors

When you create an image on a computer with millions of colors, what happens when you view
that image on a computer that only has 256 colors? Well, the results can be horrifying at times. If
acomputer does not have a certain color in its palette, it tries to approximate the color by
arranging avariety of pixelsin the same vicinity to give the appearance of that color. This
process is called dithering. Sometimes the dithering is presentable, but usually it creates odd and
distracting patterns and can also make text unreadable.

NOTE: Dithering isalot like screening in traditional printing. When the screens are rotated just
right, you get a nice rosette, but if the screens do not line up properly, you get an ugly moiré
pattern.

Using The Web Palette

As Douglas Adams would say, "Don't Panic." There are afew things you can do to assure that
your art looks great on the web--on any machine. The first thing is to use the Web-safe color
palette. Aswe learned in Hour 9, "Coloring Objects," computer monitors use the RGB color
model. The web-safe color palette is a collection of 216 RGB colors that will not dither when
viewed onscreen.

How did they come up with a number such as 216? Well, it's like this: The majority of people
out there have monitors with 256 colors (VGA is 256 colors). These 256 colors are in what's
called the system palette, which is built into your operating system. The Windows system palette
and the Macintosh system palette, however, differ dlightly. To be exact, there are 40 colors that
do not match up between the two system palettes. So, if we eliminate those 40 colors, we are |eft
with 216 colors that are identical on both platforms.

NOTE: If you are creating artwork for an intranet, where you know the type of computers people
are using, you can take advantage of that by using more resources. If, for example, everyone who
will be viewing your art has a Macintosh, you can use the Macintosh system palette that contains
40 more colors than the web pal ette does.
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Now, if we would create artwork using only colors from these palettes, we can be sure that the
colors will not dither when viewed on the web. By now, you're wondering, "Great! Where do |
sign up?' and the answer is easy. Adobe has included system palettes for both Windows and
Macintosh as well as a color-safe web palette--all right inside Illustrator.

Simply choose Swatch Libraries from the El

Window menu and make your choice. b
The Palette opensin anew Swatches-like D R=2CC (5=5CC R=2CC B i
floating palette and is not editable (see =
Figure 23.4). If you want to edit colors, [ | r=z55 G=z55 B=204 oE-
you must drag those colors to the Swatches |:| R=2CE (5=2C5 E={53 I B

palette first, and then edit them. Notice

the little icon in the lower-left corner, [ r=255 G=z55 B=t02 mEe;
indicating the Web palette cannot be [ ] R=z55 G=z55 B=51 O E|o
edited. N ]

NOTE: Because the web and the technology that it brings are constantly changing, dealing with
every aspect of web color can take up an entire book in itself. Although many issues and
techniques are beyond the scope of this book, you might want to look into books that delve
deeper into web color, such as The PANTONE Web Color Resource Kit or Creating Killer Web
Sites, both published by Hayden Books.

Assigning URL sto Objects

We mentioned before that a single image, otherwise known as an imagemap, can contain
multiple links. Using an imagemap allows a user to follow different links, based on where he
clicksin alinked image. Before Illustrator 7, you had to create an imagemap in athird-party
application, which was usually atedious task. And if you made a change to your image, you
would have to redefine the imagemap as well. Now, with Illustrator 7, you can do it all in one
application, and in one easy step.

Y ou create an imagemap by assigning a URL (Uniform Resource Locator) to an object in your
illustration. URL is afancy word used for aweb address, and usually looks similar to this:
http://www.adobe.com. In order for you to create an imagemap, you must know the URL of the
page you are linking to.

@ T T T s s i s i [
To assign aURL to an object, open [ Attributes | b
the Attributes palette (F11). Select an
object, and type the correct URL in

the Attributes pal ette. After you enter Pr _ :
aURL, it is added to the pop-up list DI <[5 o
in the Attributes palette, so you can URL: [http: & Swwew bezier.com n
choose from alist as you create more

|:| Crverprint Fill |E| Crverprint Strake

. hitp: / Fwwow . mordy.com
links. hitp: £ fwwow bezier.com

hitp: £ Swwew ronchan.com
hitp: £ Swewew thomasbradley.com
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If you have aweb browser such as Netscape Navigator or Microsoft Internet Explorer, and an
Internet connection, you can click the Launch Browser button in the Attributes pal ette to check
your links.

WEB FILE FORMATS

Y ou must save your filein a certain file format before it can be used for the World Wide Web.
The most popular formats, GIF and JPEG, can be saved right out of Illustrator, and each has its
strengths and weaknesses. Another file format, PNG, is slowly making its way into the limelight
aswell because it offers some features not found in GIF or JPEG. Basically, all of these formats
use a compression method to make the files smaller so that they take less time to transfer over a
modem.

All files saved in these formats are converted to pixels when they are saved. Always be sure to
keep a copy of your original Illustrator filesin case you need to make changes to your images.
Also, be careful when you save your web files that you give appropriate names to your images.
Use only lowercase letters, no spaces, and use the appropriate three-letter extension for your file
(GIF, JPG, PNG) so that a browser can identify it.

The GIF89a For mat

The GIF89a format (created in 1989, hence the 89a extension) is probably the most popular file
format used for images on the web. Developed by the people at CompuServe, GIF uses alossless
compression scheme called LZW. Lossless means that no information is lost when thefileis
compressed. The GIF format is best used for images with flat color, such as logos and
illustrations.

Exportinga GIF [ ) N

1. Choose Export... from the File menu.

2. Choose GIF89afrom the pop-up menu Eniert Tals Desument fs (D} 2}
(seeillustration at right). [ e =3
e e
-
3. Giveyour file aname (don't forget the WD
.GIF extension) and click the Save button. il
FLH
Frakashap &
4. Choose your options from the GIF89a g
Options dialog box and click OK. s
1.": et

Let'stake a closer ook at some of the options presented in the GIF89a Options dialog box. First,
you can select a palette of colors to be saved with the file (see Figure 23.5). Choose either the
Web palette or the Adaptive palette to get even fewer colors. The GIF format supports any
number of colors up to 256. The fewer colorsin the palette, the smaller your file size. Y ou then
have four options: Interlace, Transparent, Anti-alias, and |magemap.
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Figure 23.5

GIF89a Options

Palette: | Adaptive - -“
Color Exact

System (Macintosh)

ancel

Ssystem (Windows)
Web
Options EEiLETRETIE

- .
11 Custom...

[ ] Anti-alias

[ ] Imagemap
(@ Client-side (.html)
3 Server-side (.map)
Anchor:

* Selecting the Interlace option enables your image to appear gradually onscreen when it appears
in abrowser window. This gives the viewer an idea of what the image looks like as it loads.

* Using Transparent makes the background of your image appear asif it were filled with
nothing, letting colors that appear behind it show through. Thisisimportant with irregularly
shaped or oval images, which would otherwise appear with awhite background.

* Anti-alias, as we mentioned earlier with the Rasterize command, smoothes out jaggy lines and
curves, making the image look better onscreen. Try to avoid using this option with small font
sizes as it tends to make the type too blurry to read.

* Finally, if you have assigned URLs in your file, you can export an imagemap along with the
GIF file. You can choose to create either a client-side imagemap or a server-side imagemap.
Client-side imagemaps are generally better and are more common in today's web sites.

The JPEG Format

The JPEG format (pronounced jay-peg) uses alossy compression scheme, meaning that
information is thrown out in order to make the file size smaller. This affects the final quality of
the image, and you are able to specify how much information is lost during compression (of
course, the more you throw out, the smaller the file becomes). JPEG is used primarily for
photographic images or complex illustrations with gradients because the JPEG format can
support 24-hit color (millions of colors).
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Exporting a JPEG [t ] I

IEEHC | 1 |
1. Choose Export... from the File menu. o ﬂ T
2. Choose JPEG from the Format pop-up menu el ar e [ Carel ]
(seeillustration at right). L | =
3. Give your file aname (don't forget the .JPG — ?}’C’?
extension) and click Save. Phasastar 4

FHE

4. Choose your options from the JPEG Options T
dialog box and press OK. R ittont

In the JPEG Options dialog box, you are able to set the image quality, which also controls the
amount of compression. By selecting a higher quality file, you are also creating alarger file. To
change the quality, simply drag the little triangle slider to the left or right or enter a number from
1-10in the box.

JPEG Options

Image Options
Ouality: |5 Medium -
-

srnaller file + Medium - file

‘ Maximum !
Format Options

{® Baseline (“Standard”)
{ ) Baseline Optimized
(> Progressive

Scans: E]

Recently, anew kind of JPEG format, called progressive JPEG, has begun to spread and is
supported by the latest versions of popular web browsers. A progressive JPEG is essentially the
same as an interlaced GIF, where the file loads gradually, enabling the viewer to get an idea of
what the imageis asit loads. | have even found that progressive JPEGs are usually afew K
smaller than a Baseline (standard) JPEG.
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The PNG Format

The PNG format (pronounced "ping") was initially created to address the shortcomings of the
GIF format. Using a completely new compression algorithm, it avoids any legal problems
concerning the LZW compression scheme (see the following Just a Minute). PNG also supports
24-bit color, aswell as the use of alpha channels for masking. The format, however, is new on
the scene, and is supported in very few browsers.

NOTE: The GIF format utilizes the LZW compression scheme that was devel oped by Unisys
Corporation. A few years ago, after along legal battle, Unisys began to charge software
developers aroyalty feeif they created software that implemented the LZW compression

algorithm (end users are not charged, only developers). The PNG format was developed as an
aternative to the GIF format, to avoid having to pay royalty feesto Unisys.

Exporting a PNG

1. Choose Export... from the File menu.

2. Choose PNG from the Format pop-up menu.

3. Giveyour file aname (don't forget the .PNG extension) and click Save.

4. Choose aresolution from the Resolution Options dialog box and press OK. Because your art
will be viewed on the web, 72 dpi isfine.

Resolution Options =—— =—— PNG Options

Resolution: — Interlace
# Screen D Mone
{2 Medium @ Adam? [m]

(3 High

O Other dpi —Filter —————
{7 None
) Sub
5. Choose your options from the PNG © Up
Options dialog box and press OK. (2 Average
i Paeth
PNG's interlacing schemeis called Adam?, @ Adaptive

or you can choose to have no interlacing.
Y ou can aso choose from severa filters,
which are different compression methods.
The Adaptive method is most effective for
web images.
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MAKING ANIMATIONS

[llustrator's Blend tool can help you create great-looking animations for the web. The GIF89afile
format supports multiple imagesin asingle file, enabling animation. Almost all of today's web
browsers support Gl F89a animation.

Basically, an animation is a string of images or frames, where each frame is different than the
next. When viewed one after the other, the image appears to move. Y ou can use lllustrator's
Blend tool to help create the different frames.

1. Create two objects--oneis the object in its original state, the other in the state you eventually
want it to be.

2. Select both objects.

ol
k)

3. Choose the Blend tool (B) from the Toolbox. <§>

4. Click one point from the first object.

6. Specify the number of steps Illustrator should create (this is the number of frames).
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Y ou can then tweak each object individually. In order to create the actual animation file, you
need to export each frame as a separate GIF file, and then combine them in a third-party
animation program such as GifBuilder.

\_J ~ — /N M

DN
NS
After the blend is performed (the mouths), you can tweak and edit each object (the faces).

The Blend tool can also be used to create airbrush effects by creating more steps. Experiment
with blending small, light-colored objects within larger, dark-colored objects to create highlights
and shadows. Keep in mind that blends can create alot of shapes that make for slower print
times and larger file sizes. For more information on using the Blend tool, see Hour 21, "Working
Smart in Illustrator.”

WORKING WITH FLASH

This last section is for the lucky ones that own Macromedia's Flash. With the Release to Layers
command and expanded SWF export options, it's easy to construct dynamic Flash animations
from layersin lllustrator. Y ou can automatically generate layers consisting of objects that build
up cumulatively and then export the layers to SWF frames. Follow this exercise to see how you
can create animated text that builds itself up character by character.

1. Createaline of text
Open anew Illustrator artwork window in RGB color mode. Select atype tool in the toolbox,

and click in your artwork to set atype insertion point. Enter the desired characters on the
keyboard.

[llustrator contains type tools for

entering both horizontal and vertical
text. Y ou can change type attributes, ] i
such as font, size, and spacing, by ul [
choosing Type > Character and ' 4
setting options in the Character E;
pal ette.

L

1
0
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2. Convert thetypeto graphic objects.

Use the selection tool to select the type you just created, and choose Type > Create Outlines. The
Create Outlines command converts type characters to graphic objects. Converting type to graphic
objects gives you the freedom to apply Illustrator's full array of filters and editing features.

Here, we have converted the type so
that we can apply the Free Distort
filter and later the Release to Layers
command.

3. Distort the shape of the characters.

With all the type characters selected, and choose Filter > Distort > Free Distort. Drag the
bounding box handles to change the shape of the type as desired, and click OK.

Free Distort |

i_ance| l
.......... Reset
[ Freview

Notice that the distortion applies to the characters as they appear on each layer.

4. Release the type charactersto separate layers

In the Layers palette, select the group containing the type characters. Press Shift, and choose
Release to Layers from the Layers palette menu (see Figure 23.18).
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Figure 23.18

| Layers ™,

When you hold down —
Shift in conjunction with
the Release to Layers
command, objects on the
selected layer are placed
cumulatively on separate
layers. In our example,
the character "1" is
released to the first
layer, "1 2" to the
second layer, and so on.
This cumulative
behavior is especially
useful for preparing
animations of objects |% =
1

= |2 q.‘“ Layer 1 oo

; *'r{ Layer 2 L |

Vi

o T
i '
1

Layer 2 oo

:.L Layer 4 O

‘@1‘@1‘@1‘@1‘@1‘@
| | | | |

= = = = =
it
—
T
=
L
2
O

that build up step by
step, asif being painted
or written.

Layer

5. Export thefileto SWF format

Choose File > Export..., choose Flash (SWF) for the format, and click Export. In the Flash
Format Options dialog box, for Export As, choose Al Layersto SWF Frames, and click OK.

When exporting to SWF format, you can choose between exporting the entire fileto asingle
SWE file, exporting layersin the file to SWF frames, or exporting layersin the file to separate
SWEF files. Because we are building an animation, we have chosen to export the layersto
separate SWF frames.

6. Import thefileinto Macromedia Flash

Drag and drop the SWF file into your browser for viewing, or import into Flash for further
editing.

SUMMARY

This hour you became a techie web-head! We learned all about using "safe" colors when
designing for the web to prevent dithering. We also learned how to create imagemaps by
assigning URLsto objectsright in lllustrator. And if that weren't technical enough, we learned
how to make our images web-ready by saving them in avariety of web-compatible formats.
Heck, we even covered animation!
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We're getting ready to wrap things up next hour when we learn how to print stuff and make color
separations, so get ready for the home stretch!

Term Review

*magemap -- A list of coordinates that, when referenced to a graphic image, enable the user to
follow different links, depending on where they click on the image.

* Interlacing -- The process of loading an image gradually, increasing in resolution and detail as
it appearsin the browser.

* Adaptive Color Palette -- A table of a specific number of colors that are derived from the best
possible match in an image.

* Web Color Palette -- A table of 216 specific colors that can be reliably used in any browser and
on any platform.

* GIF, JPEG, PNG -- Image file formats that are universally accepted on the Internet and World
Wide Web.
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CROSS-PLATFORM ISSUES

Aswe begin the last chapter of this book, it'simportant to remember that the beauty of working
with a computer is that anything that you create can be worked on not only on your machine but
others as well. Whether it be a co-worker, a client, a service bureau, or even just moving files
between your office and computer at home, it's a good idea that you become familiar with
moving your files around. As we mentioned before, Illustrator is cross-platform. This means the
program works the same way on both Macintosh and Windows computers, and, more
importantly, it means you can open the same file on either platform as well.

This sounds really nice on paper, but it's important to remember that it doesn't always work like
that in real life. There are several important issues that you should keep in mind when working
with files that will be used on both Macintosh and Windows platforms. Throughout the next
hour, we explore these issues, including:

* Naming files

* Fonts

* Drag and drop

* Color management

Naming and Saving Files

Be careful when naming your files. The Mac OS supports filenames of up to 32 characters, as
does Windows 95, but Windows 3.1 and DOS support only 12 charactersin the form
1:9.9.9.0.0.0.0.9.00.6

If you are saving afile on a Macintosh for use on a PC, name the file with the appropriate file
extension preceded by aperiod (.EPS, .TIF, .GIF, .JPG, and so on). If your file will be opened in
[lustrator for Windows, save it with the lllustrator extension ("FILENAME.AI™), or Illustrator
will not open the file. (Although Macintosh can tell the kind of file from the file resource type,
Windows relies on the three-letter extension to identify the file type.)

If you are copying your file onto adisk or aremovable media cartridge, such asazip disk, be
sure the disk is formatted for the computer it will be used on. Although support for PC disksis
built-in to the Mac OS, you need a special utility to mount Macintosh disks on a Windows
machine.

Patter ns and Gradients

Expand your gradients and patterns where possible (we learned how to do this using the Expand
command in Hour 10, "Fills"). Thisisjust a precaution you can take to ensure the integrity of
your gradients or patternsin afile.
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Thisis especialy important when transferring files to a computer that uses an older version of
[llustrator than what you are currently using. Patterns and Gradients as we know them now did
not exist in versions prior to version 5 on the Macintosh and 4.1 on Windows.

Drag and Drop

Drag and drop is afeature in today's operating systems that greatly increases productivity.
Instead of having to copy and paste something from one application to another, you can simply
drag your selection right into another application window. If, for example, you are working in
[llustrator, and want to bring some artwork into Photoshop, you can simply drag the object from
the Illustrator window right into the Photoshop window.

Of course, in order to take advantage of these drag and drop features, you must have enough
RAM in your computer to run both Illustrator and Photoshop simultaneously (or any other
programs that you want to drag objects into or from).

Y ou can drag a bitmap image from Photoshop 4 into Illustrator, but it will be converted to a 72
dpi RGB image regardless of what the settings were for that file in Photoshop.

When dragging selected Illustrator objects into Photoshop 4, you can hold down the Shift key to
place the object in the center of the active layer, and you can also hold down the (Command) key
to have the lllustrator art placed as paths in Photoshop (for use as clipping paths and selections).

Y ou can also drag objects directly to your desktop. On a Macintosh this creates a clipping file
(PICT), and in Windows this creates a scrap file (WMF).

Font Issues

There are two leading font technologies out in the world of publishing: TrueType and Postscript
Type 1. TrueType was developed by both Apple and Microsoft, and PostScript Type 1 was
developed by Adobe. A few years ago, there was a showcase showdown between these two
technologies, and when the dust settled PostScript remained the standard on the Macintosh
platform, but TrueType became the de facto on the Windows side.

This can make for some problems when switching documents between platforms--especially in
documents with kerning or justification. Whenever possible, it's best to convert your text to
outlines to avoid any problems. Of course, if the type must be edited, then converting the type to
outlines won't work for you. Just be prepared to see different line breaks and |etter spacing when
moving the file between platforms.

To ensure that fonts appear identical across platforms, make sure the font names are identical and
that they are from the same type foundry (Adobe Garamond is very different from ITC
Garamond).
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Compatibility

Cross-platform compatibility in Illustrator 7 is greatly improved from previous versions.
[llustrator now supports many different file formats. Of course, whenever possible, try to keep
your filein EPS format as this keeps the file in a scalable format, as well as ensures that your file
prints reliably from any PostScript printer.

Color M anagement

We spoke about color management back in Hour 16, "Working with Raster Images,” but |
thought it was necessary to repeat it again. In all probability, what you see on a Macintosh screen
will vary greatly from what you see on a Windows screen. If possible, try to use standard defined
colors, such as those from the PANTONE collection, and use a printed swatchbook to proof
colors.

SUMMARY

In order to be successful in today's growing world of computer design, one must be able to work
with both platforms. We already knew that Illustrator was a cross-platform application, but this
past hour we learned all about the little things--the things that matter most--to help ensure a
smooth transition between both Macintosh and Windows platforms.

Term Review

* Drag and drop -- Copying items between applications or open windows by simply dragging the
selected items without using Copy and Paste commands.

* File extension -- Following the period in afilename, up to three |etters that identify the file
type, such as EPS or TIF. (Appliesto PC only. Mac OS uses afile resource located within the
file to determine the file type.)
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